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1 Introduction 
Solar Maps is a state-of-the-art software package for PCs running Microsoft 

Windows operating system. 

It is a stand-alone program designed for the purpose of aiding beginners through to 

expert astrologers with a comprehensive set of astro-locality mapping tools, 

including a set of useful on-screen interpretations and printable relocation reports. It 

provides easy access to high quality map and chart production using the Windows 

visual interface. 

Many of the features of the best-selling Solar Fire® program have been included to 

provide unprecedented power in an astro-locality mapping tool. For example, in 

addition to the standard planets, you can also include TransNeptunians, seven major 

asteroids, the Dark Moon Lilith, and up to 36 of any fixed stars of your choice. 

All the options in the program have been preset to sensible defaults, so beginners in 

astro-locality mapping can simply start the program running and learn as they go. 

More demanding users will note that all of the major astro-locality mapping 

techniques have been included, and map and chart displays may be customised in an 

infinity of ways to suit almost any taste. 

 

1.1 Selected Features of Solar Maps 

The following list is a small selection of the features which are available in this 

program. 

 

 View and print maps for any region of the world 

 Pan and zoom to find the exact map region you want 

 Measure distances on a map by clicking and dragging 

 Create your own map colors 

 Cast new natal or event charts 

 Import charts from other astrological software packages 

 Display planet/angle, midpoint and aspect lines 

 Display local space lines 

 Display paran lines 

 Display celestial lines 

 View interpretations of any astrological line on the map by double-clicking 

 Relocate a chart by clicking on the map 

 View and print an interpretation report for the relocation of any chart 
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 Watch the AstroClock updating the astrological lines in real time 

 View the shadowed region of the Earth as it rotates 

 Plot hurricane tracks, earthquake locations and other geographical data 

 Animate transits or other types of charts over the map 

 

Many other features are also available in this comprehensive program, and you can 

discover them simply by installing and running it, referring to the manual as often as 

you feel that you need to. Most features can be found just by browsing through the 

menus of Solar Maps, and selecting any items of interest, in order to try them out. 

 

1.2 Esoteric Technologies 
Esoteric Technologies Pty Ltd is the creator of Solar Fire® and the Solar suite of 

astrology software. We are a company of professional astrologers dedicated to the 

development, publishing and marketing of quality astrology software. The people 

behind the company are Stephanie Johnson, Neville Lang and Graham Dawson. Our 

company has used its expertise and knowledge in contributing to the techniques 

contained in this ground-breaking Solar Maps program. Our team is committed to 

supporting the astrology community and enabling our colleagues to reach a wider 

audience through our quality software. 
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2 Getting Started 
This section provides you with all the information you need to start using Solar 

Maps. You will learn how to: 
 

 Install Solar Maps onto your computer 

 Start Solar Maps 

 Set up Solar Maps for first use 

 Use Solar Maps menus and dialog boxes 

 Exit from Solar Maps 
 

2.1 System Requirements 

Before installing the program, ensure that you have all the hardware and software 

you need to run Solar Maps: 
 

 A PC or compatible computer with Pentium processor (or equivalent) 

 Note – This program is not compatible with the 64-bit versions of Windows 

 CD or DVD drive 

 RAM depends on which version of Windows you have: 

 Windows 95, 98, 98SE – minimum 32 MB of RAM,  64 MB or more recommended 

 Windows ME, NT4 – minimum 40 MB of RAM,  80 MB or more recommended 

 Windows 2000 – minimum 72 MB of RAM,  144 MB or more recommended 

 Windows XP – minimum 128 MB of RAM,  256 MB or more recommended 

 Windows Vista – minimum 500 MB of RAM,  1 GB or more recommended 

 About 70 MB of disk space for a full installation 

 VGA video resolution – XGA or better is recommended 

 A mouse pointing device 

 

2.2 Installing 

 To install Solar Maps 

1. Start your computer. 

2. Start Windows. 

3. Insert the Solar Maps CD into your CD-ROM drive. 

4. Follow the instructions given on your screen 

If your CD drive does not have auto-run enabled, then run install.exe on the root 

directory of the CD. 

 

The SETUP program will prompt you to 

 Read the licence agreement 

 Read the readme file with the latest information 
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 Change the default installation directory (if you wish) 

 Enter your name, serial number and password 

 

After the setup program has run successfully, you will have a Solar Maps icon on 

your desktop, and a Solar Maps folder accessible from Start / Programs, which 

contains a number of other items which are included as part of the Solar Maps 

package. 

 

2.3 Starting Solar Maps 

Solar Maps starts up automatically as soon as its installation has finished, provided 

that you select the option to do so. 

On subsequent occasions, you will need to start it up yourself. You can start it up on 

its own, or run it from within Solar Fire (v5 or later), if you already have it installed 

on your computer as well. 

 To start Solar Maps on its own 

 Double-click on its icon. 

Solar Maps will then start up, displaying the AstroClock chart on a map. 

 To start Solar Maps from within Solar Fire 

1. Select the required chart from the list of  “Current Charts” 

2. Select the “Solar Maps” option from the “View” menu 

Solar Maps will then start up displaying the selected chart on a map.  

Important Note: Solar Fire chart types such as progressed or composite charts 

cannot be used correctly within Solar Maps, and may produce misleading results if 

you attempt to use them. You should only select charts of a natal type from the list of 

Solar Fire’s “Current Charts” for display in Solar Maps, and use Solar Maps own 

“Subsidiary” option on its “Chart” menu to generate progressed, directed or 

transiting charts which can be displayed correctly in Solar Maps. 

 

2.4 Setting the Default Location 

When you use the program for the first time, it will probably be set for a location 

which is not your own. The AstroClock will not show the correct planetary positions 

for your location until you have correctly set the default location. 

 To set the default location 

1. Select the “New Chart...“ item from the “Chart“ menu 

2. Enter your own place, country, timezone, latitude and longitude 

3. Click on the” Save...“ button within the “Default Place“ frame 
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 To enter the place details 

Type in all the required fields, or click on the “Place“ button 

The “Place” button displays the “ACS PC Atlas” dialog. For an explanation of how 

to select a city, see page 116. For a description of valid formats for the timezone, 

latitude and longitude see page 124. 

Once you have saved the default location details, you do not need to do it again 

unless you move to live in another location, or if your timezone needs to be adjusted 

for daylight saving, or other similar changes. 

The AstroClock will calculate charts for whatever default location you have entered. 

The default location details may also be retrieved and used to calculate a new chart at 

any time. 

 To retrieve the details of the default location 

Click on the” Restore“ button within the “Default Place“ frame 

This will fill in the place, country, timezone, latitude and longitude fields with 

whatever was last stored as the default. This is convenient if you wish to do a transits 

chart for your current location, for example, as in this case you can enter all the 

required details by clicking on just two buttons - the “Now“ button and the “Restore“ 

button. 

 

2.5 Other Defaults You May Want to Set Now 

Some other options that may have their default values set are the following. 

 

 House System - Determines which house system is used when chart wheels are 

viewed. 

 Mean or True Lunar Node - Determines which lunar node type is used in charts 

on and maps. 

 Method of Calculating Vulcan - Determines how Vulcan is calculated when 

charts are cast or opened. 

 

See page 106 for further details of all of these options, and how to set them. 

 

2.6 Checking for Updates 

If you have an internet connection on your computer then it is strongly recommended 

that you check for program updates on the web at the earliest opportunity.  

From time to time we create updated versions of Solar Maps to fix problems and 

make minor enhancements to the program, and you can avoid unnecessary problems 
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and get the benefit of any improvements by downloading and installing the latest 

patch update file. 

You can check for such updates very easily by using the Solar Maps Help menu item 

described on page 117, or otherwise simply by visiting our website 

(http://www.esotech.com.au/) and looking for links to patch updates. 

 

2.7 Exiting From Solar Maps 

 To exit from Solar Maps 

Select the “Exit“ option from the “Chart” menu 

If your current chart is a new one which has not yet been saved to a file, then you 

will be asked whether or not you wish to save it. 

Before finally exiting, Solar Maps saves the image of the current map to be 

redisplayed when it is next started again. 

 

3 An Overview of Solar Maps 
 

3.1 The Main Solar Maps Window 

When Solar Maps starts up, it needs to prepare the map database. This may take 

several seconds, and the progress of this operation is shown with a progress bar in 

the middle of the screen. When this has finished, you will see a Window like the 

following one. 

http://www.esotech.com.au/
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Like other windows, the Solar Maps main window may be minimised, resized and 

moved around the screen. Whenever you resize the window, the map will be redrawn 

automatically to fit the new window size. 

 

The title bar - the bar across the top of the window - normally displays information 

about whatever chart, eclipse and track or event is currently being displayed, and 

what kind of astrological lines are being displayed. Some examples are 

 

 Transits 25 Jan1997 - Natal - Lines: MC/IC/Rise/Set 

 AstroClock - 2:13 PM  23 Jul 1996 - Lines: MC/IC/Rise/Set 

 John Smith - Natal - Lines: Local Space 

 John Smith - Natal & Eclipse of 26 Feb 1998 - Lines: MC/IC/Asc/Dsc 

 Eclipse of 26 Feb 1998 

 

The menu is the means of accessing all the options within the program. The main 

headings in the menu are 

 

 Chart - Options for selecting and displaying charts and astrological lines on the 

current map 

 Map - Options for selecting and editing maps, and exiting from the program 

 Stars - Options for selecting stars to be displayed with the current chart 
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 Eclipse - Options for selecting solar eclipse lines to display on the current map 

 Track – Options for selecting tracks and events to plot on the current map 

 Reports - Options for selecting various listings and reports 

 Options - Special display and advanced options 

 Help - On-line help 

 

The location information box displays the current position of the cursor over the 

map in terms of latitude and longitude. It also displays angular and linear distance 

between two points when used with the Measure mouse mode option, and Ascendant 

and Midheaven positions when the right hand mouse button is held down. 

The mouse mode buttons enable you to switch between various modes of mouse 

operation. These modes are 

 

 Measure - To measure distance on the map 

 Zoom - To zoom into a region on the map 

 Move - To move the map in any direction 

 Relocate - To select a point to relocate a chart to 

 Fill - To fill regions of the map in various colors 

 Rulers - To add reference ruler lines to the map 

 Interpret – To view interpretations of a planet line or see a relocation report 

 

See page 67 for more information on the mouse modes. 

The line symbols which appear around the edge of the map (and on some lines 

within the map itself) indicate the line type of whatever line it is attached to. For 

example, the As/Venus symbols indicate that the attached line is one along which 

Venus is rising. When in interpret mode, it is possible to use the mouse to click on 

any such symbol to see an interpretation of that line. See page 55 for a more detailed 

explanation of this feature. 

 

3.2 Using On-line Help 

Solar Maps has comprehensive on-line help, which can be invoked from anywhere 

within the program.  

 To invoke help from any screen 

Press the “F1“ key 

This will call up a Windows help screen containing information about whichever 

screen or control currently has the focus. This is known as context sensitive help. 
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 To invoke help directly from Solar Maps menu 

Select the “Contents“ option from the “Help“ Menu 

This will display the contents page of the on-line help file. 

Select the “Search for Help on...“ option from the “Help“ Menu 

This will display the keyword search screen from which it is possible to locate topics 

based on keywords that they contain (much like an index of a manual). 

Select the “How to Use Help...“ option from the “Help“ Menu 

This will display help information on how to use Windows help files. 

Once the help screen is displayed, it is possible to navigate through the text and 

topics as desired, and to select any of the options that are available in Windows help 

files. Some of these options are:- 

 

 Contents Button - Takes you to the contents page 

 Search Button - Displays the keyword search screen 

 Back Button - Goes back to the last topic you looked at 

 History Button - Displays a list of all the topics you have previously looked at 

 << and >> Buttons - Goes to the previous or next topic 

 Group Button - Goes to the start of the current group of topics 

 

For more information on these, and other standard features in Windows help files, 

see the How to Use Help option of the Help menu. 

 

3.3  Using the Keyboard 

Although Windows is most easily used with a mouse, use of the keyboard is 

compulsory for certain data entry items, and it is possible to perform almost all 

operations from the keyboard instead of the mouse if this is desired. 

Additionally, there are various "short-cut" keys which enable some tasks to be 

invoked more quickly from the keyboard then by using a mouse. 

 

3.3.1  Dialog Boxes 

Movement and editing within a dialog box may be carried out according to the key 

definitions as described in your Windows manual. A brief reminder of some of these 

keys follows. 

 

TAB Move from option to option 

SHIFT+TAB Move from option to option in reverse order 
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ALT+character Move to option whose letter matches character 

Arrow key Move cursor within a data box 

HOME Move cursor to start of data within a data box 

END Move cursor to end of data within a data box 

INSERT Toggle between type over and insert modes 

DELETE Delete the next character or the selected text 

BACKSPACE Delete the previous character 

ENTER Activate the dialog box's default command button 

SHIFT+cursor Select text across which cursor moves 

 

When the text in a dialog box is selected (highlighted), then typing any text will 

cause the existing text to be deleted. To avoid this, use the END or cursor keys to 

switch off the selection of text before typing any characters. 

 

3.3.2  Short-Cut Keys 

A variety of short-cut keys have been defined within Solar Maps to facilitate the 

activation of certain frequently used menu options without having to use the mouse. 

Each short-cut key combination activates an item from the menu. A list of these keys 

follows. 
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F1 Context sensitive help 

F2 Open Map 

F3 Save Map As 

F4 Redraw Map 

F5 Previous View 

F6 Map Options 

F7 Edit Cities 

F8 Edit Countries 

F9 Special Fill Color 

F11 Print 

CTRL+A AstroClock On/Off 

CTRL+N New Chart 

CTRL+C Select Chart 

CTRL+O Open Chart File 

CTRL+S Save Chart 

SHIFT+DEL Clear Chart 

CTRL+U Subsidiary Chart 

CTRL+M Animate Chart 

CTRL+R Relocate Chart 

CTRL+L Select Lines 

CTRL+P Displayed Points 

CTRL+D Day/Night Shading On/Off 

CTRL+E Select Eclipse 

CTRL+T Select Track/Event 

CTRL+F1 Map Parans Report 

CTRL+F2 Local Parans Report 

CTRL+F3 City Directions Report 

CTRL+F4 Reloc Interpretations Report 

CTRL+F5 Edit Screen Settings 

CTRL+F6 Edit Printer Settings 

SHIFT+F1 Celestial Zodiac 

SHIFT+F2 Geodetic Zodiac 
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4 Introduction to Astro-locality Mapping 
In natal astrology we explore the energies of the planets and constellations, and 

sometimes other cosmic entities, at the time and place of our birth. We take the exact 

moment of our birth and mathematically construct a birth or natal chart for the place 

where we are born. From these chart calculations we interpret meanings. Our modern 

day birth chart interpretations have sprung forth from ancient roots - ancient times 

when most people did not roam far from home. 

However, in modern times many people travel far from their birth places. 

Exploration of foreign lands for the purposes of going on holidays, travelling for 

work, and moving home has become common place, particularly amongst the 

populations of affluent countries. 

As a result of this, astrologers have begun to research and experiment with what 

happens when an individual travels temporarily or permanently to a location other 

than their birth place. Questions have arisen as to whether or not the birth chart needs 

to be modified to adapt it to the new location, and subsequently different theories 

have arisen. 

In Solar Maps we have provided the tools for astrologers to further experiment with 

the different methods of astro-locality mapping. We have used the term “astro-

locality mapping” in a general sense, intending it to apply to the full range of 

astrological techniques that can be used in relation to maps of any regions or 

localities. (Another, similar term that is sometimes used is “geographical astrology”.) 

Some of these tools have been used since ancient times to determine the fate of 

countries in what is called Mundane Astrology, and even the “Star in the East” 

indicating the birth of Christ was used as an astro-locality mapping pointer to guide 

the three wise men. 

However, the use of astro-locality mapping in natal astrology has only quite recently 

been developed to any great extent. 

 

4.1 Relocating Charts 

A relocated chart is one that has been calculated for a different location than the birth 

place. It is cast for the same moment of birth (taking into account any differences in 

time zone between the locations), but uses the latitude and longitude of the new 

location being considered. A relocated chart therefore has identical planetary 

positions to the original natal chart, but the chart’s angles (Ascendant, Descendant, 

MC and IC) will change, and therefore the house which each planet occupies may 

also change. 

The method of casting and interpreting relocated charts is called Relocational 

Astrology. Relocational Astrology, is normally used when a person has moved from 

their birth place or is considering a move. The idea is that a relocated chart will hold 
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some relevance in a person's life once they have moved, even though the birth chart 

is still the most significant method of interpretation. For instance, the birth chart may 

show that a young individual struggles within their chosen profession, because 

Saturn is in the 10th house. However, if that person moves to a different location 

where Saturn moves out of the 10th house, and Jupiter moves into the 10th house, 

then the planetary energies would shift, helping that person to have more of a sense 

of ease and abundance in their chosen profession. 

In Solar Maps, it is possible to relocate any chart either by selecting a city from the 

on-line atlas, or just by clicking the mouse on the required location on the map (once 

the relocate button on the button bar has been selected) 

 

An Example 

Mohandas (Mahatma) Gandhi was born in India, and at the age of 19 defied 

convention by going abroad to study towards his career (Uranus in the 9th house of 

his natal chart, and conjunct the MC). He studied law at University in London, and 

also philosophy in his own time, discovering the principles of non-violence and civil 

disobedience (Jupiter and Pluto opposite Mars on the MC/IC axis of the relocated 

chart), which later played a key part of his successful campaign to end British rule in 

India. 
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4.2 Astro-locality mapping and Astro*Carto*Graphy® 

The best known technique of astro-locality mapping in modern times has been 

promoted and popularised by Jim Lewis under the registered name 

“Astro*Carto*Graphy®”. 

Astro*Carto*Graphy® is simply a method of showing where on Earth the planets for 

a given chart would be actually crossing the horizon or meridian. This method 

enables the astrologer to see quickly and clearly where planets, and other cosmic 

entities, are rising and setting (or crossing the Ascendant and Descendant), 

culminating (or crossing the Midheaven or MC) and at the lower point of 

culmination (or crossing the Imum Coeli or IC). The idea is that these planetary lines 

will affect the individual's life wherever there is contact with or proximity to that 

line, either through physically moving to that line or by carrying out certain activities 

which have some association with a place on that line. This technique, called “In 

Mundo” mapping, is based on the right ascension and declination of each planet.  

A slightly different technique, which is also offered in Solar Maps, is to use the 

celestial latitude and longitude of each planet, as a result of which the astrologer can 

see lines along which these planets would have the same zodiacal longitude as the 

Ascendant, Descendant, MC or IC. This normally gives very similar lines to 

Astro*Carto*Graphy®, and differs significantly only for planets which are not near 

the ecliptic. For example Pluto is often many degrees away from the ecliptic, so the 
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lines along which it is rising and setting will differ somewhat from the lines along 

which it is conjunct the Ascendant and Descendant in longitude. (Note, though that 

lines for Planets on the MC and IC are identical under either technique.) This 

technique, called “Zodiacal” mapping, is analogous to showing where, if a relocated 

chart was cast, planets would be exactly on the MC, IC, Ascendant or Descendant of 

the chart.  

In Solar Maps we have referred to lines of these types as Planet/Angle lines. You 

have the option of sticking to the Astro*Carto*Graphy® technique of using In 

Mundo lines, or of trying the ecliptical technique using Zodiacal lines. 

 

An Example 

We will look at an Australian Prime Minister Paul Keating, renowned for his desire 

to break away from the English Monarchy and launching Australia into 

Republicanism. If we cast Paul Keating’s chart (18 Jan 1944, 12:05 PM AEDT -

11:00, Sydney, 33S55 151E10) and display it on a map of the UK, then we can see 

that Mr Keating has the line Pluto on the MC running through England, near 

London. If we did a relocated chart for Keating in London, then we would see that 

Pluto was very near the MC of that chart. This placement indicates power issues in 

his public or professional life. A struggle for supremacy with the English Monarchy 

would be a most appropriate interpretation for this planetary line. It is likely that Mr 

Keating will always face powerful career issues when having contact with England. 

The North Node on the MC line does not run so close to London, but adds to the 

feeling that he will have to deal with issues affecting the British public in his career. 

(Note that Mr Keating's birth time of 12:05 PM is only one of several published 

times. However, this example seems to add further confirmation that this time may 

be the correct one.) 
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It is interesting to note that Gandhi (see the previous example) who also has Pluto 

near the MC of his London relocated chart, also worked towards breaking his 

country’s ties to Britain. Gandhi was successful, but Keating failed when a 1999 

referendum on the matter obtained a result in favour of remaining a monarchy. 

 

4.3 Midpoints and Aspects  

Basic astro-locality mapping consists of lines indicating conjunctions of the planets 

with the chart angles. However, by simple extension, it is also possible to construct 

such lines for planetary midpoints, and for additional aspects of planets to the angles, 

such as squares, trines and sextiles to each chart angle. 

It should be noted that a planetary midpoint is normally calculated as a midpoint in 

celestial longitude, and when the “Zodiacal” mapping option is selected, this 

convention is adhered to. However, when the “In Mundo” option is selected, the 

planetary midpoint is calculated as the midpoint in right ascension instead. This 

adjustment is necessary to ensure consistency with the coordinate system in which 

these calculations are taking place. 

Similarly, when aspects other than conjunctions are used, the aspects are of longitude 

when the “Zodiacal” mapping option is selected, and of right ascension when the “In 

Mundo” mapping option is selected. 

As these extended techniques have only become popularised with the advent of 

advanced computer software, there is as yet little written about them in the literature. 
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4.3.1 An Example 

Consider the chart Henry Kissinger, 27 May 1923, 5:30am -1:00, 49N28 10E59 

(From Birth Certificate –Rodden Rating AA). Kissinger became Nixon's advisor on 

national security affairs in 1969, and was the US Secretary of State for many years. 

He was the major US figure in negotiations to end the Vietnam War. Looking to his 

midpoint astro-locality lines in south east Asia we can see that two of his natal 

midpoint lines run right through Vietnam. These lines are Pluto/Chiron midpoint 

culminating, and Moon/Pluto rising. The Moon/Pluto midpoint rising line reflects 

powerful emotions (and an ability to powerfully affect the emotions of others) in 

relation to the Vietnamese issues, and the Pluto/Chiron culminating midpoint is 

reflective of his major public role in seeking to end and heal what had turned into a 

deeply unsettling conflict for the USA. 

 

 

 

4.4 Geodetic (Mundane) Charts 

Several mundane astrologers of note, such as Sepharial and Johndro, have developed 

a different astro-locality mapping technique which uses a symbolic projection of the 

zodiacal signs onto bands of longitude around the Earth. Typically the 0º Aries point 

is projected onto the Greenwich meridian (0º of longitude), and the sign divisions 

fall every 30º around the equator in an eastward direction, although the anchor point 

and direction are sometimes varied (and these are offered as options in Solar Maps). 

This projection method is often used in the astrology of national and international 
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politics and events, using charts of nations and cities. It produces maps which are 

very similar in appearance to Astro*Carto*Graphy® maps, but the positions of the 

planets and their corresponding Planet/Angle lines are symbolic only, and do not 

show their true positions on the Earth’s surface. It is possible to view any chart using 

this method by selecting the “Zodiac” option from the “Chart” menu of Solar Maps. 

See page 52 for further information. 

 

4.5 Transits, Progressions and Cyclo*Carto*Graphy® 

In addition to viewing the planetary lines of a natal chart over a map, an additional 

technique that can be used is to view the planetary lines of progressions, directions 

or transits to that natal chart. As these charts vary with time (i.e. they are dynamic), it 

is possible to use this technique as a predictive tool, by looking at how planetary 

lines change over a period of time. 

When a progressions, directions or transits chart is used to display planetary lines, it 

is necessary to retain the original chart angles from the natal chart, so that one can 

see how much planets have moved in relation to their natal positions. This is similar 

to the concept of a bi-wheel, where the progressed, directed or transiting chart is 

displayed around the natal chart, and where the house cusps remain fixed in relation 

to Ascendant and Midheaven of the natal chart. 

As an illustration, consider the transiting Sun. This moves roughly 1º per day, so in 

relation to its natal position, it would have moved roughly half way around the world 

after 6 months, and have returned to its natal position after about one year. The 

secondary progressed Sun, however, moves only about one degree per year, so in 

relation to its natal position, it would have moved only about 30º after 30 years of 

life. 

Solar Maps allows you to cast a chart for secondary progressions, tertiary 

progressions, solar arc directions, or for transits, for any specified date. 

The method of Cyclo*Carto*Graphy®, also developed and registered by Jim Lewis, 

uses a mixture of transiting and secondary progressed planets. For a particular date, it 

uses the outer transiting planets (Jupiter, Saturn, Uranus, Neptune and Pluto) and the 

inner progressed planets (Sun, Moon, Mercury, Venus and Mars). Solar Maps 

includes this technique under the name “Sec.Prog + Transits (CCG)”. If you were to 

compare chart lines using this technique to those for secondary progressions and 

transits, you would see that the CCG lines for the inner planets correspond to the 

same secondary progressed lines, and the CCG lines for the outer planets correspond 

to the same transit lines. 

 

An Example 

This example involves looking at a map of Adolf Hitler’s transits at the time of his 

invasion of Poland - 1st September 1939. This can be done in Solar Maps by first 
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opening or casting Adolf Hitler’s natal chart (20 Apr 1889, 5:37:52 PM UT+0:00, 

Braunau am Inn, 48N15 13E02), and then casting a subsidiary chart for 1 Sep 1939, 

and selecting the Transits option. The transiting Planet/Angle lines over the 

European region are shown in the following map. 

 

 

Of particular note is that transiting Pluto is conjunct Hitler’s natal Midheaven right 

over his home country of Germany. This indicates that issues of power are 

culminating for him in Germany. Also, over Poland, transiting Saturn is conjunct his 

Descendant, indicating strains in his relationship to that area, and the Moon’s North 

Node is conjunct his Ascendant (and therefore the South Node is conjunct his 

Descendant), indicating that there may be an ending of relationships as a result of 

past issues. 

A further intriguing fact is that, if we look at his tertiary progressions for the same 

date, progressed Uranus is on his Ascendant along a line which also passes straight 

through Poland. This is an indicator of sudden and unexpected actions, which in this 

case manifested as a sudden military invasion. 

 

4.6 Local Space Astrology 

Local Space Astrology uses a measurement system based on the local horizon and 

meridian, and was pioneered by Michael Erlewine. 

Whilst the positions of the planets, as measured in right ascension and declination, or 

celestial latitude and longitude, remain almost constant regardless of the observers 



20  Chapter 4: Introduction to Astro-locality Mapping 

 

location, measurements of the planets’ azimuth and altitude changes dramatically 

according to where on Earth they are observed from. For example, a planet which is 

seen near the Northern horizon from some place on Earth will be near the Southern 

horizon from the opposite side of the globe. 

The azimuths of the planets can be plotted on a chart known as a local horizon chart. 

Imagine that we are standing at our place of birth, at the moment of our birth, and 

turning in a full circle looking along the horizon. We can follow an imaginary line to 

each of the planets as they are placed in the heavens. Obviously as we imagine these 

lines running towards the horizon in the direction of the planets, we will see them 

running through certain cities regions and countries. These are the lines which 

appear on the local horizon chart. 

If the local horizon chart is printed out onto a transparency, you can overlay this onto 

a map of your locality or region, although you must ensure that the centre of the chart 

is correctly centred at its true location on the map, and that the north/south axis of 

the chart is aligned with the north/south axis of the map. This will then show you 

where the local space lines for each planet go. The principle here is that if you follow 

any particular planetary line, then you are likely to encounter people, things or 

concepts which are related to that planetary archetype. 

The same technique can also be used on maps of large areas, but it is important to 

note that on most map projections, the planetary lines will appear to curve rather than 

extending in a straight line. This is due to the fact that the Earth is actually round, 

and that the map is flat. However, Solar Maps takes account of this when local space 

lines are plotted onto a map, and if you view a map of the whole world, you will see 

that these lines extend around the whole globe and eventually back to their starting 

point. If you were to change the map projection option to view it as a globe, then it 

will become obvious that the lines are actually great circles around the Earth, and 

don’t really change direction at all, as they appear to do on the rectangular or 

Mercator map projections. 

 

An Example 

Consider the case of Ernest Hemingway (21 Jul 1899, 8:00 AM CST +6:00, Oak 

Park, IL, 41N54  87W43). He was renowned for restlessness, and travelled the 

world. Some particular examples from his life which are reflected in his local space 

lines are: his love of Europe and Paris (his Jupiter line runs through Europe near 

Paris); his work in patrolling for submarines off the coast of Cuba (his Pluto line 

runs across Cuba); his two aeroplane accidents in Uganda (very near his Mars line). 
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Although this example looks solely at the planet direction lines in Hemingway’s 

natal chart, it is also possible to use a relocated chart. This would a reasonable thing 

to do if you have moved home, for example. If you do so, then you will notice that 

the planet direction lines for the relocated chart all converge on that chart’s relocated 

position, and if you have moved a great distance, the lines will form a completely 

different pattern, passing through different regions of the world. 

 

4.7 Eclipse Paths 

There are typically about four eclipses each year. Two of these are lunar eclipses (©), 

when the Moon is obscured by the shadow of the Earth. The other two are solar 

eclipses (¨), when the shadow of the Moon passes across the surface of the Earth. 

Lunar eclipses can be observed from anywhere on Earth simultaneously, and 

therefore cannot be plotted onto maps. However, solar eclipses are localised, and can 

only be seen from certain regions of the Earth. The path of the Moon’s shadow in a 

solar eclipse is generally very narrow, and forms a thin band which moves across the 

Earth. This path can be plotted onto a map, as can lines along which the magnitude 

of the eclipse is less than total. 

 

An Example 

On 11th August 1999 a solar eclipse occurred, starting east of the USA, moving 

across the Atlantic, Europe and the Middle East, finally finishing after passing across 

India. Astrologers are particularly interested in this eclipse because at the time of the 

eclipse a powerful fixed grand cross was formed between all the major planets. It 

was expected that the effect of this eclipse would be felt most strongly in regions 
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directly under the path of total eclipse. Regions which are not under the path of total 

eclipse but still experiencing a partial eclipse, such as northern Africa, Scandinavia, 

Russia and China, are likely to be affected to a lesser extent. 

 

 

 

4.8 Conclusion 

Solar Maps is a program which makes it possible to use all of the formerly 

mentioned methods of geographical astrology, with a view to helping astrologers to 

explore the world of planetary energies as they relate to humans and events in 

different places in the world. We have used a few simple examples to give you the 

flavour of what is possible, and to give you an idea of what you might want to 

explore yourself. 

In traditional astrology, the natal/birth chart, together with transits, progressions, 

returns and other predictive techniques, can tell the story of timing of events in an 

individual's life. The additional questions that can be addressed by using the 

techniques contained in Solar Maps relate to the whereabouts of events and 

influences in a person’s life. 

Not all of the possible techniques that you can use have been covered in this chapter 

- this is somewhat beyond the scope of this manual which is intended more as a 

technical guide to using the program. However, there are a number of books 

available which explain all of the techniques covered here, and others, at much 

greater length. If you wish to find out more, then it is recommended that you seek out 

one or more of these books from your local astrology bookshop. 

 

Some Useful Books on Astro-locality Mapping 
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“Planets in Locality” by Steve Cozzi, Llewellyn Publications 1988 

“Planets on the Move” by Maritha Pottenger and Zipporah Dobyns, ACS 

Publications 1995 

“The Astro*Carto*Graphy Book of Maps - The Astrology of Relocation” by Jim 

Lewis and Ariel Guttman, Llewellyn Publications 1989 

“Astrolocality Astrology” by Martin Davis, The Wessex Astrologer Ltd 1999 
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5 Charts and Lines 
In addition to using the AstroClock, you may cast new charts in Solar Maps, or 

alternatively you can open charts which have previously been saved to chart files. 

When Solar Maps is used with Solar Fire v5, you can also select any chart which is 

currently calculated in Solar Fire or was previously retained in Solar Fire. 

When a chart is created or selected, planetary and zodiacal lines relating to that chart 

are displayed on the current map. It is possible to relocate the chart and to change 

options relating to the displayed lines and symbols for the chart. 

It is also possible to view and print a chart wheel or local space wheel for the chart, 

and to save the chart to a file for future re-use. 

 

5.1 Using The AstroClock 

The AstroClock is an automatically updating chart, which can be set for your current 

location and timezone. The chart is updated every minute, providing you with a way 

of keeping track of the continually evolving planetary positions over the globe, or 

over any desired local map. In this manner you can watch as planetary lines pass 

overhead at your location, as the sun’s shadow moves over the Earth’s surface, or as 

stars rise and set, amongst many other uses. 

The AstroClock is switched on automatically whenever Solar Maps is started up. 

However, when you use the program for the first time, you should ensure that the 

AstroClock is set for the correct default location and timezone. See page 4 for 

instructions on how to do this. 

 To switch the AstroClock on or off 

Select the “AstroClock“ menu item from the “Chart“ menu. 

This will switch the AstroClock on if it is currently off, or switch it off if it is 

currently on. Note that when you switch the AstroClock on, any existing chart that 

you were using is replaced with the chart for the current time. When you switch the 

AstroClock off, the chart for the current time remains in place, but it will no longer 

be updated. 

The AstroClock remains on until you 

 Switch it off using the menu 

 Create a new chart to display 

 Open a chart to display 

 Exit from the Program 

 

Whilst the AstroClock is running, each time that the chart is updated your computer 

will need to spend several seconds calculating and redrawing the chart. If you leave 
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the AstroClock running and start using another application, you may find that, if you 

have an “older” computer, it becomes unresponsive for a few seconds each minute. If 

you find this a problem, then you will need to switch the AstroClock off while you 

work on other applications. 

 

5.2 Opening a Chart File 

You may open any chart file (of type Solar Fire v3, v4, v5 format) which exists on 

your computer or on a diskette. These chart files may have been created by i) Solar 

Maps (v1 or later), ii) Solar Fire (v3 or later), or iii) The Chart Import Utility. 

To use charts which are not already in Solar Fire v3/4/5 format, you must use the 

Chart Import Utility first. See page 31 for further information on this. 

If you already have the Solar Fire program installed on your computer, then it is not 

necessary to open a chart file unless you wish to select a chart which is not a retained 

or currently calculated chart in Solar Fire. 

 To open a chart file 

Select “Open Chart File...“ from the “Chart“ menu. 

This will display the “Select Chart File to Open” dialog box, displaying a list of chart 

files from which you can choose. 

 

 

 

Note that when you click on a file name, a description of the file appears in the box 

along the bottom of the window. 

All of the charts are initially stored in Solar Maps USERDATA directory, but if 

necessary, you can choose a different disk drive by selecting an item from the drop-

down list of drive names, and look in a different directory by double-clicking on 
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directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to open a chart file which is stored on a diskette. 

After you open a chart file, you will be prompted to select a chart from within that 

file to display. 

 

5.3 Selecting a Chart 

 To select a chart to display over the current map 

Select “Select Chart...“ from the “Chart“ menu or click on the “Chart“ button 
above the map display area. 

If Solar Fire is currently running, or if there are retained charts from the last session 

of Solar Fire, then you will be presented with a list of calculated or retained charts 

from which to choose. 

If you have not already chosen a chart file to open, then you will be presented with a 

dialog box from which you can select a chart file to look in. See page 25 for further 

details. 

 

 

 

When you click on a chart in the listbox on the left, the details of that chart will be 

displayed in the box at the right, along with any chart comments that were saved with 

that chart (if any exist). 
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 To select one of these charts to display 

Click on the required chart and then click on the “OK“ button or Double-click 
on the required chart. 

You will then be returned to the main screen of Solar Maps, and the newly selected 

chart will be used to draw astrological lines over the current map. 

 To sort the listed charts into alphabetical order 

Click on the “Sort Alphabetically” check box. 

This will sort the charts into ascending alphabetical order. When this option is not 

checked, the charts will be displayed into the order in which they were saved into the 

chart file (i.e. unsorted). 

 To display charts names with last name first 

Click on the “Last Names First” check box. 

This will ensure that the last name in the chart will be displayed at the beginning of 

the line, followed by a comma and the remainder of the name. This option is useful 

when used with the alphabetical sort option in order to list the charts by alphabetical 

order of last name. However, note that any chart names which have been created in 

Solar Fire as “Event” or “Horary” charts are not affected by this option, because it is 

assumed that such charts do not consist of personal names. 

 To remove any currently selected chart 

Select the “Clear Chart“ item from the “Chart“ menu. 

This leaves the map without any chart lines displayed, and you must reselect a chart 

to display them again. 

 

5.4 Casting a New Chart 

It is possible to cast new natal or event charts for subsequent display, and any such 

charts may also be saved to a chart file for later re-use. 

 To cast a new chart 

Select the “New Chart..“ option from the “Chart“ menu. 

This will display the “New Chart Data Entry” dialog box. 
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You may enter all the required details on this screen. These details are 

 Chart Name - Enter up to 30 characters to describe the chart. Typically this is 

the name of the person for whom you are casting the chart. This must not be left 

blank. 

 Date - Enter the date for the chart. Most normally used date formats are 

acceptable. See page 124 for a description of valid date formats. 

 Time - Enter the local time for the chart. Most normally used time formats are 

acceptable. See page 126 for a description of valid time formats. You must enter 

a time, even if the actual time of birth is not known. If so, then the best solution 

is normally to enter a time of 12 PM. 

 Place - Enter the name of the place for the chart. Alternatively you can click on 

the place button or use the AutoLookup feature to get the required place details 

from the Atlas. 

 Country/State - Enter the name of the country or state in which the place 

exists. 

 Zone - Enter a timezone abbreviation and/or time difference. See page 128 for a 

description of valid timezone formats. 

 Latitude - Enter the latitude of the chart location. See page 130 for a 

description of valid latitude formats. 

 Longitude - Enter the longitude of the chart location. See page 130 for a 

description of valid longitude formats. 

 

The buttons may be used as follows 
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 Now - Fills in the Chart Name, Date and Time fields according to the 

computer’s internal clock. If the computer’s clock is not accurately set, then you 

can use the control panel’s Date/Time icon to reset it. 

 Place - Displays the Select City (or ACS PC Atlas) screen from which place 

details may be selected. See page 116 for a full description of the atlas features. 

 Zone - Displays the TimeZone Selection screen from which a timezone may be 

selected. See page 128 for more details. 

 Save - Saves the current Place, Country/State, Zone, Latitude and Longitude as 

the default. 

 Restore - Restores the Place, Country/State, Zone, Latitude and Longitude 

which were last saved as the default with the Save button. 

 

If the AutoLookup checkbox is checked, then as soon as the cursor leaves the 

Country/State field, the atlas is automatically searched for a match with the Place and 

Country/State name that were entered. If a match is found, then the Zone, Latitude 

and Longitude fields are automatically filled in with the appropriate details. 

 

5.5 Relocating a Chart 

It is possible to relocate the currently selected chart to any location on the globe. 

Relocation of a chart simply involves changing its longitude and latitude. The date, 

time (and timezone) of the chart are retained without change. Therefore the positions 

of the planets over the Earth do not change when a chart is relocated. Hence 

relocating a chart has no effect whatsoever on the positioning of 

MC/IC/Rising/Setting lines on a map, nor on paran lines or celestial lines. These 

lines are independent of a chart’s location, and depend solely on the instant in time 

for which a chart is calculated. 

However, local space lines are affected by relocation of the chart, as are the chart 

wheel and the local horizon chart, because all of these are drawn up for a specific 

locality. 

 To relocate the currently selected chart 

Select the “Relocate to...“ item from the “Chart“ menu and Select a city from 
the list of cities in the atlas 

or 

Click on the ”Relocate“ mouse mode button and Click on the map at the 
desired relocation point. 

After the chart is relocated, if you are displaying any local space lines, then the lines 

will be redrawn automatically to reflect the new chart location. However, if you are 

not displaying any local space lines, then you will not see any change to the lines 

shown on the map. In this case, you will not see the result of the relocation unless 
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you view the chart wheel or local horizon chart, or if you switch on some local space 

lines for viewing on the map. 

 

5.6 Saving a Chart 

 To save the currently selected chart 

Select the “Save Chart...“ item from the “Chart“ menu. 

This will display the “Select File to Save Chart in” dialog box, displaying a list of 

chart files from which you can choose. 

 

 

 

If you have previously opened a chart file or saved a chart, then the chart file that 

you last used will be highlighted. 

Note that when you click on a file name, a description of the file (if one exists) 

appears in the box along the bottom of the window. 

All of the charts are initially stored in Solar Maps USERDATA directory, but if 

necessary, you can choose a different disk drive by selecting an item from the drop-

down list of drive names, and look in a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to open a chart file which is stored on a diskette. 

You also have the option of creating an entirely new chart file if you prefer. 

 To create a new chart file 

Click on the “Create...“ button. 

This will display the “Create File” dialog box into which you may type in a name 

(without a file extension) to use as the file name. For example, you could type in 

“family”, “personal” or “clients”. If you then click on the “OK“ button, then an 
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empty file with this name will be created and added to the list of chart files from 

which you can choose. 

 To select the required chart file and save the chart 

Highlight the required chart file on the list, and then click on the “Select“ 
button. 

The current chart will then be saved into that chart file, from where it may be 

retrieved for use in future sessions with Solar Maps or Solar Fire. 

 

5.7 Converting Chart Files 

This chapter describes how you can use Solar Map's Chart Conversion Utility to 

import and/or export natal type charts to or from chart files created by Solar Maps, 

Solar Fire or various other astrological software, as well as sending chart details to 

text files. 

Most charts produced by Astrolabe and Matrix Blue*Star or QuickCharts compatible 

software may be imported into Solar Fire / Solar Maps format. The capability to 

import other types of chart files may also be added at a later date. If you have Nova, 

Chartwheels, Professional Natal Report, Blue*Star, or QuickCharts, and you have 

calculated and saved important natal charts using these programs, Solar Fire can 

import them into its own chart file format. 

This utility searches for and processes only the natal chart records in your chart files. 

It does not import or export derived-type charts such as progressed charts, solar and 

lunar returns, and composite charts, for example. 

Note: The ASCII text data that can be imported or exported using this utility can 

consist only of chart details such as name, date, place, timezone etc, and cannot 

include planetary or house data such as planetary and house cusp longitudes, 

declinations etc. 

 

5.7.1 Chart Files You Can Import From 

You can import natal type charts from any of the following types of chart files. 

 Solar chart files - This feature is useful for importing charts created in current 

or earlier versions of Solar Fire (v1/2/3/4/5), Solar Maps (v1/v2/v3), Solar 

Spark or Solar Writer. 

 JigSaw project files – JigSaw v1 or v2 project files have the extension .DAT. 

 Nova chart files - Nova and Nova-series software has charts in files with the 

extension .NOV. Example: FRIENDS.NOV. 

 Blue*Star chart files - Blue*Star saves charts in files with the extension 

.RND. 
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 QuickCharts chart files - QuickCharts saves charts in files with the extension 

.QCK. 

 ASCII files – These can be text files that contain chart data in fixed length or 

comma quote delimited format, with a file extension of .ASC, .TXT or .DAT. 

 Other file formats - Any additional file formats which are added after 

publication of this manual 

Note: This utility cannot import Win*Star charts directly. However, if you 

convert your Win*Star charts into QuickCharts format first (or 

alternatively into an ASCII text file), then these charts may be 

imported with this utility. 

 

5.7.2 Chart Files You Can Export To 

You can export natal type charts to any of the following types of chart files. 

 Solar Fire v5 chart files 

 Solar Fire v3/v4 chart files 

 JigSaw v2 project files 

 ASCII files – These can be flexibly defined to contain selected chart details in 

fixed length or comma quote delimited format. 

 

5.7.3 Starting the Solar Fire Chart Conversion Utility 

 To start the utility 

From the Start / Programs / Solar Maps menu, select the Chart Conversion 
item. 

 

After the utility loads, Solar Fire displays a chart conversion dialog containing three 

tabbed dialogs. 

 Import From - To select the file from which data will be read 

 Save To - To select the file to which data will be exported or written 

 Options – To select various conversion options 
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5.7.4 Import From 

 To select the file to import from 

1. Select the required File Type from the Chart Type to Import From 
drop-down list box. This selection determines which file types will be 
visible in the file list below. 

2. Select the required Drive from the drop-down list of drive names. 

3. Select the required Directory or Folder by navigating through the 
directories/folders. Each time you change the directory or folder, the list 
of files available to import from will be updated, to reflect the newly 
selected location. When you have selected the required directory or 
folder, all the files of the selected chart type that are in that folder will 
be listed in the file list. 

4. Select the required file from the file list. When you do so, the “Import 
From” box at the bottom of the dialog will be updated to give the full 
path and file name of your selected file. 
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5.7.5 Save To 

You have the option of saving or exporting charts either into a new file, or to be 

appended to an existing file. 

 

 To select the file to save or export to  

1. Select the required File Type from the Chart Type to Save Into drop-
down list box. This selection determines which file types will be visible 
in the file list below. 

2. Select the required Drive from the drop-down list of drive names. 

3. Select the required Directory or Folder by navigating through the 
directories/folders. Each time you change the directory or folder, the list 
of existing files of the selected type will be updated, to reflect the newly 
selected location. When you have selected the required directory or 
folder, all the files of the selected chart type that are already in that 
folder will be listed in the file list. If you are importing chart for use in 
Solar Maps, then you should select Solar Maps’ USERDATA directory 
(or whichever other directory you are using to store its chart files). 

4. If you wish to save your charts into a file that already exists, then select 
the required file from the file list. 

5. If you wish to save your charts into a new file, then enter a new file 

name into the File Name to Save Into box. When you do so, the “Save 
To” box at the bottom of the dialog will be updated to give the full path 
and file name of your selected file. If you omit the file extension, then 
the correct extension type will be appended to the file name 
automatically when the file is created. 

 

5.7.6 Options 

5.7.6.1 New Solar Fire Chart Files 

This option is used only when you are saving charts into a new Solar type chart file. 

It determines the internal format of any Solar type chart file which is created by this 

utility. 

 Create v3/4 format chart files – Newly created chart files will be compatible 

with Solar Fire v3, v4 and v5, but when used with Solar Fire v5, cannot be 

used to store non-natal type charts, chart ratings or source comments. Choose 

this option if you wish to create chart files that can be used by owners of Solar 

Fire v3 and v4 and Solar Maps v1. 

 Create v5 format chart files - Newly created chart files will be fully 

compatible with Solar Fire v5 and Solar Maps v2 or v3, but cannot be used 

with any older version of Solar Fire or Solar Maps. 
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5.7.6.2 Default House System 

This option is used only when you are saving charts into a Solar type chart file. 

The default house system that is selected in this drop-down list is applied whenever 

the chart data that is being imported does not have a house system stored with it, or 

has a house system that is not recognised in Solar Maps. 

If the Force all converted charts to use this house system option is checked, then 

all imported charts are given the default house system, regardless of what house 

system may be stored in the imported chart. 

 

5.7.6.3 Default Zodiac 

This option is used only when you are saving charts into a Solar type chart file. 

The default zodiac that is selected in this drop-down list is applied whenever the 

chart data that is being imported does not have a zodiac stored with it, or has a 

zodiac that is not recognised in Solar Fire. 

If the Force all converted charts to use this zodiac option is checked, then all 

imported charts are given the default zodiac, regardless of what zodiac may be stored 

in the imported chart. 

 

5.7.6.4 Default Coordinates 

This option is used only when you are saving charts into a Solar type chart file. 

The default coordinate system that is selected in this drop-down list is applied 

whenever the chart data that is being imported does not have a coordinate system 

stored with it, or has a coordinate system that is not recognised in Solar Fire. 

If the Force all converted charts to use these coordinates option is checked, then 

all imported charts are given the default coordinate system, regardless of what 

coordinate system may be stored in the imported chart. 

 

5.7.7 ASCII Format to Use 

This option is used only when you are importing from or exporting to an ASCII text 

type chart file. 

You can either select a pre-defined ASCII format from the drop-down list, or click 

on the Edit ASCII Formats… button to create new ASCII format definitions, or edit 

or browse existing ASCII format definitions. 
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5.7.8 Converting Charts 

Once you have selected all the required options, you can start the conversion by 

clicking on the Convert button. 

If the Save To file already exists, then you will be prompted whether or not you wish 

to append new charts after any existing charts in that file. 

When the process has finished, you will be notified how many charts were 

successfully converted. 

 

Note: If you import a Solar Fire chart file, then any comments associated with the 

charts in that file will also be imported. 

 

5.8 Casting a Transits, Directions or Progressions Chart 

If you have already opened a chart or cast a new natal chart, then you can easily 

create a subsidiary chart which shows any of the transiting, secondary progressed, 

tertiary progressed or Solar arc directed planetary positions in relation to the angles 

of the current natal chart. This enables you to see how planetary influences change 

with time. For example you may wish to view where the transiting or progressed 

planetary lines for the current date appear in relation to your natal chart. 

Note that these subsidiary charts are not quite the same as casting an ordinary transits 

or progressions chart for the current date. The difference is that when viewing these 

subsidiary charts on an astro-locality map, the natal chart angles are retained, so that 

the transiting or progressed planetary positions can all be seen relative to the natal 

chart’s angles. An ordinary transits chart, for example, would have a midheaven 

angle which depended on the time of day for which the chart was cast, and an 

ordinary progressions chart would have a midheaven angle which depended on the 

progressed solar arc in longitude (or progressed solar arc in right ascension, or 

whatever method of angle progression has been used in calculating the progressed 

chart angles). In contrast, subsidiary charts cast in Solar Maps always retain the natal 

chart angles. 

Solar Maps will only allow you to cast a subsidiary chart if you have already opened 

a natal chart or cast a new natal chart. If the current chart is the astroclock, or a chart 

called “Transits”, or any kind of non-natal chart, then the Subsidiary Chart menu 

option will remain greyed out, and cannot be selected. 

 To cast a subsidiary chart 

Select the “Subsidiary Chart...“ item from the “Chart“ menu. 

This will display the “Subsidiary Chart” dialog box. 
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When this is first displayed, the caption at the top of the frame will indicate the name 

of the chart which will be used as a base chart for this new subsidiary chart. If this is 

not the correct chart, then you should exit from this dialog box and select the correct 

chart before trying again. 

The types of chart which you can select to calculate, by clicking on the appropriate 

option button are as follows. 

 Transits - This will calculate a chart containing the planetary positions for 

whatever date, time and timezone you specify, but will retain the chart angles of 

the base chart. 

 Secondary Progressions - This will calculate a chart containing the secondary 

progressed planetary positions for whatever date, time and timezone you 

specify, but will retain the chart angles of the base chart. The secondary rate of 

progressions is based on the ratio of one day for one year which is 

0.00273790926. 

 Sec.Prog + Transits (CCG) - This will calculate a chart containing secondary 

progressed positions for the Moon, Sun, Mercury, Venus and Mars, but also 

containing transiting positions for all the outer planets and other chart points. 

This particular combination is the same as is used in Cyclo*Carto*Graphy®. 

 Tertiary Progressions - This will calculate a chart containing the tertiary 

progressed planetary positions for whatever date, time and timezone you 

specify, but will retain the chart angles of the base chart. The tertiary rate of 

progressions is based on the ratio of one day for one mean lunar month which is 

0.03660109676. 
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 Solar Arc Directions – This will calculate a chart containing the solar arc 

directed planetary positions for whatever date, time and timezone you specify, 

but will retain the chart angles of the base chart. The solar arc is calculated 

according to the secondary rate of progressions which is based on the ratio of 

one day for one mean lunar month (0.00273790926). All the other chart points 

are directed by the same arc as the sun. 

 Restore Natal Chart - This will restore the planetary positions of the chart to 

their original locations in the base chart. This option is useful if you have 

already calculated a subsidiary chart, and now wish to revert to viewing the 

original base chart. 

  

To specify the date and time for which the subsidiary chart will be calculated, you 

can enter the required details into the following fields 

 Date - Enter the date for the chart. Most normally used date formats are 

acceptable. See page 124 for a description of valid date formats. 

 Time - Enter the local time for the chart. Most normally used time formats are 

acceptable. See page 126 for a description of valid time formats. 

 Zone - Enter a timezone abbreviation and/or time difference. See page 128 for a 

description of valid timezone formats. 

 

The buttons may be used as follows 

 Now - Fills in the Chart Date and Time fields according to the computer’s 

internal clock. If the computer’s clock is not accurately set, then you can use the 

control panel’s Date/Time icon to reset it. 

 Zone - Displays the TimeZone Selection screen from which a timezone may be 

selected. See page 128 for more details. 

 

When you have made the necessary selections and ensured the entered data is 

correct, you can display the chart . 

 To calculate and display the new subsidiary chart 

Click on the “OK“ button. 

The subsidiary chart will then be drawn onto the current map. The title bar on the 

main map screen will also be changed to indicate the type of subsidiary chart that 

you have selected e.g. “John Smith - Transits 1 Oct 1996” or  “John Smith - 

Sec.Progs. 1 Oct 1996”. 
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5.9 Animating a Chart 

It is possible to step or run a chart through time, whilst allowing the chart lines 

displayed over the map to be updated in an animated fashion. 

You can animate any type of chart, either natal or subsidiary. 

You can use this animation feature in various useful ways, for example 

 To view the general movement of transiting planets and astro-lines through time 

to familiarise yourself with the typical speeds and patterns of movement of the 

planets and astro-lines. 

 To view the movement of transiting planets and astro-lines through a particular 

period of time to determine when certain mundane astrological events occur. 

 To view the movement of a person’s subsidiary chart planets and astro-lines 

through a particular period of time to determine when certain astrological events 

occur in relation to the natal chart. 

 To view the movement of the day/night boundary during the course of the day to 

determine the times of sunrise and sunset at various locations. 

 To make adjustments to (i.e. rectify) a natal chart, by stepping the chart through 

times close to the probable birth time, and noting when various astro-line contacts 

occur on the map. 

 

 To animate transiting planets and astro-lines 

Ensure that your current selection of astro-lines is as required for your 
animation 

Ensure that you are currently displaying a natal chart of any kind (either a 
chart you have opened, cast as a new chart, or the AstroClock.) 

Select the “Animate Chart…” menu item from the “Chart Menu” 

 

 To animate a subsidiary chart 

Ensure that your current selection of astro-lines is as required for your 
animation 

Ensure that you are currently displaying a subsidiary chart of the required 
type (by selecting the required natal chart, and then using the “Subsidiary 
Chart…” menu item). 

Select the “Animate Chart…” menu item from the “Chart Menu” 

 

This will open the Animation dialog, with the date and time set from the current 

chart’s date and time. 
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This dialog box sits on top of the Solar Maps main screen, but may be dragged 

(using its title bar) to any suitable location, for example to the top of the main screen, 

or off the main screen altogether if it is not maximised and taking up the whole of 

your desktop. 

 

5.9.1 Setting the Animation Options 

Start Date and Time – You can enter a date and time to start the animation into the 

date and time edit boxes, or click on the Now button to automatically move to the 

current date and time. 

Step – You can select any desired step interval from the drop-down list (seconds, 

minutes, hours, days, months, years), and also enter a multiple of that interval. 

Speed – The maximum speed of animation depends on the calculation time for 

individual steps in the animation. This generally depends on the capabilities of your 

computer. Users with older computers may find that they need to set the animation 

speed slider to the fastest setting, whereas those with more powerful computers may 

wish to adjust the slider so that the interval between steps is not so fast that you are 

unable to keep track of it. 

 

Note: You can use or set any of these animation options whilst the animation is 

running, if you wish to do so. 

 

5.9.2 Running the Animation 

The animation is controlled by the five buttons in the central block. These buttons 

are: 

Stop – (Red square) This stops the animation if it is currently running, and leaves the 

displayed chart at the most recently calculated date and time. 

Step back – (Blue back arrow and bar) This adjusts the chart by one step interval 

backward in time, and then stops. 

Step forward – (Blue forward arrow and bar) This adjusts the chart by one step 

interval forward in time, and then stops. 
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Run back – (Blue back arrow) This repeatedly adjusts the chart backward in time 

(using steps of the specified interval), until the stop button is pressed, or the 

animation dialog is closed. 

Run forward – (Blue forward arrow) This repeatedly adjusts the chart forward in 

time (using steps of the specified interval), until the stop button is pressed, or the 

animation dialog is closed. 

 

5.9.3 Closing the Animation 

 To close the animation 

Click on the dialog close button “x” on the top right hand side of the dialog 
box. 

This will close the animation dialog and return you to the main screen of Solar Maps. 

 

Note: You can close the animation dialog whilst the animation is still running. This 

will stop the animation automatically. 

 

5.10 Displaying Lines 

There are a number of different astrological line types which it is possible to display 

in relation to the currently selected chart. 

 To select which line types to display on the current map 

Select the “Displayed Lines...“ item from the “Chart“ menu or click on the 
“Lines“ button above the map display area. 

This will display the “Select Lines” dialog box, which contains a list of the different 

line types which may be selected for display. 
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There are four categories of line types which may be selected. These are 

 Planet/Angle Lines - These are the lines which describe where on the Earth 

individual planets or stars are culminating or anticulminating (or on the 

Midheaven and  Imum Coeli) or are rising or setting (or on the Ascendant or 

Descendant). These lines are also sometimes called Astro*Carto*Graphy® lines 

in other books and programs. The culminating, anticulminating, MC and IC 

lines are always lines of longitude, whereas the rising, setting, Ascendant and 

Descendant lines are great circles around the globe and appear to curve on a 

map viewed in Cartesian or Mercator projection. Extra options allow you to 

display lines where planets are in aspect to the angles, or alternatively where 

planetary midpoints conjunct the angles. 

 Paran Lines - These are lines of latitude, indicating where any two 

astronomical bodies (e.g. planets or stars) are in an angular relationship which 

coincides with the meridian and horizon of a chart at that latitude. For example, 

if the angle between the Sun and Saturn is the same as that between the 

meridian and the western horizon, for a particular latitude, then there is a paran 

line for the Sun Culminating/Saturn Setting along that latitude. 

 Local Space Lines - These are the lines indicating the direction in which 

planets or stars are found when looking from the chart’s location. These lines 

are great circles around the globe, starting from the chart’s location. The 

common convention is to continue the line right around the world, back to the 
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starting location. When viewed in Cartesian or Mercator projection, these  lines 

generally appear to curve. 

 Celestial Lines - These are projections of the celestial sphere onto the Earth’s 

surface, and show where the ecliptic is overhead, as well as where the zodiacal 

sign divisions falls onto the Earths’ surface. 

 

 To switch on or off any particular line type 

Click on the check box to the left of the desired line type. 

When any box is checked, that line type is switched on. If it is unchecked (i.e. 

blank), then that line type is switched off.  

 To switch on or off a whole category of line types 

Double-click on any empty space inside the frame of a line category. 

If all the lines in that category are already off, then this will switch them all on, and 

vice-versa. If only some lines in that category are already on, then all of them will be 

switched on. This shortcut enables you to quickly switch on or off whole categories 

of line types. For example, you may often want to switch on or off all the line types 

in the Planet/Angle Lines category at one time. 

Note that, whilst it is possible to switch on any number of line types at any one time, 

doing so whilst viewing a world map with all planets displayed would result in a 

grossly overcrowded display. It is therefore recommended that you use only a limited 

number of line types whilst viewing large area maps. However, when viewing small 

area maps, such as individual countries, and/or using only a small number of 

displayed points, you may find that you can switch on many different line types 

without causing an overcrowded display. 

Following is a description of each individual line type that may be switched on or 

off. 

 

Planet/Angle Lines - In Mundo 

 Culminate Lines - These lines show where a planet (or star) would be crossing 

the meridian, at the highest point of its diurnal motion. At some point on this 

line, the planet is exactly overhead. 

 Anticulminate Lines - These lines show where a planet (or star) would be at 

the lowest point of its diurnal motion. 

 Rise Lines - These lines show where a planet (or star) would be crossing the 

horizon, upwards. 

 Set Lines - These lines show where a planet (or star) would be crossing the 

horizon, downwards. 

 

Planet/Angle Lines - Zodiacal 
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 MC Lines - These lines show where a planet (or star) would be conjunct the 

Midheaven (by zodiacal longitude). 

 IC Lines - These lines show where a planet (or star) would be conjunct the 

Imum Coeli (by zodiacal longitude). 

 Asc Lines - These lines show where a planet (or star) would be conjunct the 

Ascendant of a chart (by zodiacal longitude). 

 Dsc Lines - These lines show where a planet (or star) would be conjunct the 

Descendant of a chart (by zodiacal longitude). 

 

The Culminate/Anticulminate/Rise/Set lines are identical to the MC/IC/Asc/Dsc 

lines for bodies which are exactly on the ecliptic. Most planets are close to the 

ecliptic, but Pluto, some asteroids and most stars are not. Standard 

Astro*Carto*Graphy®  uses the In Mundo lines, but you may prefer to use Zodiacal 

lines if you want to relate the lines that you see to planets being exactly conjunct the 

angles of the chart. 

It is not possible to view both In Mundo and Zodiacal lines at the same time. 

 To switch between viewing In Mundo and Zodiacal lines 

Select the required “In Mundo“ or “Zodiacal“ option button. 

 

Planet/Angle Aspect Lines 

 To switch on Aspect Lines 

Click on the “Add Aspects” check box. 

Normally, the planet/angle lines displayed are only conjunctions to the chart angles 

(MC, IC, Asc, Dsc or Culmination, Anti-culmination, Rising, Setting). However, 

when you use the Add Aspects options, you are able to see additional lines for 

aspects other than just conjunctions, such as trines, squares, sextiles to each of the 

angles. 

 To select which aspects to include 

Click on the “>” button to the right of the “Add Aspects” button. 
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This displays a dialog which allows you to highlight which aspects you wish to 

include. The list includes all possible aspects from the 1
st
 to the 12

th
 harmonic types. 

Clicking on the “Default” button will select the first five major aspects on the list, 

and clicking on the “None” button will switch off the Add Aspects option. 

Note: Certain aspects are complimentary to one another when used with pairs of 

chart angles e.g. a conjunction to the MC and an opposition to the IC would be 

identical lines. Also, a trine to the MC and a sextile to the IC are also identical lines. 

Solar Maps contains an algorithm that automatically discards such identical lines, in 

order to avoid the confusion that might arise if they were all plotted. Therefore, if 

you choose both conjunctions and oppositions and both MC and IC, then only 

conjunctions to each will be displayed. Similarly, if you choose both trines and 

sextiles, then only trines to each will be displayed. However, if you choose both 

trines and sextiles but select only the MC and not the IC, then you will see both 

trines and sextiles to the MC, because in this case the sextiles are not replicating the 

trines to the IC that would have been shown if the IC was also selected. 

Note: Using this option will result in a very large number of lines being displayed on 

a world map. It is recommended that you use this option only with regional maps. 

 

Planet/Angle Midpoint Lines 

 To switch on Midpoint Lines 

Click on the “Add Midpoints” check box. 

When this option is selected, lines are drawn for each possible midpoint combination 

of all the selected displayed chart points. You can control which points are included 

by selecting a particular subset of Displayed Points by using the appropriate option 

from the Chart menu. 
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Note: The method of calculating the midpoint positions depends on whether the “In 

Mundo” or “Zodiacal” option is selected. When the “In Mundo” option is selected, 

the midpoint lines are midpoints in right ascension, whereas when the “Zodiacal” 

option is chosen, the midpoints are midpoints in ecliptical longitude. 

Note: Using this option will result in a very large number of lines being displayed on 

a world map. It is recommended that you use this option only with regional maps. 

 

Paran Lines 

 Rise/Set to Rise/Set - These lines show at what latitude pairs of planets (or 

stars) rise/rise, rise/set, set/rise or set/set at the same time. 

 Rise/Set to Culm/Anti - These lines show at what latitudes pairs of planets 

either rise/culminate, rise/anticulminate, set/culminate or set/anticulminate. 

 

It is possible to see parans for one planet or star at a time (paired with each other 

planet or star), or for all planets and stars together. The latter option produces a large 

number of lines, and it is recommended that this option be used only on regional 

maps or maps of small areas.  

 To choose which planet or star to view the parans of 

1. Click on the “Parans Of...“ button. 

2. Select an Item from the list of currently displayed points. 

To view parans of a star, you must first have opened a star file. See page 82 for 

instructions on how to do this. Note that the point which you choose does not have to 

be a displayed point. You can view parans of any point, regardless of whether or not 

you have selected it as a displayed point. 

To prevent unwanted paran lines from being displayed, it is also possible to limit the 

latitudes between which paran lines will be shown.  

 To specify a latitudinal limit 

Enter a “Limit of Lat“ value in whole degrees. 

The entered value must be between 45 and 90 degrees. Paran lines will not be 

displayed beyond the specified latitudes, both north and south. Typically you may 

want to use a value of  60 degrees or so, because lines in the arctic and antarctic 

region are of little interest to most people who live and travel in less extreme 

latitudes. 

 

Local Space Lines 

 Planet Directions - These lines extend from the chart location toward each 

planet (or star) according to its local azimuth, and extend around the globe. 

 Local Horizon - This line indicates where planets or stars would be on the 

horizon in relation to the current chart’s  location. Astronomical points between 
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the chart and this line would be above the horizon (and potentially visible), 

whereas those on the other side of the line would be below the horizon (and 

therefore not visible). 

 Local Houses - These lines are a division of the local space into 12 equal 

houses of 30º azimuth each. The 1st house cusp is always due east, and the 10th 

house cusp is south for chart locations north of the ecliptic, and north for chart 

locations south of the ecliptic. 

 

Normally, the planet direction lines (i.e. planet azimuths) change whenever the 

chart’s location is changed. However, there is an option which allows you to keep 

the original azimuths intact despite relocating the chart. Hence, with this option 

switched on, you can relocate your chart, and display planet direction lines 

emanating from that new location, but with directions corresponding to the original 

natal directions rather than the directions that would apply if you had actually been 

born at that new location. (Note that in this case, the planet direction lines will no 

longer intersect the points where the planets are actually overhead.) 

 To retain the original planet azimuths 

Click on the “Keep original azimuths after relocation” checkbox. 

This option applies to any relocated chart which are relocated using Solar Maps 

relocation options, including any charts that were relocated prior to selecting this 

option.  

Note: This option has no effect on any charts which were already relocated externally 

to Solar Maps (such as in Solar Fire) – Solar Maps does not recognise such charts as 

being relocated – rather they are treated as ordinary natal charts. 

 

Celestial Lines 

 Ecliptic - This is the projection of the ecliptic onto the Earth’s surface. The sun 

is always overhead somewhere on this line, and most of the other planets are 

near it. The ecliptic is inclined to the Earth’s equator, and extends about 23.5º 

north and south of it. 

 Zodiacal Signs - These lines are the projection of the lines of zodiacal 

longitude which divide the ecliptic into 12 equal zodiacal signs. Therefore they 

all cross the ecliptic at right angles. 

 

See page 12 for a further discussion of line types and how they are used in astro-

locality mapping. 
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5.11 Selecting Displayed Points 

It is possible to display any combination of up to 30 planets, asteroids, hypothetical 

planets and an additional 36 fixed stars on a map at any time. Most users will 

probably wish to display just the standard set of planets. However, in some 

circumstances you may wish to increase the number of points displayed, or in others 

select just a single planet to be displayed on a map. 

 To select which points to display on the map 

Select the “Displayed Points...“ item from the “Chart“ menu. 

This will display the “Select Planets” dialog box. 

 

 

 

The list box on the left contains a list of all the points which it is possible to display. 

Normally this will be a list of the 30 planets, asteroids and hypothetical planets. 

However, if you have previously opened a fixed star file, then there will also be up to 

36 fixed stars at the bottom of the list. You can see items lower down on the list by 

using the scroll bar on the right hand side of the list box. Items which are currently 

selected for display are highlighted. Items which are available for display, but 

currently unselected, are not highlighted. 

 To select or unselect any single point in the list 

Hold down the “Ctrl“ key and click on the desired item in the list. 

This will switch the point on if it was previously unselected, or switch it off if it was 

previously selected. 

If you do not hold down the “Ctrl“ key then you will switch on only that item, and 

everything else will be switched off. 
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There is also a shortcut to restoring the “default” selection of displayed points. If you 

are running Solar Fire, and have called Solar Maps from within Solar Fire, then the 

“default” selection is the same set of points which are the current displayed points in 

Solar Fire. If you are running Solar Maps on its own, then the “default” selection is 

the standard set of planets plus the lunar nodes.  

 To reset the selection to the default 

Click on the “Default“ button. 

Once you have made your selection, you can return to view the map with the newly 

selected lines displayed. 

 To return to the map 

Click on the “OK“ button. 

 

Note: If you are currently displaying a map of the world, then selecting a large 

number of points may result in an overcrowded screen and some map symbols may 

overflow off the edge of the map. It is recommended that you only select a large 

number of points if you are viewing a regional map, or if you are only viewing a 

small number of line types. 

 

5.12 Selecting a Paran Point 

Paran lines are lines of latitude, indicating where any two astronomical bodies (e.g. 

planets or stars) are in an angular relationship which coincides with the angular 

relationship between the MC/IC axis and Asc/Dsc axis of a chart at that latitude. For 

example, if the angle between the Sun and Saturn is the same as that between the MC 

and the Descendant, for a particular latitude, then there is a paran line for the Sun on 

the MC / Saturn Setting along that latitude. 

It is possible to display these paran lines on a map, but due to the potentially very 

large number of planetary pairs which would each have different paran lines, Solar 

Maps allows you to limit yourself to viewing the paran lines of a single chart point at 

a time, but paired with every other displayed point. This produces a more reasonable 

number of lines to display on the map at any one time. 

For example, if you choose the Sun as your paran point, then Solar Maps will attempt 

to plot the paran lines for the Sun together with each other displayed chart point. 

(Note that the paran point does not have to be a currently displayed point. You can 

select any available point, including a fixed star, whether or not it is selected as a 

displayed point. To view parans of a star, you must first have opened a star file. See 

page 82 for instructions on how to do this. ) 

You can also limit which paran line types are displayed according to the following 

categories. 
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 Rise/Set to Rise/Set - These lines show at what latitude pairs of planets (or 

stars) rise/rise, rise/set, set/rise or set/set at the same time. 

 Rise/Set to Culm/Anti - These lines show at what latitudes pairs of planets (or 

stars) either rise/culminate, rise/anticulminate, set/culminate or 

set/anticulminate. 

 

Selecting the paran point can be done either from the main screen of Solar Maps, or 

from within the “Select Lines” dialog box. 

 To select the paran point from the main screen 

Select the ”Paran Point...“ item from the “Chart“ menu. 

 To select the paran point from the “Select Lines” dialog box 

Click on the “Parans Of...“ button. 

In either case, this will display the “Select Paran Point” dialog box. 

 

 

 

 To select the desired paran point 

1. Select an Item from the list of points. 

2. Click on the “OK“ button. 

You may only select a single point. If you highlight multiple entries, then you will 

get an error message telling you that you must select just a single point. 

Note: If you have used the “Select Lines” dialog to display “All Parans”, then this 

option will have no effect. Any change you make to the selected Paran point will 

take effect only once you have switched off the “All Parans” option. 
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5.13 Selecting Point Colors 

You can customise the colors used for each point (planet, asteroid, hypothetical 

planet) when they are drawn onto maps, or viewed in chart wheels or local horizon 

wheels. 

 To select colors for each of the chart points 

Select the “Point Colors...“ item from the “Chart“ menu. 

This will display the “Select Planet Colors” dialog box, showing the current point 

colors for each point over a background of the current sea fill color. 

 

 

 

 To change the displayed color of any individual point 

1. Click on the symbol containing the required point or use the cursor keys to 
move the highlight frame over the required symbol. 

2. Click on the “Palette“ button. 

3. Select the desired color from the “Color Selection” dialog. 

See page 132 for a description of how to use the “Color Selection” dialog. Once you 

have selected the color, the dialog box will be updated to show the newly selected 

color for this point. You can repeat this procedure for as many points as you wish. 

When you have finished selecting colors, you then have the option of saving your 

selected colors for use in future sessions. If you do not save your selections, then any 

changes that you have made will only apply for the remainder of the current session 

with Solar Maps, and the color selection will revert to its original setting when you 

next start up Solar Maps. 

 To save your selections for future sessions 

Click on the “Save...“ button. 
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Whether or not you wish to save the selections for the next session, you can apply 

these selections to the current chart displayed.  

 To apply the selections to the current chart displayed 

Click on the “Apply“ button. 

The current chart lines will be automatically redrawn with the new color selections. 

 

5.14 Selecting Zodiac Projection Type 

When drawing astrological chart lines onto a map, it is possible to project the zodiac 

onto the Earth’s surface in either of two different ways.  These are 

 

 Celestial - This projects the true positions of the zodiacal signs, ecliptic, and 

planets onto the Earth’s surface, as they would be seen in real life. This is the 

projection method that is normally used in standard astro-locality mapping. 

 Geodetic - This projects the ecliptic onto the equator, so that the zodiacal signs 

then correspond to bands of longitude around the Earth. Typically the 0º Aries 

point is projected onto the Greenwich meridian (0º of longitude), and the sign 

divisions falls every 30º around the equator, eastwards. This projection method 

is often used in mundane astrology (the astrology of national and international 

politics and events). Solar Maps enables you to select a different terrestrial 

starting longitude for the 0º Aries point, if you wish, and also to specify the 

direction. The starting longitude option may be used to define the zodiacal 

starting point at the longitude of the great pyramid in Egypt, for example. 

 

When the geodetic projection is in use, Solar Maps includes the caption “(Geodetic)” 

after the chart name on the title bar of the window. If this is not present on the title 

bar, then the normal celestial projection is being used. 
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Celestial Zodiac Projection 

 

 

 

 

Geodetic Zodiac Projection 

  

 

 

You can switch to either zodiacal mapping option by selecting it from the menu.  
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 To switch to the celestial projection method 

Select the “Celestial“ option from the “Zodiac“ item under the “Chart“ menu. 

 To switch to the geodetic projection method 

Select the “Geodetic“ option from the “Zodiac“ item under the “Chart“ menu. 

In both cases the chart will then be redrawn using the selected projection method. 

 To select the geodetic zodiac options 

Select the “Geodetic Zodiac…“ item under the “Options“ menu. 

 

 

 

In this dialog you can enter a starting terrestrial longitude, and choose to map the 

zodiac either eastwards or westwards. The options you choose here are remembered 

when you re-start the program and remain in effect until you next alter them. 

 

5.15 Day/Night Shading 

As the Earth revolves around the sun, half of the Earth is in shadow. This region of 

shadow can be shown in Solar Maps, provided that you are viewing a map of the 

entire world in either Cartesian or Mercator projection. 

 To switch the day/night shading on or off 

Select the “Day/Night Shading“ item from the “Chart“ menu. 

This will switch the shading on if it is currently off, or switch it off if it is currently 

on. 

The shaded region is bounded by the rising/setting lines of the Sun. This can be 

clearly seen if you choose to view only the Sun as a displayed point. 

If this option is used in conjunction with the AstroClock, then you can easily track 

the progress of the shadow as it moves westwards around the Earth. This may also be 

useful if you want to make a phone call overseas, in which case you can easily see 

what stage of the day/night cycle your intended recipient is experiencing! 
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5.16 Printing Maps and Chart Lines 

It is possible to print the currently displayed map (and chart, stars, eclipse and track 

lines) onto a graphics capable printer which is installed in Windows. If you have a 

color printer, then the map lines, chart lines and eclipse lines can be printed in color. 

Note, however, that most printers do not have the capability of printing land and sea 

fill colors, so no land, sea or special fill colors will normally be printed, with the 

exception of the day/night shading area, if this option is switched on. (See page 106 

for more information on setting printer color options.) 

Before you print for the first time, you should ensure that your printer is connected 

and working, and loaded with paper. You can do this by using another Windows 

application such as a word processor, and printing a small sample of text. If this is 

successful, then you are ready to try printing from Solar Maps. 

 To print the currently displayed map and chart lines 

Select “Print...“ from the “Chart“ menu. 

This will display the “Print Current Map” dialog box 

 

 

 

 To alter your printer settings (e.g. change the printer resolution) 

Click on the “Setup...“ button. 

See your Windows manual or your printer’s manual for further explanation on 

printer setup options. Typically this option is used to ensure that you have selected 

the correct page size for your paper, the appropriate print resolution (i.e. print 

quality), and any other options that your printer may allow you to choose. 

 To start printing 

Click on the “Print“ button. 

This will send the printout to your printer. If you have disabled your print manager, 

then the printer should start printing almost immediately. However, if the print 

manager is enabled (as is usually the case), then the printout is sent to the Windows 

print spool file first, and the printer will not start printing until the whole printout file 

has been sent. 
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If your printer is offline or otherwise unable to print, then Windows will normally 

issue a message to tell you this, and ask you to either correct the problem or to cancel 

the printout. 

 

Note: Solar Maps always prints maps in landscape (sideways) orientation, 

regardless of which orientation you choose in the printer setup. This is done to 

ensure that the printed map retains a similar height/width ratio to the screen. 

 

5.17 Copying Output for External Use 

The map and chart lines that you are viewing in the main screen can be copied to the 

Windows clipboard, to a graphics file, or as an email attachment file. Also, the 

current chart and map details can be copied to the Windows clipboard. 

 To copy the current map and chart image 

Select “Copy image to…” from the “Chart” menu 

A dialog box will be shown to allow you to select the copy destination and type. 

 

 

 

The possible destinations are as follows. 

 Clipboard - for pasting into other programs such as word processors, desktop 

publishers and drawing programs. 

 File – for storage on your computer disk, for importing into other programs. If 

you choose this option then you will be prompted to enter a file name and 

location to save to. 

 Email attachment – for sending to other via email. If you have a suitably 

configured (MAPI compliant) email program, then this will create a GIF graphic 

file and open your email program with the a new email with the graphic file 

already attached. 

 

The possible graphic types are as follows. 

 Bitmap – Standard windows bitmap format – large file size, common format 
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 GIF – Graphic Interchange format – small file size and limited to 256 colors, but 

useful for efficient email and web page graphics 

 

Note: the clipboard destination only allows the bitmap graphic type, and the email 

destination only allows the GIF graphic type. 

Note: MAPI is a mail automation protocol that allows third party programs to 

automate the generation of email. 

In order to use these automated email options, you must have a MAPI compliant 

email program. All Microsoft email programs (e.g. Outlook and Outlook Express) 

and Eudora are MAPI compliant, for example. 

You may also need to ensure that the MAPI options are activated in some email 

programs, for example in Eudora Pro v3, you may need to go into the Tools / Options 

menu item, find the MAPI category, and ensure that “Use Eudora MAPI server” is 

switched to either “When Eudora is Running” or “Always”. If you are unsure about 

any of these options, you should consult the documentation of your email program 

(e.g. search for “MAPI”), or contact the manufacturer of your email program. 

 

 To copy the current map and chart details as text 

Select “Copy text details to clipboard” from the “Chart” menu 

This copies information about the current chart, selected line types and map details. 

This information can usefully be pasted along with the image itself which was copied 

with the “Copy image to…” option. A sample of such text is as follows. 

 

Chart: 

 Albert Einstein - Natal 

 14 Mar 1879 

 11:30 AM  -0:40 

 Ulm 

 48N24 010E00 

 Tropical Zodiac 

Lines: 

 Culminate/Anticulminate/Rise/Set 

Eclipse:  

 4 Dec 2002 

Map Description: 

 Australia  
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5.18 Viewing Interpretations 

Solar Maps contains textual interpretations of all the major planet lines that you are 

likely to see on a map, and these can be accessed quickly and easily with the mouse. 

Before viewing interpretations, make sure that the mouse mode is set to 

Interpretations. 

 To set the mouse mode to Interpretations 

Select the “Interpretations“ mode from the “Mouse Mode“ item under the 
“Options“ menu or select the “Interpretations“ mouse mode button from the 
button panel. 

Interpretations are potentially available for any enclosed symbol either inside or 

around the outside of the map. For example, if you have chosen to display 

Planet/Angle Lines on a world map, then there will probably be symbols for each 

planet’s MC line across the top of the map, for each Planet’s IC line across the 

bottom of the map, and for the Asc/Dsc lines at the sides of the map. Additionally 

there will be symbols where each planet is overhead on the map, and at some point 

along the Asc and Dsc lines. 

 To get an interpretation for any line/symbol 

Click whilst the mouse cursor is on the symbol. 

This will display the interpretations window. 

 

 

 

This window contains a title bar and a scrollable text box. The title bar describes the 

type of symbol that you have clicked on, and the text box contains any subtitles 

further identifying the line or symbol type, plus the body of interpretation text. 

You may resize the interpretations windows or place it anywhere on the screen that 

you wish. 

 To hide the interpretations window 

Click anywhere outside the interpretations window or close the interpretations 
window. 
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The interpretations window can be reopened or redisplayed at any time just by 

double-clicking on any symbol again. 

 To extract the interpretations text for use in some other program (for 

example a word processor) 

1. Highlight the required text by dragging the mouse over it. 

2. Use the “Ctrl“+”C“ keys. 

3. Change the focus to your other program. 

4. Paste the text into your word processor or other application in the usual 
manner. 

 

5.19 Viewing a Local Horizon Chart 

It is possible to view and print a local horizon wheel for the currently selected chart. 

The local horizon chart displays a wheel with the compass directions onto which the 

directions (azimuths) of the displayed planets and stars are plotted. Each planet is 

shown with its symbol in the outer ring, and with a line from the centre of the wheel 

directed outwards towards the symbol. Each line is also extended in the opposite 

direction as a dashed line. If this wheel is printed out onto a transparency, it can be 

overlaid onto a map, and it is then possible to see where the lines of planetary 

influence extend. 

 To view the local horizon chart 

Select the “View Local Horizon Chart“ item from the “Chart“ menu. 

This will display the Local Horizon Chart Window.  
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This window may be resized or moved as required. Resizing the window causes the 

chart wheel to be redrawn to fit the window as closely as possible, whilst 

maintaining a circular shape. 

 To print the displayed wheel on your printer 

Click on the “Print...“ button. 

This will display the “Print Current Chart” dialog box, from which you may choose 

to alter printer settings, or to go ahead and print the chart. 

 To return to the current map display 

Click on the “Quit” button. 

 

5.20 Viewing a Chart Wheel 

It is possible to view and print a simple zodiacal chart wheel for the currently 

selected chart. This wheel displays the positions of the displayed planets (and 

optionally stars). The house system used may be altered under the “Options“ menu, if 

desired. 

 To view the chart wheel 

Select the “View Chart Wheel“ item from the “Chart“ menu. 

This will display the Chart Wheel window. 
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 This window may be resized or moved as required. Resizing the window causes the 

chart wheel to be redrawn to fit the window as closely as possible, whilst 

maintaining a circular shape. 

 To print the displayed wheel on your printer 

Click on the “Print...“ button. 

This will display the “Print Current Chart” dialog box, from which you may choose 

to alter printer settings, or to go ahead and print the chart. 

 To return to the current map display 

Click on the “Quit” button. 
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6 Maps 
The main window in Solar Maps always displays a map. When the program first 

starts, it will display a map of the world. You have the option of selecting any other 

stored map to be displayed, or of creating and customising your own maps. If you 

resize the window, then the map will be automatically redrawn to fit the new window 

size. 

Solar Maps has a particularly powerful map database. It is possible to use it to create 

maps spanning the whole world, as well as maps spanning less than a single degree 

of longitude (typically equivalent to about 100 kilometres or 60 miles). 

It is also possible to zoom into a map in increasing magnification to look at a region 

in greater detail, or to move a map in any direction in order to view adjoining regions 

which are off the edge of the current map. 

When you first start using Solar Maps, you might prefer to use only the maps which 

are supplied with the program, and avoid using the more advanced map creation and 

editing features until you are more familiar with the capabilities of the program. In 

this case you need only know how to select a map. 

 

6.1 Selecting a Map 

Solar Maps is supplied with a range of pre-defined map files covering most regions 

of the world. Note that the user can also create an unlimited numbers of additional 

maps of any areas with a variety of display options, and these may be stored along 

with the pre-defined maps. 

 

 To select and display a map from the list of predefined maps 

Select “Open...“ from the “Map“ menu, or click on the “Map“ button above the 
map display area. 

This will display the “Map Selection by Region” dialog box, which contains a list of 

maps organised into a collapsible/expandable hierarchical list by region. The regions 

are listed in alphabetical order, and the maps within each region are listed in 

alphabetical order of their descriptions, and have their file names shown in square 

brackets following the descriptions. 
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To find and select a particular map to display, you can navigate the list by first 

finding the required region, expand the sublist entries for that region, and then 

highlight and select the required map which is then displayed in the main map 

screen. 

You can also use this map selection dialog to do any of the following. 

 Rename the region entries 

 Create new region entries 

 Edit map descriptions 

 Delete maps 

 Move maps from one region into another region 

 

 To navigate through the region or topic headers 

Click on the box with the “-”  or “+“ sign to the left of the region name, or 
double –click on the region name itself. 

This will expand or collapse the sublist of maps within that region or topic header.  

 To select a map from a sublist of map files 

Click on the map description in the list and then click on the “Open“ button, or 
double-click on the map description, or use the right hand mouse button to 
choose the “Select” menu item. 

Doing so will display the required map. 
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 To delete a map 

Click on the map description and use the right hand mouse key to display a 

pop-up menu, and select the Delete item. 

You will be asked to confirm before the map file is deleted and removed from the 

list. 

 To edit a map description 

Click on the map description and use the right hand mouse key to display a 

pop-up menu, and select the Edit Description item. 

You will be prompted with a dialog allowing you to enter a new description. 

 To add a new region or topic header 

Click on any region name and use the right hand mouse button to display a 

pop-up menu, and select the Add Topic item. 

This will display a dialog allowing you to enter the new category name 

 To rename a region or topic header 

Click on the topic category name and use the right hand mouse button to 

display a pop-up menu, and select the Rename Topic item. 

This will put a focus box around the topic category name and allow you to edit it. 

 To move a map from one region or topic header into another 

Simply drag the map entry onto another region or topic header name. 

If the region or topic header you wish to move to is off the top or bottom of the page, 

then drag the page off the top or bottom of the list. This will cause the list of pages to 

collapse, and scroll up or down respectively, thus making the required target topic 

category visible. 

 To delete a region or topic header 

To remove a region or topic header, simply delete or remove all the maps 
within it. 

When the list of maps is next refreshed, the empty region will have disappeared. 

 To refresh the list of maps after making changes 

Use the F5 key. 

This is the standard Windows key for refreshing lists of files. 

  

 To draw a new map 

Select the “New“ menu item from the “Maps“ menu on the main screen. 

This will then open the map which is stored under the list of maps as new.sfm. 

Initially, this is a map of the world in Cartesian coordinates. However, if you prefer 

to replace this with your own map design, then you can do so by setting up the map 

as you want it, and then saving it under the name new.sfm. This will replace the 

existing map with your own, and this map will then be displayed whenever you 
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select the new map option. (If you delete the new.sfm map file, then Solar Maps will 

display a map of the world with no color fills when this option is chosen.) 

 

6.2 Re-Opening a Recently Used Map 

Each time that you select a map from the list of pre-defined maps, the name of that 

map file is added to the list at the bottom of the “Map“ menu. The eight most 

recently opened maps are listed on the menu, with the most recent one at the top of 

the list.  

 To re-open one of the eight most recently opened maps 

Click on the item with the name of the map at the bottom of the “Map“ menu. 

Whichever map you re-open in this way will then appear at the top of that list. 

 

6.3 Saving a Map 

You can save as many maps as you wish. Each map can be saved into its own map 

file, with a name of your choice. The specific items that are saved when you save a 

map are 

 A description of the map 

 The range of latitude and longitude covered by the map 

 The map projection 

 Which details to show (e.g. lakes, rivers, city names etc) 

 Coordinate grid options 

 City file name 

 Color fill points (including any special fill colors that you may have selected) 

 

 To save the current map 

Select the “Save As...“ item from the “Maps“ menu. 

This will display the “Save File As” dialog box. 
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You can enter a description to be saved with the map in the text box at the top of the 

screen. This description is displayed whenever you browse through the list of maps 

to open, so it is helpful to enter a useful description which will allow you to see 

whether this file contains the map that you want. For example you could enter the 

name of the geographic region covered by the map, plus an indication of the map 

projection used. 

All of the maps must be stored in Solar Maps USERDATA directory in order to be 

re-opened for future re-use, but if necessary, you can choose a different disk drive by 

selecting an item from the drop-down list of drive names, and look in a different 

directory by double-clicking on directory names in the directory list box on the left. 

For example, you may wish to select the A: drive if you want to save a map to a 

diskette to send to someone else. 

The file name can be entered into the File Name text box. 

 To save the map with the displayed name and description 

Click on the “Save“ button. 

The map will then be saved, and can be reopened at any time. 

Examples of items that are not saved with a map file, and are therefore independent 

of any individual map are 

 The land and sea colors 

 The selected chart 

 Displayed line types 

 Line colors 

 Symbol sizes 

 Eclipse selections 

 Displayed planets 



Chapter 6: Maps 67 

 

 

6.4 Using the Mouse 

The mouse may be used to perform eight different modes of action. These modes are 

 General – To display latitude and longitude or Ascendant and Midheaven 

position 

 Measure - To Measure Distance or Angular Separation on the Map 

 Zoom - To Zoom into a Region on the Map 

 Move - To Move and Reposition the Map 

 Relocate - To Relocate the Currently Displayed Chart 

 Fill - To Fill Regions of the Map with Color 

 Rulers - To Place and Move Rulers on the Map 

 Interpretations – To view interpretations of planetary chart lines on the map, 

or relocation reports 

 

The mouse General mode is active in combination with any of the other modes, and 

cannot be selected on its own. 

 

 To switch the mouse into any one of the modes 

Select the required mode from the “Mouse Mode“ item under the “Options“ 
menu 

or 

Select the required mouse mode button from the button panel. 

 

 

 

The way in which the mouse behaves under each mode is listed below. In each case, 

to cancel the mouse action before the button is released, you may use the “Esc“ 

button on your keyboard. 

 General – Moving the mouse cursor over the map causes the latitude and 

longitude of the cursor position to be displayed at the top, left of the screen. 

Depressing the right-hand mouse button causes the Midheaven and Ascendant 

of the cursor position for the current chart to be displayed instead. This 

behaviour works in combination with all other selectable mouse modes. 
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 Measure - Clicking the mouse button down fixes the first measurement point. 

Dragging the mouse to any other points causes the coordinate box (on the top 

left of the screen) to display the distance between the two points in terms of 

angular separation and distance in kilometres and miles. The curved line 

between the two points shows the great circle line which is the shortest line 

joining the two points along the Earth’s surface. Releasing the mouse button 

terminates the measurement. 

 Zoom (Automatic with click) – Moving the mouse cursor over the map causes 

the outlines of other stored maps to be displayed as the mouse moves over them. 

Clicking the mouse whilst one of these map outlines is displayed will cause a 

zoom to that pre-defined map area. Clicking the mouse whilst no map outline 

rectangle is displayed will result in a zoom in by a factor of 3, centred on the 

cursor’s position.  

 Zoom (User-defined area by dragging) - Clicking the left-hand mouse button 

down fixes the first corner point for the zoom rectangle. Dragging the mouse to 

any other point causes the zoom rectangle to grow or shrink accordingly. Note 

that the zoom rectangle has a fixed aspect ratio (width to height), so the mouse 

controls only the width of the rectangle, not its height. Releasing the mouse 

button causes the map to be zoomed into the region selected by the zoom 

rectangle. 

 Move - Clicking the mouse button down fixes the movement reference point. 

Dragging the mouse to any other point displays a line showing the selected 

movement of the reference point e.g. Dragging down would move the map 

downwards. Releasing the mouse button causes the map to be moved by the 

selected amount. 

 Relocate - Clicking the mouse causes a line to be drawn from the chart’s 

location to the current mouse position. (If the chart’s location is not shown on 

the map, then this line may extend off the edge of the map.) Releasing the 

mouse button causes the chart to be relocated to the current mouse position. If 

the selected location is near a displayed city point, then the relocation is 

assumed to be for the stored coordinates of that city. 

 Fill - Clicking the mouse on any point in the map will cause that region of the 

map to be filled with either the “Sea Fill Color“ or with a “Special Fill Color“, 

depending on which of these has been selected from the “Map“ menu. See page 

132 for further details. 

 Rulers - Clicking the mouse button down whilst the mouse is above or below 

the map area causes a new horizontal ruler to appear. This may be dragged to 

any desired position on the map. Releasing the mouse button causes the ruler to 

become fixed at that position. Similarly, clicking to either side of the map 

causes a new vertical ruler to appear. Clicking the mouse anywhere inside the 

map causes the nearest existing ruler to jump to that location. This may then be 
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dragged and dropped at a new location. Dragging any ruler off the edge of the 

map and then dropping it causes it to be deleted. 

 Interpretations – Clicking the mouse on any line glyph around the outside of 

the map, or inside the map, will display an interpretation of that line. Such line 

glyphs include planet/angle lines, paran lines, eclipse lines etc. Clicking 

anywhere else on a map will result in the user being asked whether they wish to 

view a relocation interpretations report for that location, for the current chart. 

 

6.5 Selecting Map Options 

Any map in Solar Maps may be customised in various ways, for example showing 

major lakes and rivers, state borders and labelling various cities. Also the projection 

of the map may be changed to any of 4 pre-defined options, including “flat” and 

circular views, and lines of longitude and latitude may be added. 

 To select or change map display options 

Select the “Map Options...“ item from the “Maps“ menu. 

This will display the “Select Map Options” dialog box. 

 

 

 

This dialog box contains three categories of options, which are 

 Details to Show - What kind of features to include on the map 

 Projection - In what form to display the map 

 Coordinate Grid - Whether to display reference lines of latitude and longitude 

 

6.5.1 Selecting Details to Show 

Each category of detail type may be switched on or off by clicking on its check box. 

The details types are 
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 Lakes - If selected, then any major lakes in the map region will be drawn 

 Rivers - If selected, then any major rivers in the map region will be drawn 

 Country Borders - If selected, then any country borders in the map region will 

be drawn 

 State Borders - If selected, then any state borders in the map region will be 

drawn onto the map 

 Country Names - If selected, then any country names in the map region will be 

written onto the map 

 City Names - If selected, then any city names in the map region will be written 

onto the map 

 

Note that only those lakes, rivers, country borders and state borders which are 

included in the Solar Maps map database can be drawn on maps. For example, state 

borders are only included for the USA, Canada and Australia. 

If the “Country Names” option is selected, then the country file is searched to find 

country names which are available to be plotted on the current map region, whenever 

the map is redrawn. It is possible to customise the country names and alter the 

conditions upon which each name is plotted. See page 77 for instructions on how to 

do this. 

If the “City Names” option is selected, then the current city file is searched to find 

city names which are available to be plotted on the current map region, whenever the 

map is redrawn. If no city file is currently selected, then you will first be prompted to 

select a city file. See page 73 for instructions on how to do this. 

 To change the selection of city file 

Click on the “City File...“ button. 

This results in the “Select Cities File to Open” dialog box appearing, from which you 

can choose an existing city file, or create a new city file. For more information on 

this process, see page 73. 

 

6.5.2 Selecting Projection 

The four types of projection which may be selected are as follows 

 

Cartesian 

The Cartesian map projection involves displaying both latitude and longitude on a 

linear scale, so that the whole world appears as a rectangle. 
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Mercator 

The Mercator projection displays lines of longitude at regular, proportional intervals, 

but uses a logarithmic expansion of the latitude, so that polar regions become 

stretched. The rationale behind this projection is that a straight line on this map is 

also a line of constant compass bearing. It is not possible to display the poles using 

this projection, as the mapping algorithm would cause them to be stretched out to 

infinity. Therefore Solar Maps limits the displayed latitude to 80º. 
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Globe (Sphere) 

The spherical projection is what you would see if you viewed the Earth from a great 

distance. Only half the globe is visible at one time. 

 

 

 

Globe (Oblate) 

The oblate projection is similar to the spherical projection except that the globe is 

stretched horizontally to make maximum use of space on the rectangular screen. 
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6.5.3 Selecting Coordinate Grid 

The coordinate grid may be switched on or off, and if it is on, then you may specify 

at what intervals of longitude and latitude the grid lines should be drawn. 

 To switch the grid lines on or off 

Click on the “Show Grid” check box. 

This will switch the grid on if it is off, or switch it off if it is on. If it is switched on, 

then you may enter the intervals (in whole degrees) for the lines of latitude and 

longitude. These must be numbers between 1 and 90 inclusive. 

The first line is always drawn at 0º of latitude and longitude, and subsequent lines 

are drawn at the specified interval in each direction. For example, if the interval of 

latitude is 30º, then lines of latitude are drawn at 0º, 30ºN, 60ºN, 30ºS, 60ºS. 

 

6.6 Editing Cities 

Solar Maps initially contains a selection of city files which have been split up to 

cover various geographical regions. The city name entries contained in these files 

may be plotted on maps, or they may be used to help select a location for a report or 

chart relocation. It is possible to customise these files by adding, deleting or editing 

individual entries, creating new files or copying entries between files. 

Each stored map in your program may be associated with a city file of your choice. 

By default, any new map that you create will automatically become associated with 

the same city file as the map from which it was derived. For example, when you 

create a new map using the “New“ item under the “Maps“ menu, the city file 

world.smc is associated with that map. If you create a new map by zooming into a 

smaller region, and then save it under a new map file name, then that map will also 

be associated with the world.smc city file. 

 To associate a different city file with your currently displayed map 

1. Select the “Map Options...“ item from the “Maps“ menu. 

2. Click on the “City File...“ button. 

or 

1. Select the “Edit Cities...“ item from the “Maps“ menu. 

2. Click on the “Select File...“ button. 

In either case, this will display the “Select City File to Open” dialog box. 
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 To select a file from the list of city files 

Click on the file name in the list and then click on the “Open“ button, or 
double-click on the file name. 

Note that when you click on a file name, a caption appears in the box along the 

bottom of the window indicating how many city entries are contained in that file. 

All of the city files are initially stored in Solar Maps USERDATA directory, but if 

necessary, you can choose a different disk drive by selecting an item from the drop-

down list of drive names, and look in a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to open a map which is stored on a diskette. 

You also have the option of creating a new, empty city file, which you can later 

populate with city names. 

 To create a new city file 

1. Click on the “Create... “button. 

2. Enter up to eight characters as a new file name. 

3. Click on the “OK” button. 

The newly created (empty) city file will then appear in the list of files, and may be 

selected if desired. 

After you open a city file, that file becomes associated with the current map. Note 

that you must re-save the map after doing this if you wish this change to be 

permanent. 

 To add, delete or edit entries in the current city file for the current 

map 

Select the “Edit Cities...“ item from the “Maps“ menu. 

This will display the “Edit Cities” dialog box. 
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The information that is stored for each entry in the city file is 

 Name - This name is what appears on the map. 

 Latitude - The latitude at which the name is to be plotted. See page 130 for a 

description of valid latitude formats. 

 Longitude - The longitude at which the name is to be plotted. See page 130 for 

a description of valid longitude formats. 

 Zone - In earlier versions of Solar Maps, this was the timezone observed in that 

city. However, this data is now not used in any other part of Solar Maps, so it 

has been disabled. Timezones are now always found automatically, when 

required, from the embedded ACS Atlas which contains an extensive timezone 

database throughout the world, including daylight savings periods. 

 Plot If <= - This controls how wide the map must be in order for the name to be 

plotted. For example, if a value of 100 is entered, then this name will only 

appear on maps which cover less than 100º of longitudinal width. If its value is 

set to 360º, then this name will be plotted on every map with which this city file 

is associated. (Note that, for easy reference, the width of the currently display 

map is displayed just to the right of this field. If you enter a value greater than 

the current map width, then it will be displayed on this map. If you enter a value 

smaller than the current map width, then it will be displayed only of maps of 

smaller size.) 
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 Alignment - This controls where the symbol is plotted in relation to the city 

name. If the Left option is chosen, then the name is aligned so that the symbol 

is on the left of the name (i.e. +Name). If the Right option is chosen, then it is 

aligned with the symbol on the right (i.e. Name+). If the Centre option is 

chosen then the name is centred over the symbol (i.e. Na+me). 

The order of entries is initially always alphabetical. However, you can sort the 

entries in the following orders. 

 Alphabetic – From A to Z 

 Latitude – From most southerly to most northerly 

 Longitude – From most easterly to most westerly 

 Plot Width Flag – from largest plot width (most visible) to smallest plot width 

(least Visible) 

 To sort the entries in the city list 

Click with the right hand mouse button over the list. 

You will see a pop-up menu with the above sort options, from which you may select 

one. 

 To edit an existing entry in the city file 

1. Click on the required entry in the listbox. 

2. Edit the information fields. 

See the description of fields above. 

 To edit multiple entries at once 

1. Whilst holding down the “Ctrl“ key, click on each of the required entries, or 
Click on the “Select All “button to select all the entries in the list. 

2. Edit the required information fields. 

It is only possible to change the Plot If <= and the Alignment fields simultaneously 

for multiple entries in the list. 

 To add a new entry to the list 

1. Click on the “Add City“ button. 

2. Enter data into the information fields. 

You will then see the “ACS PC Atlas” dialog box which allows you to enter the city 

name and look up its details in the Atlas. These details will be inserted automatically 

into the information fields on this screen. If you wish to enter the details manually, 

then just Cancel the ACS dialog, and you will be able to enter the details yourself. 

 To delete one or more entries from the list 

1. Click on the desired entry or Whilst holding down the “Ctrl“ key, click on 
each of the required entries. 

2. Click on the “Delete“ button. 

You will be asked to confirm deletion before the selected entries are removed. 
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 To copy one or more entries from this city file into another city file 

1. Click on the desired entry, or Whilst holding down the “Ctrl“ key, click on 
each of the required entries. 

2. Click on the “Copy...“ button. 

You will then see the “Select City File to Copy Into” dialog box, from which you 

must select a city file into which the selected entries will be copied. 

 In order to exit from this screen 

Click on the “OK“ button. 

You will be asked whether or not you wish to save the changes that you have made. 

If you choose to save them, then the entries will be saved and sorted into alphabetical 

order for next time you use this screen again. If you choose not save them, then any 

changes that you made using this screen will be lost. 

 

6.7 Editing Countries 

Solar Maps contains a single country file which contains information relating to 

country names, sizes and locations. It is possible for the user to edit, add or delete 

entries, and alter the conditions under which certain entries are written onto maps. 

The country file can also potentially be used to store information on other 

geographical features such as seas, oceans, desert regions etc. which can all also be 

plotted onto maps. 

 To edit information in the county file 

Select the “Edit Countries...“ item from the “Maps“ menu. 

This will display the “Edit Countries” dialog box. 

 



78  Chapter 6: Maps 

 

 

 

The information that is stored for each entry in the country file is 

 Name - This name is what appears on the map. 

 Latitude - The latitude at which the name is to be plotted. See page 130 for a 

description of valid latitude formats. 

 Longitude - The longitude at which the name is to be plotted. See page 130 for 

a description of valid longitude formats. 

 Plot If <= - This controls how wide the map must be in order for the name to be 

plotted. For example, if a value of 100 is entered, then this name will only 

appear on maps which cover less than 100º of longitudinal width. If its value is 

set to 360º, then the area of the country (1000 km
2
) is used to determine 

whether the name is plotted, instead. 

 1000 km
2
 - This is the area of the country in thousands of square kilometres. If 

the Plot If <= field is set to any value other than 360, then this field is ignored. 

Otherwise this value is used to control whether the name is plotted on maps of 

various sizes. Names with large areas are plotted on all maps, with medium 

areas on smaller maps, and with small areas only on the smallest maps. This 

value may be set to zero if the actual area is unknown, or if the entry relates to a 

geographical feature which does not have an area. In this case, you can use the 

Plot If <= field to control on which maps the name is plotted. (Note: 1000km
2
 

is equal to approx 386mi
2
.) 
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Note that the “Zone...“ and ”Copy...“ buttons are disabled as they do not apply to the 

country entries. 

 To edit an existing entry in the country file 

1. Click on the required entry in the listbox. 

2. Edit the information fields. 

These fields are described above. 

 To edit multiple entries at once 

1. Whilst holding down the “Ctrl“ key, click on each of the required entries or 
Click on the “Select All“ button to select all the entries in the list. 

2. Edit the required information fields. 

It is only possible to change the Plot If <= and the 1000 km
2
 fields simultaneously 

for multiple entries in the list. 

 To add a new entry to the list 

1. Click on the “Add Country“ button. 

2. Enter data into the information fields. 

If you change your mind half way through entering new data, you will need to delete 

this entry. 

 To delete one or more entries from the list 

1. Click on the desired entry, or whilst holding down the “Ctrl“ key, click on 
each of the required entries. 

2. Click on the “Delete“ button. 

 In order to exit from this screen 

Click on the “OK“ button. 

You will be asked whether or not you wish to save the changes that you have made. 

If you choose to save them, then the entries will be saved and sorted into alphabetical 

order for next time you use this screen again. If you choose not to save them, then 

any changes that you made using this screen will be lost. 

 

6.8 Using Color Fills 

It is possible to create and draw maps using any combination of colors that are 

allowed by your computer’s display.  

A normal map uses only two main default colors - these are the background land 

color and the sea fill color. These default colors may be changed easily, and saved as 

part of the standard settings which are independent of any individual map. See page 

107 for instructions on how to change the default land and sea colors, which affect 

all maps. 
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When a map is displayed, it is first drawn with just the background land color. In 

order to show the sea color on top of this, a variety of sea fill points have been added 

to each map. These are locations on the map from which the sea fill color is 

generated, and fills the entire surrounding region up to any coastlines, state or 

country borders on the map. Usually it is only necessary to have a couple of sea fill 

points on a map in order to correctly color all the sea regions on the map. Additional 

sea fill points are also included for any enclosed regions such as lakes or inland seas. 

All of the maps which are initially supplied with Solar Maps already have sea fill 

points. However, when you zoom or move a map it is possible that you will 

sometimes find a region of sea which has not been filled with the sea color. In this 

case, it is easy for you to add one or more sea fill points to correct the problem. 

It is also possible for you to add special color fills to any enclosed areas of the map, 

and to have these special fill colors saved with the map. In this manner you can 

create multicolored maps with different colors for each country or state, for example. 

 To add a sea fill point 

1. If it is not already selected, then click on the “Fill“ mouse mode button. 

2. If it is not already ticked, then select the “Sea Fill Color“ item from the 
“Maps“ menu. 

3. Click inside an area on the map which you want to be filled with the sea 
color. 

The surrounding area will be filled in with the current sea color. 

 To add a special color fill point 

1. If it is not already selected, then click on the “Fill“ mouse mode button. 

2. If it is not already ticked, then select the “Special Fill Color“ item from the 
“Maps“ menu. 

3. Select the desired color from the “Color Selection” dialog. 

4. Click inside an area on the map which you want to be filled with the sea 
color. 

See page 132 for a description of how to use the color selection dialog. 

Note that the color fill can only be done instantly if any chart lines, city and country 

names are removed first. If any of these items are displayed on your map before you 

perform a color fill, then a message will appear reminding you that the whole map 

will have to be redrawn in order to apply the fill color correctly. If you are adding a 

single fill point, then this is normally not a problem, but if you wish to add many fill 

points, then it is best to first switch off all the items which might interfere with the 

color fill process. Once you do this, the map does not have to be redrawn each time 

that you add a fill point, which makes the process quicker and easier. You can switch 

the required items back on again after you have finished adding color fill points. 

If you accidentally add an incorrect fill point, then you can easily remove it. 
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 To remove a color fill 

Select the “Remove Last Fill“ item from the “Maps“ menu. 

The map will then be redrawn with the last fill point removed, and you can continue 

adding fills if you wish. 

It is also possible, on occasion, that when you zoom into a map the sea or special fill 

color may extend into regions into which they should not. (This may happen, for 

example, if the zoomed map is drawn with a greater level of map detail than the 

original map. In this case, if a fill point is very close to a coastline in the original 

map, it could actually fall on the wrong side of the coastline when the coastline is 

drawn at a higher resolution.) In this case you would be best advised to remove all 

the color fills and then to manually refill the new zoomed map from scratch. 

 To remove all the color fill points on the map, in order to start filling 

from scratch 

Select the “Remove All Fills“ item from the “Maps“ menu. 

The map will then be redrawn without any color fills at all, and you can add new fill 

points if you wish. 



82  Chapter 7: Fixed Stars 

 

7 Fixed Stars 
In addition to the standard planets, asteroids and hypothetical planets, Solar Maps 

also allows you to include fixed stars or other astronomical points in your map 

display and charts. The program is supplied with a set of 36 commonly used stars, 

but you can also select from a much larger supplied set of about 300 stars, or even 

enter your own star data if you prefer. In order to use fixed stars, you must first open 

a star file, and then select which stars you wish to display. Solar Maps is limited to 

displaying 36 fixed stars at any one time. If you attempt to open a star file which has 

more than 36 stars in it, then only the first 36 stars will be read in, and the other stars 

ignored. To use stars other than the first 36 in the file, you must use the fixed stars 

editor to move the required stars to the beginning of the star file, or to copy the 

required stars into a new, smaller star file. 

 

7.1 Opening a Star File 

You may open any star file (of type Solar Fire v3/v4/v5 format) which exists on your 

computer or on a diskette, but only the first 36 stars of that file will be accessible 

from within Solar Maps. 

To use stars which are not already included in a star file on your computer, use the 

Fixed Star Editor to create new star files or add or edit stars in existing star files. 

This is a separate program with its own icon. See page 135 for further information on 

how to use this. 

 To open a star file 

Select “Open Star File...“ from the “Stars“ menu. 

This will display the “Select Star File to Open” dialog box, displaying a list of star 

files from which you can choose. 
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Note that when you click on a file name, a description of the file appears in the box 

along the bottom of the window. 

The star files are initially stored in Solar Maps USERDATA directory, but if 

necessary, you can choose a different disk drive by selecting an item from the drop-

down list of drive names, and look in a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to open a file which is stored on a diskette. 

After you open a file, you will be prompted to select stars from within that file to 

display. 

 

7.2 Selecting Stars 

Once a star file has been opened, it is possible to select any of the first 36 stars in 

that file to be displayed alongside the other selected chart points. 

 To select the stars 

Select the “Select Stars...“ item from the “Stars“ menu. 

This will display the “Select Stars” dialog box. 
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 It is possible to select as many or as few stars as are required by clicking on 

individual entries in the list. The stars are labelled with alphabetic characters in 

sequence from A to Z and then a to j. The labels are required as symbols for the stars 

when star lines are labelled on the maps. 

 To make multiple selections from the list 

Hold down the “Ctrl“ key whilst clicking with the mouse. 

 To return the selection of stars to be the same as it was before new 

selections were made 

Click on the “Default“ button. 

 To switch off all selected stars 

Select the “Clear Stars“ item from the “Stars“ menu. 
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8 Eclipse Paths 
Solar Maps contains eclipse information for all the solar eclipses from the year 1801 

to 2200. (Lunar eclipses are not included because they do not have paths on the 

Earth’s surface, as the same phase of lunar eclipse is visible from everywhere on the 

Earth’s surface simultaneously.) It is possible to view the paths of these solar 

eclipses over the Earth’s surface, as well as to see certain other details such as the 

zodiacal positions of the eclipses and their Saros Series numbers. 

When the eclipse is a total eclipse, the path of totality can be plotted on any map. For 

all eclipses, paths of constant magnitude of eclipse can be plotted (for example, a 

line along which the maximum obscuration of the sun is 50% of its area, as seen 

from the Earth). 

The eclipses in Solar Maps are divided into the following classification types. 

 Partial - The path of totality is off the edge of the Earth’s surface. In this case, 

maximum obscuration occurs in polar regions. The amount of  obscuration is 

usually referred to as the maximum percentage of the sun’s disk which is 

obscured. 

 Central Annular - The Moon is too small to obscure the whole sun, so a ring 

(annulus) remains around the Moon when it is in front of the sun. 

 Central Total - The Moon is large enough to obscure the whole sun. 

 Non-central Annular - An annular eclipse which grazes the edge of the Earth’s 

disk. 

 Non-central Total - A total eclipse which grazes the edge of the Earth’s disk. 

 Annular-Total - An eclipse which is annular for part of its path, and total for 

the rest. 

 

Also shown for each eclipse are the following items. 

 The zodiacal longitude of the sun at the time of maximum eclipse 

 The hemisphere in which the eclipse falls 

 The lunation number (relative to the first lunation of the year 2000) 

 The Saros Series number (using van den Bergh’s numbering system) 

 

8.1 Selecting Eclipses 

 To select a solar eclipse to display over the current map 

Select “Select Eclipse...“ from the “Eclipse“ menu or click on the “Eclipse“ 
button above the map display area. 
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You will be presented with the “Select Eclipse” dialog box from which you can 

select an eclipse. 

 

 

 

When you click on an eclipse in the listbox on the left, the details of that eclipse will 

be displayed in the box at the top, right. 

Additionally, you may select which of the following items to display by clicking on 

their check boxes. 

 Total Eclipse Line - If selected, this will display the central line of total eclipse 

 Partial Eclipse Lines - If selected, this will display lines of equal magnitude of 

eclipse in intervals of 25% by default. 

 Geodetic Chart for Eclipse - If selected, this will calculate the chart for the 

time of maximum eclipse and display it geodetically. For an explanation of 

geodetic charts, see page 52. 

 Current Chart - If selected, the currently displayed chart will be retained and 

plotted at the same time as the eclipse lines. 

 Retain Previous Eclipses – If selected, then the previously selected eclipses 

which are listed immediately below this checkbox will be retained and plotted 

along with the newly selected eclipse. By using this option, it is possible to 

superimpose eclipse lines for any number of eclipses, if desired. However, if 

you wish to plot just a single eclipse line, then ensure that this checkbox is 

switched off. 
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Note that the Total Eclipse Line option is not available for partial eclipses, and the 

Current Chart option is only available if you have previously selected a chart. 

 To view the selected eclipse/s 

Click on the “OK“ button or double-click on the required eclipse. 

You will then be returned to the main screen of Solar Maps, and the newly selected 

eclipse will be used to draw lines over the current map. 

Note: If you have retained multiple eclipse lines to display, then you can identify 

which lines belong to which eclipse by switching on the mouse interpretations mode, 

and then clicking on any of the eclipse line symbols at the line endings or map edges. 

 To remove any currently selected eclipse/s, and leave the map 

without any eclipse lines displayed 

Select the “Clear Eclipse“ item from the “Eclipse“ menu. 
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9 Plotting Tracks and Events 
Mundane astrologers often have an interest in major weather events, earthquakes, 

and other geographically related phenomena.  

Solar Maps makes it possible to plot these events (either singly or in composite) on 

its maps, and allows chart planetary lines for any related astrological chart to be 

displayed simultaneously if required. 

There are two categories of geographic phenomena which may be plotted in Solar 

Maps: 

 Tracks – a collection of linked individual events (date-times and locations) which 

may be plotted as a track across the earth’s surface, such as a hurricane track or a 

ship’s course. 

 Events – a collection of individual events (date-time and location) which may be 

plotted as individual locations, such as a collection of earthquakes epicentres, 

battles or volcanic eruptions. 

Whilst this feature may be used to plot any events or tracks of almost any nature, 

special provisions have been added to make it especially easy to import and plot 

storm tracks and earthquakes using well-used data formats and data which is freely 

available on the web. In particular, the following two types of data may be readily 

used. 

 UniSys Hurricanes - Historical and current storm and hurricane tracks from 

around the world from the UniSys web site. 

 NEIC Earthquakes - Historical and recent earthquakes from the NEIC web site. 

 

9.1 Supplied Track/Event Collections 

Solar Maps is supplied with a selection of track/event files. These are: 

 Storm_na.smt – All North Atlantic Storm Tracks from 1851 to 2002 

 Hurr3_na.smt – All North Atlantic Hurricanes Intensity 3 and higher from 1851 

to 2002 

 Hurr4_na.smt -  All North Atlantic Hurricanes Intensity 4 and higher from 1851 

to 2002 

 Quake6.smt – World earthquakes Richter 6+ from 1973 to 2002 

 Quake7.smt -  World earthquakes Richter 7+ from 1973 to 2002 

 Quake8.smt -  World earthquakes Richter 8+ from 1973 to 2002 

 QuakeX.smt – Significant historical earthquakes 2150BCE to 1994 
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These collections were created using the data obtained from the websites listed 

earlier. The user is free to create additional data sets, either by importing further data 

from these sites, or by manually entering or editing data from other sources. 

 

9.2 Downloading Data from the Web 

Solar Maps allows two types of specific data to be imported directly after 

downloading from the web – UniSys Hurricanes and NEIC Earthquakes. 

Note: If these downloadable data formats are changed by the authors in any way in 

the future, it is possible that they will no longer be importable. 

 

9.2.1 UniSys Hurricanes 

The UniSys hurricane web site (http://weather.unisys.com/hurricane/) contains storm 

track data from around the world, classified by region, date etc. 

 

 To obtain UniSys data in the required format 

1. Go to http://weather.unisys.com/hurricane/ 

2. Navigate to find a link to a downloadable storm track file 

3. Click on the link (or use your browser download options) to download the 
file and save it onto your computer with a file extension *.dat. 

The resulting text file can be imported directly into Solar Maps using the Import 

button in the Track or Event Collection dialog. 

 

9.2.2 NEIC Earthquakes 

The National Earthquake Information Centre (NEIC - http://neic.usgs.gov/) contains 

extensive earthquake data and has facilities to allow the user to search for earthquake 

data by region, date, type etc. A search for worldwide data can be found at 

http://neic.usgs.gov/neis/epic/epic_global.html. 

 

 To obtain NEIC data in the required format 

1. Go to http://neic.usgs.gov/neis/epic/epic_global.html 

2. Select Compressed File Format as your output file type 

3. Choose your preferred search parameters 

4. Submit your search - This will result in the display of a web page with the 
required data. 

http://weather.unisys.com/hurricane/
http://weather.unisys.com/hurricane/
http://neic.usgs.gov/
http://neic.usgs.gov/neis/epic/epic_global.html
http://neic.usgs.gov/neis/epic/epic_global.html
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5. In your web browser, choose File / Save As, and set the “Save As Type” to 
“Text File”, and save the results page to a file with a *.txt file extension on 
your computer. 

The resulting text file can be imported directly into Solar Maps using the Import 

button in the Track or Event Collection dialog. 

 

9.3 Opening a Track/Event File 

Track/event collection files have the extension *.smt, and their internal format is 

unique to Solar Maps. They may be opened and edited within Solar Maps, but cannot 

be used with any external programs. 

 

 To open an existing track/event collection file 

Select the “Open Track Collection File…“ item from the “Track“ menu. 

This will display the “Select Tracking File to Open” dialog, displaying a list of files 

from which you can choose. 

 

 

 

Note that when you click on a file name, a description of the file appears in the box 

along the bottom of the window. 

All of the track files are initially stored in Solar Maps USERDATA directory, but if 

necessary, you can choose a different disk drive by selecting an item from the drop-

down list of drive names, and look in a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to open a track file which is stored on a diskette. 

After you open a track file, you will be prompted to select one or more tracks or 

events from within that file to display. 
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 To create a new track/event collection file 

Select the “Open Track Collection File…“ item from the “Track“ menu. 

This will display the “Select Tracking File to Open” dialog, displaying a list of files 

from which you can choose. 

 

9.4 Selecting a Tracking Event to Display 

 To select a track or event from the collection file 

Select the “Select Tracking Event…“ item from the “Track“ menu. 

This will display the “Select Plotting Events” dialog, displaying a list of tracks or 

events from which you can choose. 

 

 

 

When you click on a track in the listbox on the left, the details of that track or event 

will be displayed in the box at the right.  

Additionally, you may select which of the following items to display by clicking on 

their check boxes. 

 Geodetic Chart for Eclipse - If selected, this will calculate the chart for the 

time of the tracking event display it geodetically. For an explanation of geodetic 

charts, see page 52. 

 Current Chart - If selected, the currently displayed chart will be retained and 

plotted at the same time as the track or event markers. 
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 To select one of these tracks or events to display 

Click on the required track and then click on the “OK“ button or Double-click 
on the required track. 

You will then be returned to the main screen of Solar Maps, and the newly selected 

track will be drawn onto the current map. If you have selected a single track or event, 

then that event location (or the first location of the track) will be highlighted with a 

expanding/contracting circle (provided that it is visible on the current map region). 

In some circumstances it may be interesting to plot multiple tracks or events at once 

– i.e. composite tracks. For example you may wish to plot all the hurricane tracks in 

a single year, or all the earthquakes in a collection file. 

 To select multiple tracks or events at one time 

 Hold down the Ctrl key whilst clicking on different list entries, or 

 Hold down the Shift key after clicking on one entry, and then click on 
another elsewhere in the list, or 

 Click and drag the mouse over a range of entries 

You will then be returned to the main screen of Solar Maps, and all of the selected 

tracks or events will be drawn simultaneously onto the current map. 

 

9.5 Track or Event Plotting Styles and Colors 

9.5.1 Track Colors 

Tracks are plotted as a series of events joined by line segments. Each event in the 

track (apart from the first) is marked with a cross, and they are joined by continuous 

straight lines. 

User-defined tracks are drawn using colors which may be selected by the user as part 

of the map color scheme. See page 106 for instructions on settings the track color. 

This selected track color applies to both the crosses and the line segments of the 

track. 

UniSys Hurricane tracks also use the user selected track color for the crosses, but use 

a specific pre-set color scheme for the line segments, which was devised by UniSys 

as follows. 

 

Type/Intensity Color 

Tropical Depression Green 

Tropical Storm Yellow 

Hurricane 1 Red 

Hurricane 2 Light Red 

Hurricane 3 Magenta 
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Hurricane 4 Light Magenta 

Hurricane 5 White 

 

9.5.2 Event Marker Colors 

Events are plotted with individual crosses to mark their location. A single event is 

shown with a single cross, and multiple events with multiple crosses. See page 106 

for instructions on settings the track color. This selected track color applies to both 

the crosses and the line segments of the track. 

 

9.5.3 Track or Event Highlight Circle 

Whenever a single track or a single event is plotted, Solar Maps highlights the start 

location of the track or location of the event by drawing a rapidly expanding and then 

contracting circle. This is intended to help the user quickly spot the location of the 

event on the current map area. 

The color used for the highlight circle is the same color as is used for plotting 

individual events (i.e. event marker). See page 106 for instructions on settings the 

event marker color. 

 

 To replay the highlight circle at any time 

Click on the “Redraw” button 

This will redraw the map and track or event, and show the highlight circle again. 

 

Note: When multiple tracks or events are being plotted simultaneously, no highlight 

circle appears. 

 

9.6 Creating a New Track or Event Collection 

 To create a new track/event collection file 

Select the “Open Track Collection File…“ item from the “Track“ menu. 

This will display the “Select Tracking File to Open” dialog, displaying a list of files 

from which you can choose. 

Click on the “Create…” button and enter a name for the new file. 

Click on the “Open” button. 

This will display the Track  or Event Collection dialog, ready for editing. 
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9.7 Editing a Track or Event Collection 

 To edit an existing track or event collection file 

Select the “Edit Track Collection…“ item from the “Track“ menu. 

This will display the Track or Event Collection dialog, ready for editing. 

 

 

9.7.1 Collection Header Details 

If you are editing a newly created track file, then you can enter the following items. 

 

Title – A brief title which is displayed as part of the caption of a map when a track or 

event from this file is being displayed. (e.g. Hurricane Tracks - North Atlantic) 

Description – A longer description to help identify the data. (e.g. Hurricane tracks 

from 1851 to present, intensity 4 or higher) 

Type – One of four pre-defined track or event types, as follows. 

 

 User Defined Tracks – Any kind of tracks (sequential series of events) other 

than hurricane data from UniSys. 
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 UniSys Hurricanes – Storm data which has pre-defined extra fields, and can be 

imported from *.dat files which are downloadable from the UniSys website. 

 User Defined Events – Any kind of events other than earthquake data from 

NEIC. 

 NEIC Earthquakes – Earthquake data which has pre-defined extra fields, and 

can be imported from *.txt data files which are downloadable from the NEIC 

website. 

 

9.7.2 Extra Data Fields for Track or Event Records 

Note that if you select either the UniSys or the NEIC types, then the extra data fields 

will be automatically filled in with pre-defined values which are required for these 

data sources, and you will not be able to alter them. These extra data fields are as 

follows. 

UniSys Hurricanes – Intensity (Numeric), Wind (Numeric), Pressure (Numeric), 

Description (List of Items)  

NEIC Earthquakes – Richter (Numeric), Depth (Numeric), Data Source (List of 

Items) 

 

If you are selecting a user-defined track or event type, then you will be able to enter 

or edit your own extra data fields if you wish. These extra data fields are useful for 

storing information about events which is not plotted on the maps, but which can be 

previewed when selecting individual tracks or events to display on a map. For 

example, if you wish to create a collection of volcanic eruptions, then you could add 

extra fields to store information such as magnitude and duration of the eruption and 

number of deaths. If you are creating a track collection of sunken ship’s courses, then 

you could add extra fields to store information on size of ship, number of passengers, 

number lost at sea etc.  

Note that it is not obligatory to enter any of this data for every event, so you can 

freely define additional fields which may apply only to some events. 

 

 To add a new extra data field 

Click on the “New Field…” button. 

This will add a new field (labelled “New Field”) to the list of fields on the left. You 

can then alter its name and type in the two boxes to the right. 

The available types are as follows. 

 Free Text – This is an unrestricted type, allowing entry of anything, including 

free text, such as notes or comments. 

 List of Items – This is a textual type. Every new item that you enter is added to a 

list, and when you add new events, you have the option of selecting an item from 
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this list, or creating a new item to add to the list. For example, you might have a 

field which describes the effects of flooding, with a list of items including 

“Light”, “Moderate”, “Heavy”, and “Severe”. 

 Numeric – This allows the entry only of numeric data. 

 To edit an extra data field 

Highlight the extra field name in the list of extra fields. 

Edit the name or type in the boxes to the right. 

 

 To delete an extra data field 

Highlight the extra field name in the list of extra fields. 

Click on the “Delete” button. 

 

9.7.3 Tracks in a Collection 

If this collection consists of tracks (as opposed to events), then this part of the dialog 

will contain a list of any existing tracks, and you can add new tracks, edit tracks, 

import tracks or delete tracks from this list. Note that the import button is only 

enabled if this event collection is of type “UniSys Hurricanes”. 

 

 To Add a New Track 

Click on the “New track…” button 

This will display the “Track or Event List Data” dialog, into which the track data 

may be added to. See 9.7.5 for further details. 

 

 To Edit an Existing Track 

Highlight the required track in the list of existing tracks 

Click on the “Edit” button 

This will display the “Track or Event List Data” dialog, in which the event data may 

be edited or added to. See 9.7.5 for further details. 

 

 To Import A Track 

Click on the “Import” button 

This will display the file open dialog, allowing to you navigate disks, folders and 

files to find a UniSys import file. See 9.2.1 for a full description of the required 

format of the UniSys import file. 

 

 To Delete a Track 

Highlight the required track in the list of existing tracks 
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Click on the “Delete” button 

 

9.7.4 Events in a Collection 

If this collection consists of events (as opposed to tracks), then this part of the dialog 

does not contain a list, as there is only one set of events, and you can only edit or 

import events from that set of events. Note that the import button is only enabled if 

this event collection is of type “NEIC Earthquakes”. 

 

 To Edit the set of Events 

Click on the “Edit” button 

This will display the “Track or Event List Data” dialog, in which the event data may 

be edited or added to. See 9.7.5 for further details. 

 

 To Import a set of Events 

Click on the “Import” button. 

This will display the file open dialog, allowing to you navigate disks, folders and 

files to find an NEIC import file. See 9.2.2 for a full description of the required 

format of the NEIC import file. 

 

9.7.5 Editing Track or Event List Data 

The track or event data editing dialog is displayed after the “Edit” button is clicked 

on the “Track or Event Collection” screen. 
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The Header Details consist of the following items. 

Title - A brief title which is displayed as part of the caption of a map when a track or 

event from this file is being displayed. (e.g. Hurricane FLOYD) 

Description – A further description which can be seen and used to help the user 

select individual tracks to plot 

Abbr – An abbreviated title for display in circumstances where the full title would 

be too long. 

 

Note that the title, description and abbr fields are disabled if you are editing an event 

collection (as opposed to a track), because they are not applicable to an event 

collection. 

 

The Current Record’s Data consists of the following items 

The data displayed in the Current Record’s Data frame relate to whichever event is 

highlighted in the list at the bottom of the dialog. However, it is not editable until the 

“Edit” or “Add Rec” buttons are used. 
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Latitude – The geographical latitude of the event or track point. This may be entered 

as an ordinary latitude, or in decimal degrees (-ve = South). See 130 for details on 

how to enter latitudes. 

Longitude – The geographical latitude of the event or track point.  This may be 

entered as an ordinary longitude, or in decimal degrees (-ve = East). See 130 for 

details on how to enter latitudes. 

Date – The date of the event or track point 

Time – The time of the event or track point 

Zone – The timezone applying to the date and time 

Other Fields –To the right is a list of all the extra data fields which have been 

selected for the track or event list. The  data type which may be entered into each one 

depends on what type has been pre-selected for that type (i.e. Free Text, Numeric or 

List of Items). For those data types which are Lists of Items, the user may activate 

the drop-down box to choose one of the items of the list, or alternatively type in an 

item. If that item is not already on the list, then the user will be asked whether they 

wish to add it to the list. 

 

 To Edit the current highlighted record 

Click on the “Edit” button 

This will enable all the fields in the Current Record’s Data frame, so that the user 

may edit them. 

After editing, the user must click on either “Save Edits” to accept the changes, or 

“Cancel” to revert to the original data. 

 

 To Add a new record 

Click on the “Add Rec” button 

This will enable all the fields in the Current Record’s Data frame, so that the user 

may edit them. 

After editing, the user must click on either “Save Edits” to accept the changes and 

add them as a new record, or “Cancel” to prevent it being added. 

 

 To save all edits and additions 

Click on the “Save” button 

 

9.8 Clearing Tracking Events 

 To clear displayed tracks or events 

Select the “Clear Tracking Event” item from the “Track“ menu. 
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10 Reports 
 

Solar Maps contains a variety of reports and listing that can be generated in relation 

to the currently selected chart. Before selecting a report type to view, you must first 

have selected or created the chart for which you wish to view the report. 

 

10.1 Map Parans 

The Map Parans report is a listing of paran lines intermingled with cities, arranged in 

order of latitude from northernmost to southernmost. (For an explanation of parans, 

see page 39.) 

 To see the Map Parans listing for the current chart and map 

Select the “Map Parans...“ item from the “Reports“ menu. 

This will display the “Map Paran Report” dialog box. 

 

 

 

Each line in the listing starts with a latitude, followed either by the city name or by 

the paran type. For example, in the above listing, the city Paris is shown to be 48 

degrees and 52 minutes north, and the paran line of the Saturn setting and North 

Node at upper culmination is shown to be at 48 degrees and 48 minutes north. This 

indicates that the energy of the Saturn/Node paran line will be strong in Paris (or any 

other city near that latitude). 



Chapter 10: Reports 101 

 

The range of latitude covered in this listing depends on two things. Firstly it depends 

on the current limit of latitude for paran lines, which may be altered on the “Select 

Lines” dialog box (see page 39 for instructions on how to do this.) This is normally a 

range from 60º north to 60º south unless you have chosen to alter it. Secondly it is 

limited by the latitudinal extent of the map which is currently displayed. For 

example, if you are viewing a map of Australia, then the map extends from about 6º 

south to 50º  south. In this case, you would not see any entries at all in the northern 

hemisphere. 

The cities which are included in this listing depend on the city file which is 

associated with the current map. For example, the above listing was produced whilst 

a world map was being viewed, and this map had the world.smc file associated with 

it. If necessary, you can select a different city file. See page 73 for instructions on 

how to do this. 

 To  view an interpretation of any paran line in the report 

Click on the required entry in the listing and click on the “Info“ button, or 
double click on the required entry in the listing. 

In either case, you will then see the interpretations window with text relating to the 

selected entry in the listing. If you do this for a city entry, then you will see the city’s 

latitude and longitude displayed instead of an interpretation. 

 To copy the report text to the clipboard 

Click on the “Copy” button 

 To return to the map 

Click on the “Quit“ button. 

 

10.2 Local Parans 

The local parans report is a listing which is very similar to the Map Parans listing 

(see page 100.). The only difference is that the listing contains entries only within a 

range of latitude no more than 2º from the current chart’s latitude. 

 To display the local parans report 

Select the “Local Parans...“ item from the “Reports“ menu. 

This listing shows which parans are strongest around the chart location, and may be 

used either with an ordinary natal chart to look at the strongest paran influences 

around the birth latitude, or with a relocated chart to see the strongest paran 

influences around the latitude of relocation. 

 To copy the report text to the clipboard 

Click on the “Copy” button 

 To return to the map 

Click on the “Quit“ button. 
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10.3 City Directions 

The city directions report is a listing of cities which fall on or near local space lines 

for the current chart. It is sorted into planetary order, and then by alphabetical order 

of city name under each planet. Both conjunctions and oppositions to local space 

lines are included. 

 To display the city directions report 

Select the “City Directions...“ item from the “Reports“ menu. 

This will display the “City Directions” dialog box. 

 

 

 

The planets are listed with their symbol, name and azimuthal direction from the 

current chart’s location. Under each planet are listed city lines, consisting of either a 

conjunction or opposition symbol, the city name, and the orb from exactness. For 

example, in the above listing, the city Atlanta falls opposite the Mars local space line 

within an orb of 2 degrees and 28 minutes of arc, and the city San Francisco falls 

conjunct the Mars local space line within an orb of 2 degrees and 47 minutes of arc. 

This would be apparent if one viewed local space lines on a world map - in this case 

you would see that the Mars line passed near to both Atlanta and San Francisco. 

The cities which are included in this listing depend on the city file which is 

associated with the current map. For example, the above listing was produced whilst 

a world map was being viewed, and this map had the world.smc file associated with 
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it. If necessary, you can select a different city file. See page 73 for instructions on 

how to do this. 

 To  view an interpretation of any planet line in the report 

Click on the required entry in the listing and click on the “Info“ button, or 
double click on the required entry in the listing. 

In either case, you will then see the interpretations window with text relating to the 

local space line for the planet under which the selected entry falls in the listing.  

 To copy the report text to the clipboard 

Click on the “Copy” button 

 To return to the map 

Click on the “Quit“ button. 

 

10.4 Relocation Interpretations 

The relocation interpretations report is a descriptive report, typically of one to two 

pages in length, and must be viewed with a word-processor. It can be printed or 

reformatted using your word-processor if you wish to. 

The report provides an analysis of the astrological factors influencing a chart when it 

is relocated to any selected place on Earth. It contains sections relating to planets on 

the angles, local space lines and paran lines. 

Before you first generate a report of this type, you may wish to select the Word-

Processor that you wish to use, and whether or not you want to use the Rich Text 

Formatting option. See the following sections for a full description of these options. 

 To generate a relocation report for the currently selected chart 

Select the “Relocation Interpretations...“ item from the “Reports“ menu. 

You will then be presented with either the “Select City” dialog box, or the “ACS PC 

Atlas” dialog box from which you may select any city (or add a city if you wish to 

select one that is not already there). See page 116 for instructions on how to use the 

city selection screens. 

Once you have selected a city, the report file (called “relocrep1.txt” or relocrep1.rtf”) 

will be generated, and your word processor will be opened up displaying this report 

file. You are then free to browse the report, to print it, or to save it under another 

name if you wish.  

Note that Solar Maps created the report name with a number which is incremented 

for each subsequent report generated in the current session. Consequently, you may 

generate and view any number of reports without having to delete or close any of the 

earlier reports. However, when you start a new session with Solar Maps, the 

numbering sequence reverts to 1 again, so any existing report files from the previous 

sessions will be overwritten. Therefore, if you wish to save any relocation report 
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permanently, you must use your word-processor to save it under a different file name 

or to a different location. 

 

10.4.1 Word Processor 

You can select which word processor you wish to use when viewing and printing 

relocation interpretation reports. If you do not select one yourself, then Solar Maps 

will automatically use the default application on your computer for files with a *.rtf 

extension. This will normally be your usual word-processing program, so it is 

unlikely that you will need to select an alternative. 

 

 To select an alternative word processor 

Select the “Word Processor...“ item from the “Reports“ menu. 

This will display a dialog box showing which word-processor is currently selected. 

Normally, this will be “> Default word-processor for *.rtf file extension <”. 

In order to choose a specific word-processor other than the default, click on the NO 

button, and then browse to find the required word-processor main application file. 

For example, to select MS Word, its path and name might be 

 “C:\MSOFFICE\WINWORD\WINWORD.EXE” , or 

 “C:\WINWORD\WINWORD.EXE” . 

If you have WordPerfect, then its path and name might be  

 “C:\WPWIN\WPWIN.EXE” . 

(If you have problems finding the correct path and name of other word processors, 

then you should re-enter “WRITE.EXE”.)  

 

10.4.2 Rich Text Format 

Rich Text Format (RTF) is a method of producing a formatted report (i.e. with 

centred text, bold and italics, for example).  Without RTF, a text file will contain 

only plain text in a single font, without any special formatting, and this is much less 

attractive and harder to read. 

Solar Maps can produce its relocation interpretations report either with or without 

RTF. However, if you use the RTF option, then you must be using a word processor 

which is capable of understanding the RTF format. MS Word for Windows, 

WordPerfect and the Windows WordPad can all understand the RTF format. 

However, if you have the RTF option switched on, but are using a word processor 

which does not understand RTF, then you will see a lot of spurious items in the 

report file which interfere with its normal layout. Unless you have this problem, it is 

recommended that you leave this option switched on. 
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 To switch on or off the RTF option 

Select the “Rich Text Format“ item from the “Reports“ menu. 

This will switch the option on if it is off, or switch it off if it is on. A tick mark 

appears to the left of this menu item when it is switched on. 

 

10.5 Azimuths and Aspects 

The Azimuths and Aspects report is a list of azimuths and altitudes for each point 

which is displayed in the current chart, plus a list of aspects of azimuth sorted into 

order of orb. The aspects and orbs used in this report may be altered by the user – see 

page 1 for further details. 

 To display the Azimuths and Aspects report 

Select the “Azimuths and Aspects...“ item from the “Reports“ menu. 

 To copy the report text to the clipboard 

Click on the “Copy” button 

 To return to the map 

Click on the “Quit“ button. 
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11 Options 
 

11.1 Extra Line Annotation 

The number of symbols which are displayed around the outside of the map may be 

altered. Typically, each astrological line is identified with two symbols - one 

showing which planet or star it belongs to, and the other showing which line type it 

is e.g. a Venus on the Midheaven line will have a symbol for Venus and a symbol for 

the MC. It is possible to limit this to displaying a single symbol for the planet, and 

omitting the line type symbol. This allows the margin around the edge of the map to 

be reduced, and therefore creates a bigger plotting area for the map. If you have 

selected settings which give different line types different colors (or line styles or 

thicknesses), then you may not need the extra symbol to be displayed. 

 To switch the extra line symbols on or off 

Select the “Extra Line Annotation“ item from the “Options“ menu. 

This switches the extra line type symbols off if they are on, or switches them on if 

they are off. A tick appears to the left of this item when it is switched on. The map is 

automatically redrawn whenever this option is changed. 

 

Note: This option does not affect printed maps. Printed maps always contain the 

extra line annotation, regardless of how this option is set. 

 

11.2 Color and Font Settings 

The map and line settings in Solar Maps may be customised and saved in settings 

files. As personal color and font preferences vary widely from individual to 

individual, the user is permitted to edit or select alternative settings to maximise the 

clarity, aesthetic and personal appeal of the map and line appearance.  

A range of pre-defined settings files are supplied in order to demonstrate a range of 

possible color schemes, and the user is free to experiment to find particular color 

schemes to suit their needs. 

As printers usually have rather different display characteristics from the computer 

screen, it is necessary to choose different color and font settings for each device. For 

example, most printers are unable to print flood fill colors for land and sea areas, and 

the chosen coastline, border and font colors need to be chosen to be clearly visible on  

the usual white paper background color. 

Items which are saved in a settings file are as follows: 

 Description of Settings 
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 The Land Color 

 The Sea Color 

 The Coastlines Color 

 The State and Country Borders Color 

 The Symbol Font Size 

 The Cityname and Country Font Name, Size, Style and Color 

 The Cityname Marker Color 

 Event Marker and Tracking Line Colors 

 For each line type (MC/IC/Rise/Set etc...) 

 Use Planet Colors/ Use Line Color 

 Line Color 

 Line Style 

 Line Thickness 

 Symbol Type 

 

You can edit any of these settings either to apply during the rest of the current 

session with Solar Maps, or you can save these changes so that they can be reused in 

future sessions of Solar Maps. You can also create several different settings files so 

that you can switch between them at any time, without having to reselect all the 

individual settings each time. 

 

11.2.1 Editing Screen Settings 

 To edit the screen settings which are currently in use 

Select the “Screen Color Scheme and Font…“ item from the “Options“ menu. 

This will display the “Colors, Lines & Symbols” dialog box from which any of the 

settings may be edited. 
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You may edit any of the following items. 

 Land Color – This color is used to fill in all areas of land. Click on the Land 

Color... button and choose one of the available colors from the “Color 

Selection” dialog. See page 132. 

 Sea Color - This color is used to fill in all areas of sea and lakes. Click on the 

Sea Color... button and choose one of the available colors from the “Color 

Selection” dialog. See page 132. 

 Coastline Color – This color is used to draw the outline of the landmasses and 

lakes. Click on the Coastline Color... button and choose one of the available 

colors from the “Color Selection” dialog. See page 132. Note that the coastline 

color cannot be the same as the land color, although it can be the same as the 

sea color. 

 Symbol Size – This affects the size of the planet glyphs around the edge of the 

map area. Select an entry from the drop-down list box of available symbol sizes. 

 Cityname Font – This affects the font used to write any city and country names 

onto the map. Click on the Cityname Font… button and choose a font name, 

style and size. 
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 Cityname Color – This color is used for city and country names drawn onto the 

map. Click on the Cityname Color... button and choose one of the available 

colors from the “Color Selection” dialog. See page 132. 

 City Marker Color – This color is used for the crosshairs marking the location 

of any cities drawn onto the map. Click on the Marker Color... button and 

choose one of the available colors from the “Color Selection” dialog. See page 

132. 

 Borders Color – This color is used for any internal state or country borders on 

the map. Click on the Borders Color... button and choose one of the available 

colors from the “Color Selection” dialog. See page 132. 

 Track Color – This color is used for any user-defined tracks drawn onto the 

map. Click on the Track Color... button and choose one of the available colors 

from the “Color Selection” dialog. See page 132. Note that this color applies 

only to user-defined tracks, as UniSys Hurricane tracks are always drawn using 

a pre-set color scheme devised by UniSys. See page 89. 

 Event Marker Color -  This color is used for any events drawn onto the map, 

and for the expanding/contracting highlight circle which is used to show a 

single event location or track start location. Click on the Event Color... button 

and choose one of the available colors from the “Color Selection” dialog. See 

page 132. 

 Line Attributes - First click on the line type in the display area. This will 

highlight that line type by surrounding it with a black and white focus rectangle, 

and enter the line type name into the caption box on the top right of the screen.. 

Then select the required line attributes from the following. 

 Use Planet Colors/Use Line Color - This enables you to choose whether to 

display this line type using the color of whichever planet which is associated 

with the line (i.e. different for every line), or whether to always use the same 

line color, regardless of which planet is associated with it. 

 Line Color - Clicking on this button enables you to  choose one of the available 

colors from the “Color Selection” dialog. See page 132. This color is only used 

if the Use Line Color option has been selected. 

 Line Style - You can select one of the available styles from the drop-down list 

box. However, note that if you choose a line thickness greater than 1, then the 

line style will be drawn as SOLID, regardless of which line style setting you 

choose. 

 Line Thickness - You can select one of the available line thicknesses from the 

drop-down list box.  However, note that if you choose a line thickness greater 

than 1, then the line style will be drawn as SOLID, regardless of which line 

style setting you choose. 
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 Symbol Type - You can select one of the available symbol shapes from the 

drop-down list box. 

 

Note that each time you alter any setting, the display area is immediately updated to 

reflect the changes that you have made, showing you what the new settings will look 

like on the maps. 

The purpose of all these settings is to help you to see which astrological lines are 

which when they are displayed on the map. For example, you might choose to have 

the MC lines use the planet colors, because the MC lines are always vertical lines of 

longitude on a rectangular map, so you can easily identify them. However, rising and 

setting lines for a planet run together cannot be easily differentiated, so you might 

choose to switch to the line color option for both of these line types and have all the 

rising lines one color, and all the setting lines another color. 

When you first use Solar Maps, you will find that various settings have been chosen 

to help the typical user recognise the different line types quickly and easily. 

However, it is up to you to decide whether you would prefer to personalise these 

settings for your own taste and requirements. 

After you have edited the settings and clicked on the OK button, any changes that 

you have made will take effect immediately on the currently displayed map. These 

changes will be used either until you edit the settings again, or until you exit from 

Solar Maps. 

 

Important Note: Any changes that you make to the settings will not be retained for 

future sessions with Solar Maps unless you use the “Save Settings“ option to 

permanently save them to a file. 

 

11.2.2 Editing Printer Settings 

 To edit the screen settings which are currently in use 

Select the “Screen Printer Scheme and Font…“ item from the “Options“ 
menu. 

This will display the “Colors, Lines & Symbols” dialog box from which any of the 

settings may be edited. For a full description of these options, which are the same as 

those for screen settings, see the related section on screen settings on page 107. 

However, note that most modern printers are unable to print flood fill colors that 

would be required in order to see colored sea and land masses on the maps. 

Therefore, unless you own such a printer, the printer settings would normally contain 

white for both land and sea color, and contain colors only for the various lines (such 

as coastlines, borders, planetary lines, fonts etc.). 
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When you click on the Sea Color or Land Color buttons, Solar Maps will check your 

current printer to determine whether it is capable of flood fill, and if not, you will see 

a warning message to tell you so. In this case, you can still select non-white fill 

colors, but these colors will simply not appear when printed. 

Also note that, in the eventuality that your printer is capable of flood fill, it is 

recommended that you choose only light colors anyway, in order to avoid using up 

large quantities of printer ink or toner. 

 

11.2.3 Saving Settings 

You can save the settings that you have edited with the “Edit Settings“ option to be 

reused in future sessions with Solar Maps. 

 To save the current settings 

Select the “Save Settings..“ button. 

This will display the “Save File As” dialog box. 

 

 

 

At the top of the dialog box, you can type in a description to be saved with the 

current settings. This description can be viewed before re-opening a settings file, so 

it may be used to help you remember what type of settings you are saving in this file. 

All of the settings files are initially stored in Solar Maps USERDATA directory, but 

if necessary, you can choose a different disk drive by selecting an item from the 

drop-down list of drive names, and select a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to save a settings file onto a diskette. 

Finally you can enter a file name under which to save the settings. 
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 To write the settings to the specified file 

Click on the “Save“ button. 

If the file that you have chosen already exists, then you will see a message asking 

you to confirm whether you want to overwrite the existing file. Otherwise the file 

will be saved immediately. 

Solar Maps remembers the last file that you either saved or opened, and when you 

start the next session of Solar Maps, it will start up using that settings file. 

 

11.2.4 Re-opening Settings 

You can restore any settings which are supplied with Solar Maps, or that you have 

previously saved using the “Save Settings“ option. 

 To restore previously saved settings 

Select the “Open…“ button. 

This will display the “Select Settings File to Restore” dialog box. 

 

 

 

All of the settings files are initially stored in Solar Maps USERDATA directory, but 

if necessary, you can choose a different disk drive by selecting an item from the 

drop-down list of drive names, and select a different directory by double-clicking on 

directory names in the directory list box on the left. For example, you may wish to 

select the A: drive if you want to restore a settings file from a diskette. 

The list of available settings files appears in the list box on the right, and by clicking 

on any entry in this list, you can see the description that was saved with the settings 

in that file. 

 To restore the settings in the highlighted file 

Click on the “Open“ button. 
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You will then be returned to the map screen, and the map will be redrawn using the 

newly restored settings. Solar Maps remembers the last file that you either saved or 

restored, and when you start the next session of Solar Maps, it will start up using that 

settings file. 

 

11.2.5 Applying Settings 

If you have edited any settings, or opened a settings file, then you can apply these 

settings to the current map and chart and all subsequently displayed maps and charts. 

 To apply the selected settings 

Click on the “Apply“ button. 

If the settings which you are selecting are new ones, or have been edited by you 

since they were last opened, then you will prompted whether or not you wish to save 

the changes. If you choose to save them, then you be shown the “Save As” dialog, 

but if not, then the settings will be applied to the current map but not saved for future 

re-use. 

 

You will then be returned to the map screen, and the map will be redrawn using the 

current settings. 

 

11.3 Azimuth Aspects and Orbs 

In astro-locality mapping aspects of azimuth on a local space chart are used instead 

of aspects of longitude on an ordinary ecliptical chart. The Azimuths and Aspects 

report (see page 105) provides a list of such aspects. 
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 To select and edit the aspect orbs 

Select the “Azimuth Aspects and Orbs“ option from the “Options“ menu. 

This will display the “Select Chart Aspects” dialog box, allowing you to switch 

aspects on and off, and alter their orbs. 

 

 To switch an aspect off  

Highlight the required aspect in the list of aspect names 

Click on the Switch Off button, or enter zero into the orb edit box 

 

 To switch an aspect on 

Enter a non-zero orb value into the orb edit box 

You can enter angles in decimal degrees or degrees and minutes. See page 131 for a 

more detailed explanation of how angles may be entered. 

 

When you have finished adjusting your selection of aspects and orbs, click on the 

“Save” button to save your changes and exit. 

 

11.4 House System 

Most astro-locality mapping techniques are independent of the astrological house 

system. The only item in Solar Maps which requires a House System to be used is 

viewing a chart wheel. In this case the calculation of house cusps will depend on 

which house system is selected with this option. 

 To select a default house system 

Select one of the “House Systems“ options from the “Options“ menu. 

A tick appears to the left of whichever option is currently selected. Any charts 

subsequently opened or calculated will use the newly selected house system. 

 

11.5 Lunar Node Type 

The lunar node is one of the chart points which may be displayed in any chart. It is 

possible to select the lunar node as either the true node or the mean node. 

 True node - the real position of the Moon's node at any time. 

 Mean node  - the position of the Moon's node according to a mathematical 

formula which ignores many of the minor perturbations in its orbit. 

 To select the lunar node type 

Select one of the “Lunar Node Type“ options from the “Options“ menu. 
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A tick appears to the left of whichever option is currently selected. Any charts 

subsequently opened or calculated will have the newly selected lunar node type. 

 

11.6 Vulcan Calculation 

As Vulcan is a hypothetical planet, there is no officially accepted ephemeris for the 

calculation of its position. However, two of the more widely used methods of 

calculating its position have been included in Solar Fire, and it is possible to choose 

which of these methods you would like to be used whenever Vulcan’s position is 

calculated. The possible methods are: 

 L.H.Weston - Professor Weston produced a set of orbital parameters for 

Vulcan based on a number of supposed sightings during last century and early 

this century. This proposed orbit has Vulcan orbiting the Sun once every 19.5 

days, and having a maximum orb of about 8° from the Sun, as observed from 

the Earth. The complete theory is published in the booklet “The Planet Vulcan”, 

published by the American Federation of Astrologers, Inc. 

 D.Baker - Dr Baker has documented a theory for Vulcan based on a quantum 

mechanical type of behaviour. When Mercury is more than 3° from the Sun, 

then Vulcan is on the same side of the Sun as Mercury, and 3° from the Sun. 

When Mercury is within 3° of the Sun, then Vulcan is conjunct the Sun. The 

full rationale behind this concept is explained in his Dictionary of Astrology. 

 

 To select the Vulcan calculation type 

Select one of the “Vulcan Calculation“ options from the “Options“ menu. 

A tick appears to the left of whichever option is currently selected. Any charts which 

are subsequently calculated will use the newly selected calculation method. 

 

11.7 Atlas 

Solar Maps contains a full embedded version of the ACS Atlas. 

If you have a separate stand-alone ACS PC Atlas installed on your computer, then it 

is possible to choose to use this Atlas instead of Solar Maps' own copy. Note that 

you can switch between these two options at any time. However, this menu option 

will only be visible if you do have a stand-alone ACS PC Atlas on your computer. 

 To select the Atlas type 

Select either the “ACS Atlas (Stand Alone)“ or “Solar Maps (Embedded ACS 
Atlas)“ option from the “Atlas“ item of the “Options“ menu. 

A tick appears to the left of whichever option is currently selected. 

If you select to use the Solar Maps embedded ACS, then you will still be able to look 

up any personal ACS atlas entries you have created with your stand-alone version.
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12 Email and Web Support  
In order to use any of the automated email options in Solar Maps, you must have a 

MAPI compliant email program. All Microsoft email programs (e.g. Outlook and 

Outlook Express) and Eudora are MAPI compliant, for example. 

You may also need to ensure that the MAPI options are activated in some email 

programs, for example in Eudora Pro v3, you may need to go into the Tools / Options 

menu item, find the MAPI category, and ensure that “Use Eudora MAPI server” is 

switched to either “When Eudora is Running” or “Always”. If you are unsure about 

any of these options, you should consult the documentation of your email program 

(e.g. search for “MAPI”), or contact the manufacturer of your email program. 

However, note that if your email program cannot be configured for MAPI, you can 

still create your own email and paste the email data created by Solar Maps into the 

body of the email. 

 

12.1 Register by Email 

Registration is not obligatory, but it is desirable if you wish to keep us informed of 

your current contact details, or to be kept informed of program updates and new 

products by email.  

It is helpful to re-register whenever you change your street or email address. 

Note: The details you supply here will be kept confidential to us and our agents, and 

will not be supplied to any third party for any purpose, unless it is required by law. 

 

 To register by email 

Select the “Register by Email” menu item from the Help menu 

This will display the “Confirm Current Details” dialog box. 

 



Chapter 12: Email and Web Support 117 

 

 

 

Once you have entered or updated your details, click on the “Proceed” button to open 

your default email program with a new email containing your registration details, and 

addressed to us. You can then preview the email and send it at your leisure. 

 

12.2 Find Program Updates on Web 

 To find program updates on the web 

Select the “Find Program Updates on Web” menu item from the Help menu 

If your computer is not already connected to the internet, then you will be prompted 

to connect, or connection will start automatically, depending on the internet 

connection options in your operating system. 

When a connection is established, your default web browser will open and display a 

web page containing links to the latest software updates. 

On this web page, look for information and links relating to Solar Maps updates, and 

follow any instructions on how to download and run the updates. 

 

12.3 Get Technical Support by Email 

It is possible to get technical support by letter, phone, fax or email. However, the 

most efficient means of contact for us is by email, and if you use this built-in option, 

it increases the likelihood of a rapid resolution because of the detailed information 

that it automatically provides us about your program setup. 
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 To get technical support by email 

Select the “Get Technical Support by Email” menu item from the Help menu 

Firstly, you will be prompted to enter your contact registration details (see 12.1). 

Once you have entered or updated your details, click on the “Proceed” button to open 

your default email program with a new email containing your registration details, 

program setup information, some computer configuration information, and addressed 

to us. 

You can then preview the email, insert a description of your problem or query, and 

send it at your leisure. 

  

12.4 Submit Suggestions by Email 

Our philosophy of software design is to create software that addresses the needs and 

desires of the users. Consequently we welcome any feedback and suggestions that 

you might feel inspired to send us. 

 

 To submit suggestions by email 

Select the “Submit Suggestions by Email” menu item from the Help menu 

Firstly, you will be prompted to enter your contact registration details (see 12.1). 

Once you have entered or updated your details, click on the “Proceed” button to open 

your default email program with a new email containing your registration details. 

You can then preview the email, insert your feedback or suggestion, and send it at 

your leisure. 

 

12.5 Visit Website 

You can navigate our website to find out about our latest news, products, patch 

updates and other items of interest. 

 

 To visit our website 

Select the “Visit Website” menu item from the Help menu 

If your computer is not already connected to the internet, then you will be prompted 

to connect, or connection will start automatically, depending on the internet 

connection options in your operating system. 

When a connection is established, your default web browser will open and display 

the home page of our website. 
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13 Selecting Places From the Atlas 
At various places in the program, you are required to enter place details. This is 

necessary, for example, when you are 

 Casting a new chart 

 Creating a relocation interpretations report 

 Relocating a chart. 

 Adding a city to the current city file 

It is possible to retrieve city details from the ACS Atlas instead of having to enter all 

the details (name, latitude, longitude and timezone) each time that you want to use 

that city location. 

 

 To select stored city details 

Click on the “Place...” button. 

This will display the “ACS PC Atlas” dialog box. 

  

 

 

When this screen appears, the place, country, date and time boxes will contain the 

information that was held on the previous screen. You have the option of changing 

any of these if you wish to, and then clicking on any of the four main command 

buttons, which are described below. When you have found the place that you require, 

then clicking on the “OK” button will return you to the previous screen, and the 

displayed place details will be copied automatically onto that screen. 
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13.1 Atlas Lookup 

The order in which the lookup proceeds depends upon whether the “Hospital List” 

check box is selected or not. If it is selected (checked), then the Atlas will look 

through its list of hospitals for the city you are searching for. If no hospital list exists 

for that city, then it looks through the main list of locations. Note that, if you do not 

have the hospital list database installed then this option will be disabled (greyed) on 

your screen and you will not be able to select it. The hospital list only exists on 

recent versions of the ACS PC Atlas. 

If the ACS Atlas does not recognise the name of the country or state to which the 

given place name belongs, then you will be presented with a list of names and 

abbreviations of countries and states from which to choose:- 

 

 

 

 To select the required country or state 

Click on the required entry and select the “OK” button, or double-click on the 
required entry. 

If the place name that you entered is found, then the city, country or province, state 

or country, latitude, longitude and time zone will all be filled on the ACS Atlas 

dialog box. 

If the place name that you entered is not found, then you will be presented with a list 

of similar names from which to choose. See the next section for instructions on how 

to proceed. 
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13.2 Similar Names 

If you click on the “Similar Names” button, or if the place you are looking for was 

not found, then you will be presented with the City dialog box. 

 

 

 

 To select the required city 

Click on the required entry and select the “OK” button, or double-click on the 
required entry. 

If you select the “Cancel” button, then you will return to the ACS Atlas screen after 

seeing a message indicating that the lookup was not successful. 

 

13.3 Radius Search 

If you click on the “Radius Search” Button, then the following box appears. 
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The initial settings of the longitude and latitude will be the same as the most recent 

entry that was found in the atlas. You have the option of altering these if you wish, 

and of specifying the radius of the search in minutes of arc by editing the Distance 

box. By default it is set to 5 minutes of arc. 

 To start the search 

Select the “Start Search” button. 

You will be prompted for the country or state in which you wish to search, and the 

results will be presented in the City dialog box, from which you may select any 

entry. If no entries are found within the given radius, then you will be returned to the 

ACS Atlas screen without any result. 

 

13.4 Zone Changes 

 In order to see a list of dates and times at which the time zone 

changes occur 

Select the “Zone Changes” button. 

You may be prompted for the country or state, and for the city for which you wish to 

see the zone changes and the results will be presented in the “Time Changes History” 

dialog box. 

 

 

 

You can browse through the time zone information. Selecting the “OK” button will 

simply return you to the ACS Atlas screen. 
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Note: It is not possible to edit or add information to the embedded ACS PC Atlas in 

Solar Maps. However, if you have a stand-alone copy of the ACS Atlas, then you can 

do so by using the independent supplied atlas program. For further information 

refer to the documentation supplied with the ACS PC Atlas 
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14 Entering Dates, Times and Other Data 
 

14.1  Entering Dates 

Dates may be entered in any of the most commonly used formats. Any characters 

within the date may be in upper, lower or mixed case. Entered dates are always 

immediately transformed into a standard display format if they are recognised. If they 

are not recognised as valid dates then an error dialog box appears, after which the 

user may make a further attempt. 

 

14.1.1  Examples 

Following are some examples of valid dates, and the manner in which they are 

displayed by the program. 

 

User Entered Date International Display Format US Display Format 

1 Dec 1992 1 Dec 1992 Dec 1 1992 

1 Dec 92 1 Dec 1992 Dec 1 1992 

Dec 1 1992 1 Dec 1992 Dec 1 1992 

1 December 1992 1 Dec 1992 Dec 1 1992 

1st December 1992 1 Dec 1992 Dec 1 1992 

1 Dec 1992 AD 1 Dec 1992 Dec 1 1992 

1 Dec 1992 BC 1 Dec 1992 BC Dec 1 1992 BC 

1 Dec 0092 1 Dec 0092 Dec 1 0092 

1/12/92 1 Dec 1992 Jan 12 1992 

12.1.92 12 Jan 1992 Dec 1 1992 

 

The display format that Solar Maps uses is based on the date order settings within 

Windows, which may be set by using the International icon on the Windows 

Control Panel. 

 

14.1.2  Description of Format 

Dates must have at least three elements: 
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 A day number (e.g. 1, 2, 3, ..., 31) 

 A month name, abbreviation or number (e.g. Jan, Feb, Mar, ..., Dec, or 1, 2, 3, 

..., 12) 

 A year number (e.g. 57, 1957, 2005, -6) 

 

The year must always be placed last, but the day and month parts may be entered in 

either order provided that the month is entered as a name or abbreviation e.g. 

entering 7 Feb 95 or Feb 7 95 are both acceptable. 

However, if the month is entered as a number, then the day and month must be 

entered in the same order as the display order i.e. if the display style is 

"DD/MM/YY" then day must be entered before month, or if the style is 

"MM/DD/YY" then month must be entered before day). 

Day number must be a valid day of the month for the entered month and year. 

Month number must be 1 to 12, or month abbreviation must be at least the first 3 

characters of the month's full name e.g. Jan or Januar may be entered for January, 

and Jul or July may be entered for July. 

If the year number has 2 or less digits, then it is assumed to be in the range of the 

current year – 92 to current year + 2 (e.g. in 2002, the range is 1910 to 2009). To 

enter dates in the 1st century, use 00 as a prefix (e.g. 0059 for year 59). 

Separators between the elements within the date may be any of the following: 

 

 blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,) 

 

Optionally there may also be any of the following items: 

 A day number suffix (i.e. "st", "nd", "rd" or "th") 

 An epoch indicator (i.e. AD, A.D., BC, B.C., CE, C.E., BCE, B.C.E.) 

 A calendar style indicator (i.e. OS, O.S., NS, N.S.) 

 

The epoch is assumed to be AD unless BC or BCE has been entered, or if the year is 

negative. If the year is negative, then Solar Maps will automatically convert the year 

into a BC year, and remove the minus sign. (Note that there is a difference of 1 year 

between BC years and negative (astronomical) years e.g. the year -6 is converted into 

7 BC. This is due to the absence of a year 0 in the BC format.) 

 

14.1.3  Modern and Old Calendars 

If a calendar style indicator (new style NS, or old style OS) is not entered, then Solar 

Maps makes the following assumptions:- 
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 If the entered date is on or after 15th October 1582, then it is assumed to be in the 

new style (Gregorian) calendar. 

 If the entered date is before 15th October 1582, then it is assumed to be in the old 

style (Julian) calendar. 

 

To enter a date on or after the 15th October 1582 which is expressed as an old style 

date, add the suffix OS to the entered date. Solar Maps will immediately convert the 

date into the new style calendar. 

To enter a date before the 15th October 1582 which is expressed as a new style date, 

add the suffix NS to the entered date. Solar Maps will immediately convert the date 

into the old style calendar. 

The following table shows the adjustment that Solar Maps makes in order to convert 

from old style to new style dates:- 

 

15 Oct 1582 to 28 Feb 1700 Add 10 days 

29 Feb 1700 to 28 Feb 1800 Add 11 days 

29 Feb 1800 to 28 Feb 1900 Add 12 days 

29 Feb 1900 to 28 Feb 2100 Add 13 days 

 

14.2  Entering Times 

Times may be entered in any of the most commonly used formats. Any characters 

within the time may be in upper, lower or mixed case. Entered times are always 

immediately transformed into a standard display format if they are recognised. If they 

are not recognised as valid times then an error dialog box appears, after which a 

further attempt may be made. 

 

14.2.1  Examples 

Following are some examples of valid times, and the manner in which they are 

displayed by the program: 

 



Chapter 14: Entering Dates, Times and Other Data 127 

 

User 

Entered 

Time 

AM/PM 

Format 

24Hr 

Format 

Noon 12:00 PM 12:00 

12 12:00 PM 12:00 

12 PM 12:00 PM 12:00 

12 AM 0:00 AM 0:00 

12:00 12:00 PM 12:00 

12:00:00 12:00 PM 12:00 

6 6:00 AM 6:00 

13:00 1:00 PM 13:00 

13:25 1:25 PM 13:25 

13:25:49 1:25:49 PM 13:25:49 

1:25:49 AM 1:25:49 AM 1:25:49 

1:25:49 PM 1:25:49 PM 13:25:49 

 

The display format that Solar Maps uses is based on the time format settings within 

Windows, which may be set by using the International icon on the Windows 

Control Panel. 

 

14.2.2  Description of Format 

Times must be entered in Universal Time (UT) (i.e. standard clock time). 

Conversions to Ephemeris Time (ET) are performed internally by the program where 

necessary. 

 

Times must have at least one element: 

 An hour number (e.g. 1, 2, 3, ..., 23) 

 

Optionally there may also be  

 A minutes number (e.g. 1, 2, 3, ..., 59) 

 A seconds number (e.g. 1, 2, 3, ..., 59) 

 A morning/afternoon indicator (i.e. "AM" or "PM") 
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Separators between the elements within the time may be any of the following: 

 

 blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,) 

 

Alternatively the following single strings may be entered: 

 "Noon" 

 "Midday" 

 “Midnight" 

 

14.3  Entering Time Zones 

Time zones may be entered either by using the Zone... button to invoke the "Time 

Zone Selection" screen, or by entering a time zone mnemonic and (optionally) a time 

directly into the appropriate boxes. 

 To choose a time zone from the database of time zones 

Select the Zone... button. 

This will display the "Time Zone Selection" dialog box from which a time zone may 

be selected. 

 

 

 To find the desired time zone from the list of time zone records 

Optionally click on any entry on the list and type any alphabetic key on the 
keyboard. 

This will move the list pointer to the first name starting with that alphabetic 

character. Repeated use of the same key will cause the pointer to jump to subsequent 

entries starting with the same character. 
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It is possible to sort the time zone data into three different orders. 

 To change the order of the entries in the list 

Select the “Sort Order” option. 

If the “Full Name” option is selected then the records will be sorted into ascending 

alphabetical order of their full descriptive name. 

If the “Zone Time” option is selected then the records will be sorted into numerical 

order by their hours from GMT. (Note that the ordering is from 0 to 12 positive 

numbers followed by 0 to 12 negative numbers). 

If the ”Mnemonic” option is selected then the records will be sorted into ascending 

alphabetical order of their mnemonic. 

 To retrieve time zone details to the screen from which the Zone... 

button was selected 

1. Select the desired time zone record from the list box. 

2. Click on the “Select” button. 

Instead of using the time zone database, it is possible to enter time zone information 

directly into a time zone data box. 

 To enter time zone data 

 Enter a valid time zone mnemonic. 

Examples of valid mnemonics are "GMT", "ACST", "EST" etc. If only a 

mnemonic is entered, then it must be one which is on the internal time zone 

database. If the mnemonic is not recognised then an error dialog box will be 

displayed. 

 Enter the LMT (Local Mean Time) mnemonic. 

The time zone difference from GMT will be added automatically to the LMT 

mnemonic in the box, as calculated from the longitude. If you subsequently 

change the longitude, then the time difference will be automatically updated. 

 Enter a valid zone time. 

Examples of valid times are shown below. If the entered zone time is not valid, 

then an error dialog box is displayed. 

 

14.3.1  Description of Zone Time Format 

Zone times must be entered in hours, minutes and seconds, as the difference between 

the local zone time and Greenwich Mean Time (GMT). Zone times west of 

Greenwich (London, UK) are normally positive, and zone times east of Greenwich 

are normally negative. 

Times must have at least one element: 

 An hour number (e.g. 1, 2, 3, ..., 23) 
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Optionally there may also be  

 A sign (+ve western longitudes, -ve eastern longitudes) 

 A minutes number (e.g. 1, 2, 3, ..., 59) 

 A seconds number (e.g. 1, 2, 3, ..., 59) 

 

Separators between the elements within the time may be any of the following: 

 blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,) 

 

Some examples of valid zone times are as follows. 

 

 5  +5  +5:00   +5.00   +5 00 00 

 -9:30  -9 30  -9 30 00 

 +6:23:59 

 -12:30 

 

14.4  Entering Latitudes and Longitudes 

Longitudes and latitudes must be entered in degrees and minutes with an indicator of 

which hemisphere they are in. Entered latitudes must be geographic (i.e. geodetic), 

rather than geocentric. (Atlases always give geographic latitudes). 

Longitudes and latitude must have at least two elements: 

 A degree number (i.e. 0 to 180 for longitude, 0 to 90 for latitude) 

 A hemisphere code (i.e. E or W for longitude, N or S for latitude) 

 

Optionally there may also be  

 A minutes of arc number (i.e. 0, 1, 2, 3, ..., 59) 

 A seconds of arc number (i.e. 0, 1, 2, 3, ..., 59) 

 

Separators between the elements within the time may be any of the following: 

 blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,) 

 

Some examples of valid longitudes are as follows. 

 

 0W  0W0  149E38  78W23 45  E 167 52 

 

Some examples of valid latitudes are as follows. 
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 0S  0N0  17S58  62N17 59  S 45 23 

 

14.5  Entering Angles 

Angles are required to be entered in several different places in the program, e.g. 

when editing aspect orbs, editing report modulus and orb, specifying a chart angle 

when rectifying a chart, entering a user-specified ayanamsa and when specifying a 

return angle in the Advanced Return Options screen. 

Angles may be entered in degrees, minutes and seconds or as decimal degrees or in 

degrees, zodiac sign, minutes and seconds. Whenever an angle is entered, Solar 

Maps will convert it into a standard format, unless it cannot understand the entry, in 

which case an error message will be displayed, and you can try entering an angle 

again. 

If the angle you are entering is not a zodiacal angle then 

The angle must have at least a degree number. It may also have a minutes 

number and a seconds number. The minutes and seconds number must be 

between 0 and 59 only. Some examples of valid angle entries are as follows. 

 

 23  23 59  23 59 59  

 

If the angle you are entering is a zodiacal angle then 

The angle must have at least a zodiacal abbreviation or a degree number. It may 

also have a minutes number and a seconds number. The minutes and seconds 

number must be between 0 and 59 only. If you enter a zodiacal abbreviation of 

2 letters, then it must be one of the following - Ar, Ta, Ge, Cn, Le, Vi, Li, Sc, 

Sg, Cp, Aq, Pi. If you enter more than 2 characters of a sign name, then it must 

be an exact part of the full name of the zodiac sign e.g. "Sag" for Sagittarius. 

 

Some examples of valid zodiacal angle entries are as follows. 

 

 23Aries  23Ar  23Ar59 59  23 Aries 59 59 

  133 23  12 Cn 23 
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15 Making Color Selections 
Color selections can be made for a variety of items in Solar Maps. These include 

land color, sea fill color, special fill color, planet color, line color, etc. 

Your current display driver may allow 16 colors, 256 colors, Hi-Color (16-bit),True-

Color (24-bit) or True-Color (32-bit). It is recommended that you choose Hi-Color or 

better in order to take full advantage of Solar Maps color options. 

 To check what your current display driver allows 

On your computer desktop, right-hand click the mouse and select Properties, 
then select the Settings tab. 

This will display a box with information about your computer display settings. One 

of the items displayed is the Colors selection. Note that you may be able to select a 

better range of colors from this dialog if your system has such a driver available. 

The “Color Selection” dialog within Solar Maps varies according to the number of 

colors which your display currently supports. 

 

15.1 16 Color or 256 Color Displays 

If you have a 16 or 256 color display, then the “Color Selection” dialog contains a 

sample of each possible color. 

 

 

 

You can highlight any individual color either by clicking on it, or by using the cursor 

keys to move up and down or across the selection of colors. 
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 To select one of the available colors 

Highlight the color and click on the “Select“ button, or double-click on the 
required color. 

 

15.2 HiColor or TrueColor Displays 

If you have a display which supports more than 256 colors, then the standard 

windows “Color Selection” dialog appears instead. 

 

 

 

On the left of this dialog box there is a selection of a variety of standard basic colors,  

and on the right you can create a customised color. 

 To select one of the basic colors 

1. Click on the required “Basic colors”. 

2. Click on the “OK“ button. 

 To create and select a custom color 

Click on one of the “Custom colors” boxes on the left of the dialog box. 

Then either, 

Use the mouse to place the cursor over the desired color on the color map on 
the right of the dialog box, and 

Adjust the intensity of the color by dragging the pointer up or down on the far 
right of the dialog box, 

or 

Type in the required “Hue”, “Sat”, “Lum” or “Red”, “Green”, “Blue” 
amounts. 
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Finally, 

Click on the “Add to Custom Colors“ button, and 

Click on the “OK“ button. 

Note that Solar Maps will adopt the nearest solid color to the actual color you have 

chosen, if it is not a solid color. As there are at least 32,000 solid colors available if 

you are using this dialog box, the nearest solid color will always be very close in 

shade to the precise color you have chosen, and you can see whether there is any 

difference by looking at the “Color/Solid” box. Solar Maps will use the color in the 

left half of that box, if there is any difference between the two halves. 
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16 Editing Fixed Star Files 
This section describes how to edit files which contain listings of fixed stars (or other 

astronomical points such as black holes or galaxies) to be used when displaying 

fixed stars in Solar Fire or Solar Maps. Solar Maps uses the same fixed star files as 

Solar Fire, so any fixed star files that you already have in Solar Fire can be used in 

Solar Maps. 

 To start the fixed stars editor from the Windows group containing 

Solar Fire or Solar Maps program icons 

 Double-click on the Fixed Stars Editor icon. 

This will display the “Fixed Stars Editor” window. 

 

 

 

When the screen first appears, it will start with a new, empty star file. You may wish 

to open and edit other fixed star files, instead. 

 



136  Chapter 16: Editing Fixed Star Files 

 

16.1  Creating a New File 

 To create a new file of fixed stars 

Select the “New” option from the “File” menu. 

If you have made any changes to the current file, then you will be prompted to save 

them before a new file is opened. When a new file is opened, it contains no star 

information. You must enter this information yourself, or you can merge information 

from another star file, or import information from a Nova star file. 

 

16.2  Opening an Existing File 

 To open an existing file of fixed stars 

 Select the “Open” option from the “File” menu. 

If you have made any changes to the current file, then you will be prompted to save 

them before a new file is opened. When you select this option, you will be presented 

with a “File Open” dialog box from which you must select the required file. 

Solar Maps and Solar Fire star files have the file extension “.fst”. It is only possible 

to open files of this type. If you attempt to open a file of a different type, then a 

message will be shown indicating that the file cannot be read. 

 

16.3  Saving a File 

 To save the information that you have entered or edited 

Select the “Save” or “Save As...” option from the “File” menu. 

The “Save” option will save any changes that you have made using the existing file 

name. If there is no file name (i.e. if it is a new file), then this option will prompt you 

to enter a name before it is saved. 

The “Save As...” option prompts you for a name to save the file as. 

 

16.4  Merging a File 

This option allows you to merge the information from another star file into the 

current star file. 

 To add all the entries from another star file 

Select the “Merge...” option from the “File” menu. 

When you select this option, you will be presented with a “File Open” dialog box 

from which you must select the required file. You can only select Solar Fire star files 

with this option. The new entries will be appended to the end of the current file.  
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16.5  Importing a File from Nova 

This option can only be used if you have Astrolabe’s Nova program installed on your 

computer. It allows you to import the information from a Nova type star file into a 

new Solar Fire star file.  

 To create a new star file using data from an existing Nova type star 

file 

Select the “Import...” option from the “File” menu. 

If you have made any changes to the current file, then you will be prompted to save 

them before a new file is created. When you select this option, you will be presented 

with a “File Open” dialog box from which you must select the required Nova star 

file. 

Nova star files have the extension “.txt”, and normally reside in the Nova directory. 

 

16.6  Printing 

 To print a listing of the information in the current star file 

Select the “Print” option from the “File” menu. 

This will list all the information in the file apart from the keywords and free text 

using the current printer. You can change your printer settings, such as page size and 

orientation with the standard “Printer Setup” dialog. 

 To alter printer settings 

Select the “Printer Setup...” option from the “File” menu. 

 

16.7  Editing Star Information 

Data for a star may be changed simply by typing the required information into the 

display boxes on the main screen. Existing information may be changed by 

overtyping it. 

 To add a new entry, use the “Add” button or menu item. 

 To delete an entry, use the “Delete” button or menu. 

 To alter the ordering of entries, click on the up or down arrow of the spin 

button. 

 

It is also possible to use the “Cut”, “Copy”, “Paste” menu items to manipulate all the 

information relating to a single star entry via the Windows Clipboard. This is 

especially useful if you have two copies of the Star Editor running, in which case you 

can cut or copy entries in one file and paste them into another. (In order to run two 
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copies of the Star Editor, you must start it independently from Solar Fire, using its 

own icon in the Solar Fire Group window) 

 

Editable Items:- 

 

Traditional Name - The traditional name is the name by which the star (or 

astronomical point) is shown in the list of stars. For example, the brightest star in the 

constellation Eridanus is commonly known as Achenar. 

Nomenclature - This is a standard technical name by which the star is known. There 

are several different systems of nomenclature in use, as listed below. This 

information is optional, and may be left blank. 

 Bayer nomenclature - uses a Greek letter name which is unique in a particular 

constellation, denoting the relative brightness of the star. For example, Achenar 

is known as Alpha Eridanus. This indicates that it is the brightest star in the 

constellation Eridanus. 

 Flamsteed nomenclature - uses a number indicating the position in order of 

right ascension within a constellation. For example, Alcor is known as 80 Ursa 

Major. 

 Messier nomenclature - uses letter M plus a number for nebulous objects in a 

constellation. For example, Acumen is known as M7 Scorpius. 

 

Greek Alphabet 

1. Alpha 7. Eta 13. Nu 19. Tau 

2. Beta 8. Theta 14. Xi 20. Upsilon 

3. Gamma 9. Iota 15. Omicron 21. Phi 

4. Delta 10. Kappa 16. Pi 22. Chi 

5. Epsilon 11. Lambda 17. Rho 23. Psi 

6. Zeta 12. Mu 18. Sigma 24. Omega 

 

Constellation - The constellation in which the star (or astronomical point) resides 

can be selected from the list of available constellation names in the drop-down list 

box. This information is optional, and may be left blank. 

NGC Number - NGC stands for New General Catalogue. It is a listing of observed 

celestial objects, and assigns a number to each one. For example, Achenar has NGC 

number 1979. This information is optional, and may be left blank. 

Spectral Class - This indicates the quality of light emitted by the star. Typically it 

consists of a letter and a number. The letter indicates the general class, and the 



Chapter 16: Editing Fixed Star Files 139 

 

number (0-9) indicates where in that class it resides e.g. A7 indicates white star with 

a yellowish tinge. The possible letters, in order of hottest stars to coolest stars are:- 

 

 

 

Class Color Temperature 

W Greenish-White 80,000K 

O Greenish-White 36,000K+ 

B Bluish-White 12-25,000K 

A White 8-10,000K 

F Yellowish-White 6-7,500K 

G Yellow 5-6,000K 

K Orange 3-5,000K 

M Orange-Red 3,100K 

R Orange-Red 2,500K 

N Red 2,500K 

S Red 2,600K 

 

Sometimes there are also one or more small letters preceding or following the 

letter/number combination, as listed below. For example, gK7 indicates a giant 

orange star. This information is optional and may be left blank. 

 

Letter Meaning 

n Diffuse absorption lines 

s Sharp absorption lines 

c Exceptionally sharp lines 

g A giant star 

d A dwarf star 

e Has emission lines 

p Peculiarities 

 

Magnitude - This is a decimal number indicating the visual magnitude of the star. 

The lower the number, the brighter the star. Eg. the brightest star is Sirius, which has 

a magnitude of -1.4. The lowest visible magnitude is about 6. This information is 

optional and may be left blank. 
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Right Ascension and Declination - This is the position of the star in equatorial 

coordinates on the date specified in the Equator of Yr field. Right ascension may be 

entered either in Degrees, Minutes and Seconds, or in Hours, Minutes and Seconds 

of arc. However, it is always displayed in Hours, Minutes and Seconds. Declination 

is always entered and displayed in Degrees, Minutes and Seconds. For example, in 

1950 Sirius was at a right ascension of 6h42m56.7s and at a declination of -

16°38'46". These may be entered in any of the following ways. 

 

6h42m56.7s    -16°38'46" or 

6h42 56.7    -16d38 46 or 

6 42 56.7    -16 38 46 or 

100d44m10.5s   -16d38m46s 

 

Note that the first number entered in the Right Ascension field is assumed to be an 

hour number, unless the letter “d” appears somewhere in the entry, in which case the 

entry is assumed to be in degrees, minutes and seconds, and is automatically 

converted and displayed in the equivalent hours, minutes and seconds. 

Proper Motion - This is the annual motion of the star in right ascension and 

declination. The motion in right ascension must be entered in decimal seconds of 

Right Ascension (time). The motion in declination must be entered in decimal 

seconds of Declination (arc). For example, the proper motion of Sirius is -0.037 

seconds of right ascension per year and -1.21 seconds of declination arc per year. 

Equator of Yr - This is the “epoch” or year for which the entered right ascension 

and declination are applicable. Astronomical references usually contain star 

information for year 1950, or in more modern references, year 2000. 

Keywords and Free Text - For each star, up to 30 characters of keywords or 

definition text may be entered, plus unlimited free text. The keyword text is used in 

Solar Fire’s star reports. The free text is also used in the Planetarium whenever star 

information is shown about any star. This information is optional and may be left 

blank. 

 

16.8  Changing the Date 

The zodiacal positions displayed are calculated for the current date unless you alter 

the date setting. 

 To alter the date for the displayed star information 

Select the “Change Date...” option from the “Edit” menu. 

You may, for example, wish to enter your date of birth in order to see the star’s 

positions precessed to your birth. The format of the displayed date is typically dd 

mmm yyyy or mmm dd yyyy e.g. 31 Dec 1994 or Dec 31 1994. As in the main Solar 
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Fire program, many other formats may also be entered, but if in doubt, then use one 

of the above formats. 

 

16.9  Sorting the File 

It is possible to sort the entries in the current file into a variety of different orders 

 To sort the file 

Select the “Sort...” option from the “Edit” menu. 

You will be presented with a list of possible sort options from which you can choose. 

You may re-sort the file as many times as you wish. 

 

16.10  Viewing Stars in the Planetarium 

It is possible to view the current star file in Solar Fire’s planetarium, provided that 

you have Solar Fire v3,v4 or v5 installed. 

 To start up the Planetarium and view the current file’s information 

Select the “All Stars” option from the “View” menu. 

Alternatively, the planetarium may be started from Solar Fire’s “View” menu. In this 

case, you must select the required fixed star file from Solar Fire’s menu before 

choosing the “Planetarium” option. 
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17 Editing Interpretations 
You can create your own set of interpretations to be used in Solar Maps, or you can 

edit the existing set of interpretations supplied with Solar Maps, by creating or 

editing text files and then running the Interpretations Editor, which is a separate 

utility program. 

The Interpretations Editor is also supplied with Solar Fire, and can be used to edit 

interpretations files for use with Solar Fire as well. 

 

 To start the Interpretations Editor 

From the Solar Maps Group Folder - Double-click on the Interpretations 

Editor icon. 

This will start the editor without opening an interpretations file, and you will need to 

select the file “maps.int” from the file open dialog that appears upon startup. This file 

resides in Solar Maps INTERPS folder. 

 

When you enter the interpretations compiler, you will see text from whatever 

interpretations file has been opened. If you wish to edit text within this file, you may 

start to do so immediately. However, it would be advisable to save a copy of the file 

before making changes. In this case you must save a copy of the current file under a 

new name before proceeding (e.g. “mapsback.int”). 

 

 To save a copy of the current interpretations file under a new name 

1. Select the Save As... option from the File menu. 

2. This will display a standard “File Save” dialog, in which you can select a new 

name for the current interpretations file, and optionally a different directory or 

folder. However, Solar Maps will only work with interpretations stored in 

“maps.int” in the Solar Maps INTERPS folder. 

3. Click on the OK button. You will then be returned to the interpretations editor and 

the newly saved copy will be open instead of the original file. 

 

 To switch to another interpretations file 

1. Select the Open... option from the File menu 

2. This will display a standard “File Open” dialog in which can select a new file to 

open. 

3. Click on the OK button. You will then be returned to the interpretations editor and 

the newly selected file will be open for editing. 
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 To close the current interpretations file 

1. Select the Close option from the File menu. 

2. This will close the current file, and you will not be able to carry out any editing 

functions until you open another file. 

 

17.1 Editing Text 

Following is a list of the interpretation text types which can be used in Solar Maps, 

showing what combinations are available for each, and how they may be used. 

 

 Title – A descriptive title for this set of interpretations. This title appears in the 

File Manager to assist in selecting the required set of interpretations, and as a title 

to interpretations reports. 

 Copyright – A copyright notice. This appears in reports, but can be left blank if 

you do not wish copyright to apply to your text. 

 Introduction – General introductory text. This appears as an introductory section 

to interpretation reports. It can contain any preliminary comments that you wish, 

for example explaining how the following interpretations should be applied in 

practice, and providing disclaimers. 

 Aspect – General definition of each aspect. 

 Point – Definition of each chart point. 

 Point in Aspect to Point – Interpretation of each point in each aspect to each 

other point. The aspects that may be used here must be selected before you begin 

editing. See page 1. 

 

The text following in items TITLE, COPYRIGHT and INTRODUCTION are used at 

the beginning and end of the Relocation Interpretations report in Solar Maps. 

The ASPECT text is used simply to define conjunctions and oppositions. 

The POINT entries are used to define the local space influence of each point. 

The POINT IN ASPECT TO POINT items are used firstly to define the planet MC, 

IC, Asc, and Dsc lines (under *planet Conjunction Midheaven, *planet Opposition 

Midheaven, *planet Conjunction Ascendant, and *planet Opposition Ascendant 

entries respectively). Secondly they are used to define parans between each pair of 

points (under *point1 Conjunction point2 entries.) 

 

If you are creating a new set of interpretations, you will probably want to edit the 

title and introduction text first. Otherwise you may wish to jump into any category of 

text that you wish to work on currently. 
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 To find the text category that you wish to edit 

1. Select the required type from the Interpretation Type drop-down list box. 

2. Select the required combinations from the adjacent drop-down list boxes. 

Any existing text for that category will be displayed immediately in the main editing 

window, and you may type over it, add to it, or otherwise edit it as you wish. Any 

changes that you make are automatically saved as soon as the focus leaves the 

editing window, or when you click on any other control on the screen or access the 

menu. You do not need to take any special action to save changes that you make. 

 

On some occasions you may find that you have made an error, and wish to undo any 

changes that you have made to the text. You are able to undo any changes made 

since you edited the last category of text, but not any changes made prior to that. 

 

 To undo text changes made since the current topic was displayed 

Select the Undo Text Editing option from the Edit menu. If you change your mind 

again, selecting the same option again will restore your edited changes. 

 

17.2 Aspects Used 

Note that although the interpretations editor is capable of using other aspects in 

addition to the conjunction and opposition, only these two aspects are used in the 

pre-supplied Solar Maps interpretations. If you wish to add further aspect 

interpretations for other aspects, then you must first ensure that the extra aspects are 

included as explained further below. For example, to add interpretations for Trines 

and Squares, you must first mark these aspects as included. You will subsequently be 

able to enter interpretations text for various planet and MC or Asc aspect 

combinations. For example to add interpretation text for the Moon Trine MC line, 

just add text to the Point Aspect Point category for  The Moon Trine Midheaven text 

category.  

 

Mapped Aspect Names 

Solar Maps’ interpretations files use a concept of mapped aspect names. You can 

define a list of mapped aspect names for which you will write interpretations, and 

specify which of Solar Maps’ standard aspects map onto each of those mapped 

names. In most cases you will simply want to map each standard aspect to the same 

mapped name, so that the each interpretation that you are writing applies only to that 

one aspect.  However, if you map each of the conjunction, trine and sextile aspects 

onto the same mapped name “soft”, then you will only need to write one 

interpretation to appear whenever any of those three aspects occur. Similarly you 
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could map the opposition, square, semisquare and sesquisquare onto the mapped 

name “hard”. 

 

 To display the “Aspects to Include” dialog box 

Select Aspects to Include... from the Edit menu 

On the left of the screen you will see a list of Solar Fire’s 26 standard aspects, called 

“Available Aspects”, some of which will be marked as “Used”. On the right of the 

screen you will see a list of “Mapped Aspect Names”. 

 

 To determine which aspect is mapped to which name 

Click on each entry in the “Available Aspects” list - when you do so, the mapped 

entry in the “Mapped Aspect Name” will be highlighted automatically. 

 

 To add a new mapped aspect name 

1. Optionally select the required aspect name from the list of “Available Aspects”. 

2. Click on the Add button - This will add the name of the currently highlighted 

“Available Aspect” to the list of “Mapped Aspect Names”. 

3. Optionally edit the new mapped name by typing into the edit box above the Add 

button. 

 

 To delete an existing mapped aspect name 

1. Select the required mapped aspect name in the list of “Mapped Aspect names” 

2. Click on the Delete button - This will remove the entry from the list, and will alter 

the current entry in the “Available Aspects” list to show it as unmapped. 

Note: After deleting mapped aspect names, you will need to check and reselect all the 

other mapping relationships to ensure that they are still correct. 

 

 To set or alter the mapped name of available aspect 

1. Select the required aspect from the list of “Available Aspects”. 

2. Select the required mapped name from the list of “Mapped Aspect Names”. 

Note: Selecting the “Not Used” item from the top of the list will unmap that aspect, 

so that it can no longer be used. 

 

 To save all your changes 

1. Firstly, re-check that each aspect is correctly mapped. 
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2. Select the OK button. If you have made any major changes which are likely to 

result in interpretations text being lost, then you will be prompted to confirm your 

changes before you are returned to the main editing screen. 

 

17.3 Viewing a Summary of Contents 

During the process of editing text, you may from time to time want to see a summary 

of which categories in the file have already had text inserted, and those categories 

that still have no text yet. 

 

 To see a summary of which items contain text 

Select Contents Summary from the View menu - You may have to wait for a 

moment or two whilst the entire interpretations file is searched to determine which 

items contain interpretations text, and then a summary will be displayed in the 

editing window. 

 

 To revert to editing text 

Select Interpretations Text from the View menu. 

 

17.4 Decompiling and Compiling 

Normally, compiling and decompiling interpretation files is unnecessary. However, 

there are two main reasons why you may wish to use the compilation options: 

 If you have created text files for earlier versions of Solar Maps, you may still want 

to compile them. 

 If you wish to do any work on the entire set of text in bulk, for example, to make 

global editing changes, or to spell check the entire text, then you will need to 

decompile them first, work on the decompiled file in your word processor, and 

then recompile them. 

 

Decompiling 

The process of decompiling extracts all the interpretations text from the 

interpretations file and inserts it into a single ANSI text file. The ANSI file is written 

to conform exactly to Solar Maps’ requirements for a text interpretations file, so that 

it may subsequently be recompiled without any changes being required. The text file 

may be edited with any text editor or word processor. 
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 To decompile the current interpretations file 

1. Select the Decompile... option from the File menu - This will display a standard 

“Save File As” dialog 

2. Enter a file name - The file name must be a valid file name, and should have a 

“.def” extension. Normally it is best to choose the same name as the current file 

i.e. maps.def if you are decompiling Solar Maps’ supplied file. 

3. Optionally Select a new directory or folder. If you choose a different directory, 

then you will need to remember where you have placed the file when you wish to 

recompile it. 

4. Select the OK button. You will see a confirmation message showing you the full 

path and name of the decompiled file when it has finished. 

 

Note: Remember that after you have decompiled an interpretations file, you have two 

versions of the interpretations - the original interpretations file, and the decompiled 

text file. If you make changes to the original file instead of the decompiled file, then 

when you recompile the decompiled file, those changes will be overwritten. 

 

Compiling 

Compiling an interpretations file is the process of reading in a text file that contains 

interpretations text formatted according to Solar Maps’ specifications, and writing 

out an interpretations file which may be used directly in Solar Maps, and edited with 

the interpretations editor. The format of a decompiled text file is somewhat complex, 

and it is not recommended that you attempt to make significant alterations to a 

decompiled file unless you are technically proficient. For the full specification of the 

required format for a decompiled file, see page 149. 

 

 To compile a text interpretations file 

1. Select the Compile... option from the File menu. 

2. This will start up the interpretations compiler. See chapter 18 for further details. 

 

17.5 Compacting the File 

When you edit existing interpretations text, if you make the new text longer than the 

original text, then the new text will be added to the end of the file, thus making it 

larger. The space occupied by the original text is no longer needed, but still occupies 

some space in the file. The space that is wasted due to this process is negligibly small 

if you only edit a small number of interpretations, but if you make a large number of 

alterations, then you may wish to recover the wasted space. This is possible by 

compacting the file. 
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 To compact the current interpretations file 

Select Compact... from the File menu - You will be asked to confirm whether you 

wish to proceed, and if you click OK then the entire interpretations file will be 

rewritten to the disk using the minimum space possible. When the process is 

finished, you will see a message indicating how much space was saved. 
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18 Compiling Interpretations 

18.1  File Locations 

The interpretations text files which are supplied with Solar Maps are all installed into 

a single directory, which is the INTERPS subdirectory of the main Solar Maps 

directory. If you chose to install Solar Maps to the default directory, then the 

interpretations file will be in directory 

 

 C:\SOLARMAP\INTERPS 

 

18.2  Input File Layout 

An easy way to learn how to lay out an input text file is to browse through the text 

files supplied with Solar Maps. These are in the INTERPS subdirectory of Solar 

Maps. The main input file is named "MAPS.DEF". This file contains a number of 

#include directives which point to a number of other *.txt files in the same directory. 

Input files must be sequential ASCII text files. If you are editing your file from 

WordPerfect, for example, then you must choose to save your files as "ASCII Text 

(DOS)". 

In any input file there are four types of lines which may legally appear. These are 

comment lines, directive lines, keyword lines and text lines. 

 

18.2.1  Comment lines 

These are blank lines on which the first character is a semicolon (;) or a form feed. 

These are ignored during compilation. You can use them to annotate your file with 

comments which you do not want to be included as interpretations text. For example 

 

 ; The following section was written by John Smith on 17th Sept 1995 

 

18.2.2  Directive lines 

These are lines on which the first character is "#".  These allow you to tell the 

compiler to include a separate text file at this point in the current file. You can "nest" 

these directives in up to five levels of files. The syntax is 

 

 #include <filename> 
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where <filename> is either a full path plus a filename, or just a filename without a 

path. If no path is given, then the compiler assumes that the file is in the same 

directory as the top level input file. Examples: 

 

 #include c:\solarmap\interps\aspects.txt 

 #include decans.txt 

 

18.2.3  Keyword lines 

These are lines on which the first character is an asterisk (*). These allow definition 

types to be specified. Any text lines following a keyword line will be used as text 

relating to whatever item was defined on the keyword line. The keyword line must be 

one of the following types: 

 

 * TITLE 

  e.g. *Title 

 * COPYRIGHT 

  e.g. * Copyright 

 * INTRODUCTION 

  e.g. *Introduction 

 * ASPECT aspectname [mappedname] 

  e.g. *Aspect Square Hard  

 * pointname 

  e.g. *Moon 

 * pointname mappedaspectname pointname 

(mappedaspectname must have previously appeared as a non-mapped aspect 

name or as a mapped aspect name in a "*Aspect" keyword line. See below for 

more details.) 

  e.g. *Jupiter Hard Moon 

 

Items in square brackets are optional, and uppercase keywords which are not in 

square brackets are obligatory. Blanks between "*" and the next non-blank character 

are ignored. Text is case insensitive (i.e. text can be entered in lower, upper or mixed 

case). Names of chart points must not include blanks i.e. North Node becomes 

NorthNode, South Node becomes SouthNode. See the name lists below. 

 

Aspect Definitions 

Aspect definitions relate aspects to their mapped aspect names. (Any aspects which 

do not have a mapped aspect name in a "*Aspect" definition cannot be used in this 
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set of interpretations. If no *Aspect definitions appear then no "*Point aspect Point" 

definitions can be entered later.) Note that *Aspect definitions must appear before 

any "*Point aspect Point" definitions appear in the input file/s. For example: 

 

*Aspect Conjunction Conjunction 

Angle 0 Degrees 

|Any Harmonic. 

|This aspect emphasises and fuses the energies of the planets involved. Each planet 

modifies or strengthens the other. 

In astro mapping this aspect is used to indicate parans between planets as well as the 

planet on the MC or rising (conjunct MC or Ascendant). 

 

*Aspect Opposition Opposition 

Angle 180 Degrees 

|2nd, 4th, 6th, 8th, 10th, 12th Harmonic. 

|This aspect depicts conflict which, when resolved, results in growth. 

In astro mapping this aspect is used to indicate planets on the IC or setting (opposite 

MC or Ascendant). 

 

Note that although the interpretations compiler is capable of using other aspects in 

addition to the conjunction and opposition, only these two aspects are of use in Solar 

Maps. 

 

Spelling of Keywords 

The following lists indicate the exact spelling that must be used in the * header lines 

for each interpretation. Abbreviations may be used only as truncations of these 

words, and must be unambiguous e.g. "Ca" will cause an error if used as a sign 

abbreviation, but "Can" or "Cap" will be accepted correctly as Cancer and Capricorn 

respectively. 

 

POINTS: Sun, Vulcan, Mercury, Venus, Moon, Mars, Jupiter, Saturn, Uranus, 

Neptune, Pluto, Chiron, Vesta, Pallas, Juno, Ceres, Hygeia, Astraea, NorthNode, 

SouthNode, Ascendant, Midheaven, Cupido, Hades, Zeus, Kronos, Apollon, 

Admetos, Vulcanus, Poseidon, TransPluto, BlackMoon 

 

ASPECTS: Conjunction, Opposition 
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18.2.4  Text lines 

Any other line than those shown above is considered to be a text line. Text lines are 

always assumed by the compiler to relate to the last keyword line that was read in by 

the compiler. 

Note that any carriage returns or line feeds within the body of the text are ignored by 

the compiler. To force text onto a new line, a "|" (vertical bar) character must be 

used. E.g. 

 

 The quick brown fox jumped over these items:|A box|A tree|A hen 

 

This will ensure that, when displayed in Solar Fire's interpretations window, the last 

three items each appear on a new line, as follows 

 

 The quick brown fox jumped over these items: 

 A box 

 A tree 

 A hen 

 

Because the compiler ignores carriage returns, it does not matter how many words 

are contained in each text line. You can put as many or as few words on a line as you 

wish. When you run Solar Maps, the interpretation text lines are automatically 

formatted to fit within the interpretations window, whatever its size. 

The limit to the amount of text that can be entered in relation to any one keyword is 

that it cannot exceed about 30,000 characters (i.e. roughly 500 lines of 60 characters 

width). There is no specific limit on how much text may be entered into any one 

interpretations file. In practice you will be limited by the amount of available disk 

space on your computer. 

 

18.2.5  Examples 

The following examples are listings of a couple of the input text files supplied with 

Solar Maps. 

The first file contains text for the title, copyright and introduction of the 

interpretations. The rest of the entries are include directives which tell the compiler 

to read additional files containing the remainder of the interpretations text. 
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File: MAPS.DEF 
; 

; Solar Maps Interpretations 

; ========================== 

; 

 

*Title 

AstroMapping Interpretations for Solar Maps 

*Copyright 

1995, Esoteric Technologies Pty Ltd 

||The text in Solar Maps has been written by Australian astrologer Stephanie Johnson. 

Stephanie holds a Bachelor of Arts (Journalism) and was a journalist in Australia, England 

and the USA for 15 years before becoming a professional astrologer. She is currently a 

consulting astrologer and Company Director of Esoteric Technologies Pty Ltd in Adelaide, 

Australia. She holds the FAA Practitioners qualification and was a former editor of the 

Journal of the Federation of Australian Astrologers. 

*Introduction 

This report explores the potential energies available for you in a particular location in the 

world. The report has evolved from a technique called astromapping, which overlays your 

chart on a map of the world using various methods. This overlay means that certain planets 

will be stronger in particular geographical areas. Through interpreting these planetary 

energies we can have an astrological map which tells us the best place to apply for 

promotions, to go on holidays, to meet lovers, and to live more fulfilled lives in the areas that 

are important to us. Let the explorations begin. 

 

#include mapasps.txt 

#include maps.txt 

#include paran.txt 

 

The following file contains interpretations relating to the parans between points. It is 

one of the files referred to in an include directive in the previous file. 

 

File: PARAN.TXT 
; 

; Paran Lines 

; NB - These are listed as conjunctions in the following interpretations text 

;      e.g. a line of latitude where the Sun and the Moon are in paran is 

;      labelled Sun Conjunct Moon 

; 

 

*Sun conjunct Moon 

The energy of this combination lends itself to new beginnings. Under this influence 

you will focus on your image and your feelings, possibly changing the way you see 

yourself and adopting a new image. It is an opportunity to gain self-confidence and 

increased self-esteem, conquering new frontiers that you never before thought you 

could. Self-expression and self-reliance are more likely to dominate your life than 

reliance on others. For this reason you may need to also make sure that you do not 

become too egocentric. 

 

*Sun conjunct Mercury 

This will encourage effective communications. Therefore it is beneficial for 

projects such as writing, media work, sales, and study. You will enjoy intellectual 

stimulation, and look for avenues through which to communicate your ideas. The 

old saying that people have "the gift of the gab" will apply to you under this 

influence, and you will probably receive recognition for your communication skills. 

You may tend to talk about yourself and your own interests rather than listen to 
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others. 

 

*Sun conjunct Venus 

The energy here is such that you are gentle, loving and charming. You will express 

yourself in an affectionate manner and enjoy the company of other people. You 

may also develop or increase a love of art and beauty.  Personal relationships may 

come into focus, particularly the person closest to your heart. It is more likely that 

you will be the centre of attention in your relationships, rather than the emphasis 

being on the other person. Idealism will be emphasised, particularly in the area of 

personal relationships.  
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19 Symbols Used 
 

19.1 Zodiac Signs 

 

Symbol Sign Abbr Symbol Sign Abbr 

A Aries Ar G Libra Li 

B Taurus Ta H Scorpio Sc 

C Gemini Ge I Sagittarius Sg 

D Cancer Cn J Capricorn Cp 

E Leo Le K Aquarius Aq 

F Virgo Vi L Pisces Pi 
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19.2 Chart Points 

 

Symbol Name Abbr 

¶ Moon Mon 

¸ Sun Sun 

¹ Vulcan Vul 

º 
Mercury Mer 

» Venus Ven 

¼ Mars Mar 

½ Jupiter Jup 

¾ Saturn Sat 

¿ Uranus Ura 

À Neptune Nep 

Á Pluto Plu 

É North Node Nod 

Ê South Node Sno 

Â Chiron Chi 

Ã Vesta Ves 

Ä Pallas Pal 

Å Juno Jun 

Symbol Name Abbr 

Æ Ceres Cer 

Ç Hygeia Hyg 

È Astraea Ast 

Ë 
Ascendant Asc 

Ì Midheaven MC 

ü Descendant Ds 

ý Imum Coeli IC 

Ð Cupido Cup 

Ñ Hades Had 

Ò Zeus Zeu 

Ó Kronos Kro 

Ô Apollon Apo 

Õ Admetos Adm 

Ö Vulcanus Vus 

× Poseidon Pos 

Ø TransPluto TPl 

Ù Black Moon BMo 
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20 Technical Details 
 

20.1 INI File Settings and Options 

Certain user selectable options are stored in the Solar Maps INI file. These options 

are saved to the INI file when you close down Solar Maps, and are read in again 

when you next start it up. In most circumstances the user does not need to be 

concerned with the INI file at all. However, there are two circumstances under which 

you may wish to edit it. These are 

 If you have moved Solar Maps to another directory without re-installing it 

 To alter certain unusual settings which cannot be altered from within Solar 

Maps itself 

 

If you are not a highly experienced Windows user, and you wish to move Solar Maps 

to another directory, then it is strongly recommended that you re-install Solar Maps 

to a new directory instead of attempting to move its files to another directory 

manually. This will avoid any need to edit the INI file. 

The Solar Maps v3 INI file is called SOLMAP3.INI, and always resides in the 

WINDOWS directory on your computer. You can browse or edit the INI file using 

the Windows NotePad, WordPad or any similar simple ASCII text editor. 

A sample of some entries in a typical Solar Maps INI file is as follows. 
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Most of the entries in the file can be controlled within Solar Maps, so these will not 

be discussed here. However the following items are of note. 

 SystemDataPath, UserDataPath, InterpPath, PrefFile, LastFile1-8 - These 

items all contain the disk drive and directory in which Solar Maps is expected to 

be residing. If you have moved the files to another directory, then you must edit 

these entries to reflect the new location. 

[Solar Maps] 

SystemDataPath=c:\solarmap\ 

UserDataPath=c:\solarmap\userdata\ 

InterpPath=c:\solarmap\interps\ 

PrefFile=c:\solarmap\userdata\def256.sms 

LastFile1=c:\solarmap\userdata\world1.sfm 

LastFile2=c:\solarmap\userdata\australi.sfm 

LastFile3=c:\solarmap\userdata\samerica.sfm 

LastFile4=c:\solarmap\userdata\seasia.sfm 

WindowState=0 

Left=5265 

Top=360 

Width=9600 

Height=7200 

Place=Adelaide 

Country=Australia 

TimeZone=ACDT -10:30 

Longitude=138E35 

Latitude=34S55 

DayNight= 0 

ClockStep= 60 

LocalLineExtent= 360 

HouseSystem= 5 

TrueNode=-1 

VulcWeston=-1 

ACSAtlas=-1 

256Colors=-1 

RTFOn=-1 

WordProcessor= 

StoreImages=-1 
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 ClockStep - This shows the AstroClock update intervals in seconds of time. Its 

default value is 60 seconds, but this can be altered to any whole number of 

seconds from 1 to 30000 seconds. 

 LocalLineExtent - This shows how far around the globe lines of planetary 

direction extend. It’s default value is 360º, meaning that the direction lines 

extend from the chart location all the way around the globe, and back to the 

same location. You could use this option to limit the line to 180º, for example, 

in which case the lines would only extend to a point on the opposite side of the 

globe, or to 90º, in which case they would only extend to the local horizon of 

the chart location. You can insert any whole number of degrees from 1 to 360. 

 StoreImages - This shows whether Solar Maps stores map images as bitmap 

files, instead of redrawing the map as a vector plot each time that it is shown. Its 

default value is -1, which means that it is switched on. Any other value, such as 

0, would switch it off. If your computer is low on memory or diskspace, then 

you may prefer to switch this option off, as this will use less memory for storing 

images. 

 

Note that not all of these items will necessarily be present in your own INI file. if any 

item is absent from the INI file altogether, then its default value is used by the 

program. For example, if the StoreImages item is not in the file, then it is switched 

on in Solar Maps. 

 

20.2 Backing Up 

In case of computer hardware failure, or other accidents, it is wise to have made 

backup copies of certain key files on your computer. 

The Solar Maps program can normally be reloaded from its original installation 

diskettes should you ever experience a major problem. If your original CD has 

become corrupt or unusable for any other reason, then you can get a replacement 

copy by contacting you astrological software dealer, usually at a nominal cost. 

However, to avoid losing any data files that you may have created or saved during 

the course of your usage of the Solar Map’s program, (which therefore cannot be 

reloaded from the installation diskettes), you should create your own backup of the 

data files associated with the program. 

There are a variety of methods that can be used for backing up files, including simply 

copying them to a CD or another disk or diskette. 

Whichever method you use, you should backup all the files which are in the 

following directories 

 Solar Maps USERDATA directory 

 Solar Maps INTERPS directory 
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If you backup these files, and keep you original installation CD, then you can recover 

from a disaster as follows. 

 Re-install Solar Maps using the installation CD 

 Restore the backup files for the Solar Maps USERDATA directory 

 Restore the backup files for the Solar Maps INTERPS directory 

 

It is recommended that you perform backups on a regular basis, or at least after those 

occasions when you have created large numbers of new charts or maps etc. 

 

20.3 Uninstalling Solar Maps 

 To uninstall Solar Maps 

1. Select Settings / Control Panel from the Start Menu 

2. Select Add/Remove programs 

3. Find Solar Maps v3 on the list, and highlight it 

4. Click on the Add/Remove button 

 

After you have done this, there will still be some Solar Maps files remaining on your 

computer. These will be all of those files which have been updated or added since 

you first installed Solar Maps. 

 

 To remove all remaining files 

1. Use the right hand mouse button on the Start button and select Explore… 

2. Navigate to your Solar Maps folder (e.g. C:\Program Files\SolMap3) 

3. Highlight this folder and use the Delete key 

This will remove all the remaining files and folders associated with Solar Maps. 

 

20.4 Calculation Accuracy 

All planetary positions are calculated using the Swiss Ephemeris™, which “is at 

least as accurate as the Astronomical Almanac, the standard planetary and lunar 

tables astronomers refer to.” 

The core part of Swiss Ephemeris is a compression of the JPL-Ephemeris DE406, 

plus an extension of the time range to 10,800 years, from 2 Jan 5401 BC to 31 Dec 

5399. As a guide, the accuracy of the standard planets around the current era is 

estimated to be as shown in the following table. 
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Dates Planets Accuracy 

1980 – 2000 all planets < 0.01” 

1600 – 1980 

2000 – 2160 

Sun – Jupiter a few 0.1” 

1600 – 1900 Saturn – 

Neptune 

a few ” 

1900 – 1980 Saturn – 

Neptune 

a few 0.1” 

1910 – 1980 

2000 – 2010 

Pluto < 1” 

1750 – 2169 Moon a few ” 

 

For a more detailed explanation of how the accuracy is estimated, see the Swiss 

Ephemeris website at http://www.astro.ch/swisseph/. 

 

When Solar Fire calculates heliocentric positions, they are true dynamical positions, 

and have no corrections applied.  Their geocentric positions are corrected for 

nutation and light time delay, and therefore correspond closely to the positions 

published in the "The American Ephemeris" (ACS), for example. 

 

20.4.1 Asteroids 

The asteroid positions in Solar Fire are calculated from ephemeris files. The main 

asteroids (Ceres, Pallas, Juno, Vesta) are available for the full range of the Swiss 

Ephemeris (2 Jan 5401 BC to 31 Dec 5399). The likely accuracy is a few arc seconds 

in 1600 AD and a few arc minutes in 3000 BC. 

The supplied supplementary asteroids are also calculated from ephemerides supplied 

by Mark Pottenger, and cover the period 1900 to 2100 approximately.  

 

20.4.2 Chiron 

As a result of close encounters with Saturn in Sept. 720 AD and in 4606 AD, 

Chiron’s orbit beyond this time range is uncertain. Chiron’s position is therefore 

reliable only for the time between 700 AD and 4650 AD. 

 

20.4.3 Hypothetical and Experimental Planets 

The planet Vulcan, the Transneptunian planets and TransPluto are not officially 

discovered planets, but are important in esoteric and Uranian astrology. They should 

be treated as experimental. Their true accuracy is therefore unascertainable at this 

http://www.astro.ch/swisseph/
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time. However, efforts have been made to ensure that their calculated positions agree 

with the orbits that have been proposed and are in general use for these bodies. 

 

20.4.4 House Cusps and Chart Angles 

The house cusps, and chart angles (Ascendant, Midheaven, Equatorial Ascendant 

and Vertex) are accurate for all dates limited only by the uncertainty of changes in 

the earth’s rotation rate (sometimes called DeltaT). Solar Fire uses the best available 

Swiss Ephemeris calculations to determine these changes. However, there is still an 

inherent uncertainty of about 15 minutes of time around 1500 BC, and possibly 

several hours around 3000 BC. 
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radius search, 121 
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creating new file, 30 
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exporting to other programs, 31 

house system, 114 

importing, 31 

lunar node type, 114 

opening file, 25 

printing horizon, 60 

printing wheel, 61 

progressed, 37 

relocating, 12, 29 
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saving, 30 
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setting default location, 4 

transits, 37 

viewing local horizon, 59 

viewing wheel, 60 

Chart File 

creating, 34 

importing from other programs, 31 

Chiron 

range of ephemeris, 161 
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adding, 76 

copying between files, 77 

creating file, 74 
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editing, 73 
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selecting file, 74 

when plotted, 76 

Color and Font Settings. See Settings 

Color Fills 

adding sea fill, 80 

adding special color fill, 80 
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using, 79 
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to email, 56 

to file, 56 

Countries 

adding, 79 
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editing, 77 

items stored in file, 78 

when plotted, 78 
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calendars, 125 

entering, 124 

examples, 124 

format, 124 

Day/Night Shading, 54 

Decompiling 

interpretations, 146 

DeltaT, 162 

Directions 

solar arc, 38 

Earthquakes, 88 

Eclipses, 85 

classifications, 85 

displaying with a chart, 86, 91 

information shown, 85 

paths, 21 

selecting, 85 

Email, 116 

suggestions, 118 

support, 117 

Ephemeris 

accuracy, 161 

Esoteric Technologies, 2 

Events. See Tracks and Events 

Exporting Charts, 31 

Extra Line Annotation, 106 

Fixed stars 

viewing, 141 

Fixed Stars. See Stars 

Font Settings. See Settings 

Geodetic Charts. See Zodiac Type 
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Help 

on help, 9 
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using on-line, 8 

House System, 114 

Hurricanes, 88 

Importing Charts, 31 

INI File, 157 

Installing, 3 

Internet, 5, 116 

downloading tracks and events, 89 

updates, 117 

website, 118 

Interpretations 

compacting, 147 

compiling, 146 

creating new file, 142 

decompiling, 146 

editing, 142 

file examples, 152 

file layout, 149 
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mapped aspect names, 144 

text categories, 143 

viewing, 58 

viewing contents summary, 146 

window, 58 

Keyboard, 9 

using, 9 

using short cut keys, 10 

using with dialog boxes, 9 

Latitudes 

entering, 130 

Line symbols, 8 

Lines 

celestial, 47 

description of types, 42 

displaying, 41 

local space, 46 

paran, 46 

planet, 43 

selecting, 41 

Local Space Astrology, 19 

Longitudes 

entering, 130 

Lunar Node Type, 114 

MAPI, 57, 116 

Maps 

Cartesian, 71 

changing description, 64 

changing regions, 64 

creating new, 64 

deleting, 64 

detail types, 70 

globe (oblate), 72 

globe (sphere), 72 

items not saved with, 66 

items saved with, 65 

Mercator, 71 

opening, 62, 65 

overview, 62 

projections, 70 

reopening, 65 

saving, 65 

selecting, 62 

selecting coordinate grid, 73 

selecting options, 69 

Menu, 7 

Midpoints, 16, 45 

Mouse 

mode buttons, 67 

mode for interpretations, 58 

modes, 67 

using, 67 

Mouse modes, 8 

Mundane Charts. See  Geodetic Charts 

Options, 106 

INI file, 158 

Overview 

main window, 6 

Paran 

categories of, 49 

selecting point, 49 

Planets 

accuracy, 161 

Vulcan, 162 

Point 

saving colors, 51 

selecting colors, 51 

Points 

default, 49 

selecting for display, 48 

Printer Settings, 110 

Printing 
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charts, 54 

maps, 54 

printer setup, 55 

Progressions 

secondary, 37 

tertiary, 37, 38 

Registration, 116 

Relocation 

azimuths, 47 

Reports, 100 

city directions, 102 

local parans, 101, 105 

map parans, 100 

relocation interpretations, 103 

rich text format, 104 

selecting word-processor, 104 

Rich Text Format. See Reports 

Screen Settings, 107 

Settings, 106 

Applying, 113 

editing, 107, 110 

items saved, 106 

opening, 112 

printer, 110 

restoring, 112 

saving, 111 

screen, 107 

Short-Cut Keys, 10 

Stars, 82 

clearing, 84 

editing files, 135 

editing information, 137 

opening file, 82 

selecting, 83 

Starting, 4 

Swiss Ephemeris 

accuracy, 160 

Symbols 

tabulations of, 155 

System Requirements, 3 

Technical Support, 117 

Time 

entering, 126 

examples, 126 

format, 127 

Time Zone 

entering, 128 

format, 129 

Title bar, 7 

Tracks and Events 

clearing, 99 

colors, 92 

creating, 93 

downloading from web, 89 

editing, 93 

markers, 93 

opening, 90 

plotting, 88 

selecting, 91 

supplied, 88 

Uninstalling, 160 

Updates, 5 

Vulcan calculation, 115 

Word-processor. See Reports 

Zodiac Type 

celestial, 53 

geodetic, 53 

selecting, 52 

 


